Avid® Media Composer®
and Film Composer®

What’s New for Release 7.0
Contents

Preface
Who Should Use This Manual ............................................. 12
Symbols and Conventions .................................................. 13
If You Have Documentation Comments ................................. 14

Chapter 1 Introducing Release 7.0
Supported Hardware Configurations ................................. 15
Documentation Included with This Release ...................... 16
Online Help ................................................................. 17
What's My Next Step? ....................................................... 17

Chapter 2 User Interface Changes
Electronic Licensing ......................................................... 19
Displaying Project Settings .............................................. 19
Displaying Bins .............................................................. 21
Creating a Folder in a Project ............................................ 22
Deleting a Bin or Folder ................................................... 23
Emptying Trash ............................................................. 23
Viewing Contents in the Trash ......................................... 24
Customizing Your Workspace ........................................... 24
Assigning a Workspace ................................................... 25
Deleting a Workspace ..................................................... 26
Assigning a Workspace Button ....................................... 26
Info Display Changes ..................................................... 27
Profile ............................................................. 27
# Chapter 3 Video and Audio Input and Output

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage</td>
<td>28</td>
</tr>
<tr>
<td>Memory</td>
<td>34</td>
</tr>
<tr>
<td>Hardware</td>
<td>34</td>
</tr>
<tr>
<td>New Location for the Attic Folder</td>
<td>35</td>
</tr>
<tr>
<td><strong>Editcam Media Support</strong></td>
<td>38</td>
</tr>
<tr>
<td>Acquiring Editcam Clips</td>
<td>38</td>
</tr>
<tr>
<td><strong>Media Stream Manager</strong></td>
<td>40</td>
</tr>
<tr>
<td>Finding Tape Names</td>
<td>40</td>
</tr>
<tr>
<td>Loading the Media Database</td>
<td>40</td>
</tr>
<tr>
<td><strong>Media Conversion Tool</strong></td>
<td>42</td>
</tr>
<tr>
<td>Relinking Media Files</td>
<td>44</td>
</tr>
<tr>
<td><strong>Video Input and Output Tools</strong></td>
<td>46</td>
</tr>
<tr>
<td><strong>Digitizing</strong></td>
<td>47</td>
</tr>
<tr>
<td>AVR 70 and 75</td>
<td>48</td>
</tr>
<tr>
<td>Digitizing to Multiple Media Files</td>
<td>48</td>
</tr>
<tr>
<td>Recording to the Timeline</td>
<td>52</td>
</tr>
<tr>
<td>Selecting a Source Tape</td>
<td>53</td>
</tr>
<tr>
<td>Saving a Default Video Input Setting</td>
<td>55</td>
</tr>
<tr>
<td>Preroll Option for Digitizing Across Timecode Breaks</td>
<td>56</td>
</tr>
<tr>
<td>Combine Fields Option for Film Projects</td>
<td>57</td>
</tr>
<tr>
<td><strong>Deck Control</strong></td>
<td>58</td>
</tr>
<tr>
<td><strong>Deck Configuration Settings</strong></td>
<td>58</td>
</tr>
<tr>
<td>Deleting Configurations</td>
<td>64</td>
</tr>
<tr>
<td><strong>Deck Preferences</strong></td>
<td>64</td>
</tr>
<tr>
<td><strong>VTR Emulation Settings</strong></td>
<td>65</td>
</tr>
<tr>
<td><strong>Deck Controller Enhancements</strong></td>
<td>68</td>
</tr>
<tr>
<td><strong>Digital Cut Tool Enhancements</strong></td>
<td>68</td>
</tr>
<tr>
<td><strong>Audio Tool Enhancements</strong></td>
<td>70</td>
</tr>
<tr>
<td>Resizing the Audio Tool</td>
<td>70</td>
</tr>
<tr>
<td>Configuring Output Parameters</td>
<td>70</td>
</tr>
<tr>
<td>Creating Tone Media</td>
<td>72</td>
</tr>
</tbody>
</table>
Chapter 5 Effects

Using the Effect Editor .................................................. 110
  Big Effect Mode ......................................................... 113
  The Profile Parameter ................................................ 115
Position Information in Effect Mode ................................. 117
Typing Timecode in Effect Mode ..................................... 117
Working with the Effect Grid ........................................... 119
  Setting the Effect Grid Options .................................... 120
  Grid Options ............................................................. 123
  Displaying the Position Coordinates in Effect Mode ......... 124
  Using the Effect Grid in a Film Project ......................... 125
  Displaying the Safe Title and Safe Action Guidelines ....... 128
  Displaying the Aspect Ratio Grid for Film Projects .......... 130
Color Effect Enhancements ............................................. 131
  Using the Color Effect to Adjust a High Contrast Image .... 135
Beveled Video Border for 3D Effects ................................. 136
Expanded Support for Plug-Ins ........................................ 137
  Installing AVX Plug-In Effects .................................... 137
  Troubleshooting AVX Plug-Ins .................................... 139
  Applying a Third-Party Plug-In Effect ......................... 141
Submaster Editing .......................................................... 143
  Submaster Editing of Multiple Clips ............................. 143
  Submaster Editing of Multiple Effects ......................... 145
  Collapsing Layers into One Submaster Effect ................. 147

Chapter 6 Downstream Keying and Title Tool Enhancements

Downstream Keying of Titles and Graphics ....................... 149
Creating Rolling or Crawling Titles .................................. 150
  Page Count Limits for Rolling or Crawling Titles .......... 151
  Using Auto Size Mode ................................................. 152
  Setting Up Text Formatting for Rolling Titles ............... 152
Workflow Options for Creating Crawling Titles ................. 152
  Typing the Rolling or Crawling Text ............................. 153
Chapter 7

New Audio Features

Enhancements for Two-Channel Audio Boards
Monitoring Eight Channels on Two-Channel Audio Boards
44.1 kHz and 48 kHz Audio Rate Settings
Chapter 8

Film Features

Using the AutoSequence Command .......................... 225
Film Effects Grid ............................................. 227
Dupe Handle Length Support ................................. 228
  About Dupe Handle Lengths and Film Editing ................. 228
  Adjusting the Handle Lengths ................................ 230
  Matching Dupe Detection Handles in a Dupe List ............ 231
Three-Perforation Film Format Support ...................... 232
# Chapter 9  Importing and Exporting

**Importing Files**  .........................................................  234  
  Before You Begin  .................................................  235  
  Importing in Mixed-Resolution Projects  .......................  235  
  Using Global Import Settings  ....................................  236  
  Performing the Import  .............................................  237  
  Importing Shot Log Files  .......................................  241  
  Import Settings  ...................................................  243  

**Exporting Files**  .......................................................  249  
  Preparing to Export a Sequence  ..............................  250  
  Using Global Export Settings  ................................  250  
  Performing the Export  ..........................................  251  
  Exporting Shot Log Files  .......................................  258  
  Export Settings  ...................................................  259  

**Exchanging Files with Other Systems**  ........................  270  
  About OMF Interchange  .........................................  271  
  Transferring OMF Files from Media Composer to AudioVision  .................................................  273  
  Transferring OMF Files from Film Composer to AudioVision  .................................................  279  
  Transferring OMF Files to Pro Tools  ......................  283  
  Using the Media Composer QuickTime Codec  .................  288  
  Transferring a Project to Another Avid Composer Product  .................................................  296  
  Methods for Transferring Media Files  .....................  298  

**Import and Export Specifications**  ............................  301  
  Supported File Types  ............................................  301  
  Graphics File Specifications  ..................................  305  
  Animation File Specifications  .................................  311  
  QuickTime Specifications  ......................................  313  
  OMF File Specifications  .......................................  314  
  Editcam File Specifications  ...................................  316  

---

9
Chapter 10 Intraframe Editing

Editing with Intraframe Capability ........................................... 318
Using an Optional Pen Tool ....................................................... 319
Using Single-Field Step ............................................................. 319
Rendering Intraframe Effects .................................................... 319
  Rendering Paint Effects ......................................................... 320
  Rendering AniMatte Effects ................................................... 320
Applying the Paint Effect to a Sequence .................................... 321
Applying an AniMatte Effect to a Sequence ............................... 321
Working with the Intraframe Editing Interface ............................ 322
  Using the Effect Editor with the Paint Effect ......................... 324
  Using the Effect Editor with the AniMatte Effect ................. 326
Using Effect Templates with the Intraframe Effects ................... 328
Working with Intraframe Editing Parameters ............................ 328
  Using the Selection Tool ....................................................... 328
  Global and Key-Frame Parameters ......................................... 329
  Opacity .............................................................................. 331
  Object Visibility .................................................................. 332
  Feathering .......................................................................... 333
  Acceleration ........................................................................ 335
  Brush ................................................................................. 336
Working with Vector-Based Objects .......................................... 342
  The Elements of Vector-Based Objects ................................... 342
  Getting Started with Bezier Curves ...................................... 344
  Modifying Lines and Curves Summarized ......................... 350
  Painting a New Object with Bezier Curves ......................... 351
  Moving a Control Point ......................................................... 352
  Adding a Control Point ......................................................... 352
  Moving to Adjacent Control Points ..................................... 353
  Moving Control Points and Objects in Small Increments ....... 354
  Removing a Control Point ...................................................... 354
Using the Paint Tools ............................................................... 355
  Brush Tool ......................................................................... 355
Chapter 11 Using the Paint and AniMatte Effects

Using the Paint Effect .................................................. 382
   Getting Started with the Paint Effect .......................... 382
   Paint Effect Parameters ................................. 386
   Choosing a Color ................................................. 389
   Using Magic Mask with the Paint Effect .................. 391

Using the AniMatte Effect ............................................. 396
   Getting Started with the AniMatte Effect .................. 396
   Creating a Single-Layer Organic Matte Wipe ............... 401
   AniMatte Effect Parameters .......................... 405
   Using Magic Mask with the AniMatte Effect ............. 406
   Exporting a Matte PICT File ............................. 412

Index
Preface

This document describes the new features for Media Composer® and Film Composer®.

This manual contains important information on the following topics:
• Supported hardware configurations
• What’s included in the Open Me First and Documentation boxes
• List of new and revised documentation
• How to proceed with the installation and setup of your system
• Description of new features

Who Should Use This Manual

This manual is intended for Media Composer and Film Composer Release 7.0 customers. All users, from beginning to advanced, should review this manual.
Symbols and Conventions

This manual uses the following special symbols and conventions:

1. Numbered lists, when order is important.
   a. Alphabetical lists, when order of secondary items is important.
   • Bulleted lists, when the order of the items is unimportant.
      - Indented dashed lists, when the order of subtopics is unimportant.

 This symbol refers to the Apple or Command key. Hold down the Command key and another key to perform the desired keyboard equivalent.

Helpful tips in the margin can assist you with tasks or information.

A note provides important related information, reminders, recommendations, and strong suggestions.

A caution means that a specific action you take could cause harm to your computer or cause you to lose data.

A warning describes an action that could cause you physical harm. Follow the guidelines in the manual or on the unit itself when handling electrical equipment.
If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. We value your comments about this manual or other Avid-supplied documentation.

Simply E-mail your documentation comments to Avid Technology at TechPubs@avid.com

Please include the title of the document, its part number, revision, and the specific section you’re commenting on in all correspondence.
CHAPTER 1

Introducing Release 7.0

Release 7.0 adds many new features to the Media Composer and Film Composer applications running on the peripheral component interconnect (PCI) platforms. This document describes all the new features.

Supported Hardware Configurations

Release 7.0 runs on the following configurations:

- Power Macintosh® 9500 with a 120-MHz, or faster, processor board
- Power Macintosh® 9600 with a 200-MHz, or faster, processor board

A description of the boards and peripheral devices available for these systems is in the *Avid Media Composer Products Setup Guide*. 
Documentation Included with This Release

In addition to the hardware you purchased, your package from Avid Technology includes a box that contains the following documentation:

- *Avid Media Composer and Film Composer What’s New for Release 7.0*
- *Avid Media Composer Products Site Preparation*
- *Avid Media Composer Products Setup Guide*
- *Avid Media Composer Products Connecting Audio and Video Equipment*
- *Avid Media Composer Getting Started Guide* or *Avid Film Composer Getting Started Guide*
- *Avid Media Composer and Film Composer Quick Reference*
- *Avid StorEx Setup and User’s Guide*
- *Avid System Test Setup and User’s Guide*
- *EDL Manager User’s Guide*
- *EDL Manager Quick Reference*
- *EDL Manager Release 1.9.3 Release Notes*
- *Avid Media Composer Products Online Publications*, a CD-ROM that contains the following documents:
  - *Avid Media Composer User’s Guide*
  - *Avid Film Composer User’s Guide*
  - *Avid Media Composer and Film Composer Effects Guide*
  - *Avid Media Composer Products Reference*

Also packaged with the Core Kit is the *Avid Media Composer and Film Composer Release 7.0 Release Notes*.

⚠️ If you are missing any of the items, call Avid Customer Support at 800-800-AVID (2843).
Online Help

Online help is automatically installed with Media Composer and Film Composer. For instructions on how to use it, refer to the Avid Media Composer Getting Started Guide or the Avid Film Composer Getting Started Guide.

What’s My Next Step?

Proceed with the setup of your system as follows:

1. Refer to the Avid Media Composer Products Site Preparation for a list of power, environmental, and space requirements for your Media Composer or Film Composer system. The site preparation guide lists the standard and optional system components.

2. Read the system requirements and compatibility guidelines described in the Avid Media Composer and Film Composer Release 7.0 Release Notes.

3. Complete the hardware installation, following the instructions in the Avid Media Composer Products Setup Guide.

4. Complete the software installation, following the instructions in the Avid Media Composer and Film Composer Release 7.0 Release Notes.

5. Skim through this manual to learn about new features for this release.

6. Read the Avid Media Composer Getting Started Guide or the Avid Film Composer Getting Started Guide to learn about the capabilities of your Avid Composer system.
CHAPTER 2

User Interface Changes

This chapter describes new and changed features in the Media Composer user interface.

- Electronic Licensing
- Displaying Project Settings
- Displaying Bins
- Customizing Your Workspace
- Info Display Changes
- New Location for the Attic Folder
Electronic Licensing

Avid Composer products now have a licensing agreement that appears the first few times you log in to the system.

To accept your Avid Composer product license electronically:

1. Double-click the application icon on your desktop.
   
The Avid splash screen appears, followed by the Avid License Agreement.
2. Read the agreement, then click the Accept button or the Decline button at the bottom of the screen.
   
The agreement appears the first several times you launch the application. After that, a new button appears at the bottom of the screen.
3. If you do not want to see the license agreement again, click the Accept and Don’t Show Again button.
   
A dialog box appears.
4. Enter the name of your organization in the dialog box, and click OK.
   
The Project Selection dialog box appears and you can begin working with the Avid Composer application.

Displaying Project Settings

The Settings scroll list in the Project window can now be displayed in different ways, depending on the view you choose from the Fast menu. Table 2-1 describes the Project Settings options.
To change the Settings scroll list display:

1. Click the Settings button in the Project window.
   The Settings scroll list appears.

2. Choose a settings display from either the Fast menu (in the lower left corner) or from the Settings menu (under the Info button).
Displaying Bins

You can now add folders to your projects to allow you to organize the projects. In addition, a Trash icon has been added in the Project window to allow you to delete entire bins and folders.

Bins from other projects appear in the Project window in italics.

Bins and folders can still be viewed in a “flat” view, similar to previous versions of the Avid Composer. You can also drag and drop bins into folders, or folders into folders.
Creating a Folder in a Project

To create a folder in a project:

1. Click Bins in the Project window.
2. Choose New Folder from the Bin Fast menu.
   - A new untitled folder appears.
3. Click the untitled folder and rename it.
Deleting a Bin or Folder

To delete a bin or folder:

1. Click Bins in the Project window.
2. Select the bin or the folder you want to delete.
3. Press the Delete key.

   The deleted item is stored in the Trash.

Emptying Trash

To empty the Trash:

1. Click Bins in the Project window.
2. Choose Empty Trash from the Bin Fast menu.

   An alert box appears.

   Emptying the trash permanently deletes the bins therein from your disk. Do you really want to do this?

   Empty Trash  Don’t Empty

3. Click Empty Trash to delete the bins or folders from the Trash.
Viewing Contents in the Trash

If you need to view the contents in the Trash or decide you do not want to delete those items in the Trash, you must first move the bins and folders out of the Trash.

To view items in the Trash:
1. Click Bins in the Project window.
2. Double-click the Trash icon to open it.
3. Click the bins or folders you want to remove (or view), and then drag them from the Trash to the Project window.
4. Double-click the bin or folder to view it.

Customizing Your Workspace

A workspace is the arrangement and size of windows displayed on your Avid Composer system. If you are accustomed to working with a particular group of windows arranged and sized in a particular setup, you can assign a workspace setting to remember that arrangement. For example, during digitizing you might want to have the Digitize Tool and Video Input Tool open. During editing, you want to have the Effect Palette, Effect Editor and the Keyboard window open and arranged in a particular order and size. You can have as many workspace settings as you want.

Eight buttons allow you to switch among user-customized workspaces. The buttons are assigned to the workspaces in the Settings scroll list in the Project window in the order that they appear. For example, W1 button is assigned to the first workspace that appears in the Settings scroll list. W2 is assigned to the second workspace that appears in the Settings scroll list.

The Workspace setting only remembers the window arrangement. It does not open the windows.
Assigning a Workspace

To assign a workspace:

1. Click Settings in the Project window.
   The Settings scroll list appears.
2. Scroll to the bottom of the list and select Workspace.
   Workspace is highlighted.
3. Press ⌘-D to duplicate the workspace. Workspace appears twice.
4. In the column between Workspace and User, click until you see a text cursor.
5. Type a new workspace name; for example, digitizing.
6. Click to the left of a workspace you want to use.
   A checkmark appears next to the workspace.
7. Open the windows that you want to associate with that workspace. If you want, resize and move the windows.
   You have now assigned a set of windows to a new workspace.
8. To add multiple workspaces, follow these steps again.
Deleting a Workspace

To delete a workspace:
1. Click Settings in the Project window.
2. Select the Workspace you want to delete from the Settings scroll list.
   The selection is highlighted.
3. Press the Delete key.
   The selection is removed from the list.

Assigning a Workspace Button

To assign a workspace button:
1. Choose Command Palette from the Tools menu.
2. Click the More tab.
3. Select the Button to Button Reassignment box.
4. Click and drag workspace button (W1–W8) to a location on another palette (for example, under the Source/Record monitors or a user tear-off palette.)

The workspace button appears in the new location.
5. Click the W1 button to display the first assigned workspace.

When you open the windows associated with the first workspace, they open in the assigned locations.

*The Workspace setting only remembers the window arrangement. It does not open the windows.*

### Info Display Changes

The Project window has always included an Info button which opens the Info display. Release 7.0 has added a Fast Menu button at the bottom of the Info display. The Fast Menu button displays four menu items: Profile, Usage, Memory, and Hardware.

#### Fast Menu button

### Profile

Profile displays basic project information, such as the video format (NTSC or PAL) or frame rate (24 fps for film projects).

To display the Profile information:

1. Click the Info button in the Project window.
2. Choose Profile from the Fast menu.

Basic project information is displayed.
Usage

The Avid Composer system includes a statistics feature that gathers and reports information on system usage. You can use this information to support business functions such as resource management.

All statistics are gathered and reported by project. The file that contains this information is formatted so that you can use it as input to software programs such as analysis applications, spreadsheets, or report generators.

Do not rely on the statistics feature for billing or other financial purposes.

To view statistics for an open project:

1. Click Info in the Project window.
2. Choose Usage from the Fast menu.

You see a display similar to the following:
3. Click the Info button again to update the Usage display to reflect any changes you made to the project.

A new file is created each time the project is opened. The files are stored in a Statistics folder inside each project folder.

The file name has the following format:

```
Statistics.yymmdd.hhMMss
```

where:

- `yy` indicates the last two digits of the year
- `mm` indicates the month
- `dd` indicates the date
- `hh` indicates the hour
- `MM` indicates the minute
- `ss` indicates the seconds
File Structure and Layout

The Usage file is formatted as comma-separated ASCII text so it can be accepted by a variety of software programs. Each line in the file is tagged with indicators for identifying content and data type to assist in programming custom applications. Figure 2-1 shows a sample data file.
<table>
<thead>
<tr>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
<th>Column 5</th>
<th>Column 6</th>
<th>Column 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>01,01</td>
<td>Project Name: april5</td>
<td>Statistics as of: Fri Apr 05 11:39:37 1996</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02,01</td>
<td>Project created: Fri Apr 05 07:44:40 1996</td>
<td>Last Session Started: Fri Apr 05 11:36:22 1996</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>117,04</td>
<td>Elapsed Time:</td>
<td>Total:</td>
<td>Last Session:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>Hours, Minutes, Seconds</td>
<td>Hours, Minutes, Seconds</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>101,02</td>
<td>Time Project Open</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102,02</td>
<td>Digitize Tool open</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>104,02</td>
<td>Digitize Tool active</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>115,02</td>
<td>Digitize Tool digitizing</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>111,02</td>
<td>Title Tool open</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>113,02</td>
<td>Title Tool active</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>114,02</td>
<td>Title Tool rendering</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110,02</td>
<td>Effects rendering</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03,04</td>
<td>04,00,00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 2-1  Sample Data File**

**Description of Data File Values**

Values in the first column indicate the content of the line. Values are:
Project info
Time Project open
Digitize Tool open
Digitize Tool active
Digitized Media bytes used
Rendered Effects bytes used
Effects rendering time
Title Tool open
Title Tool active
Title Tool rendering
Digitize Tool digitizing
Digitize Tool logging
user comments

The value in the second column indicates the type of data in the line. Values are:

- 01project info
- 02time used
- 03bytes used
- 04text string

**Importing the Statistics File into a Spreadsheet**

You can import the statistics file into spreadsheet or other programs as an ASCII file and use the application to set up the proper format. For example, to create a statistics file in Microsoft Excel™ on a Macintosh:

1. From the Finder, locate the statistics file you want to copy.
2. Start Excel.
3. Open the file by choosing Open from the File menu and navigating to the directory the file is in.
After you open the file, the Text Import Wizard starts.

To complete the steps for the Text Import Wizard:

1. Choose Delimited for the Original Data Type and click Next.
2. Choose Comma for Delimiters and click Next.
3. Choose General for Column Data Format.
4. Click Finish.

The statistics file appears in spreadsheet format.

**Spreadsheet Form of Statistics Data File**

Figure 2-2 is the same sample file as it appears when you import into a spreadsheet.

<table>
<thead>
<tr>
<th></th>
<th>1 Project Name: DartShop.jg</th>
<th>Statistics as of: Mon-Sep 15 14:16:31 1997</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project created: Thu-Sep 1 15:25:55 1997</td>
<td>Last Session started: Thu-Sep 15 14:16:30 1997</td>
</tr>
<tr>
<td>112</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Exposed Time: ---</td>
<td>Total: ---</td>
</tr>
<tr>
<td>4</td>
<td>Hours</td>
<td>Minutes</td>
</tr>
<tr>
<td>104</td>
<td>2</td>
<td>Time Project</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>2</td>
<td>Elapsed Time</td>
</tr>
<tr>
<td>104</td>
<td>2</td>
<td>Elapsed Time</td>
</tr>
<tr>
<td>116</td>
<td>2</td>
<td>Elapsed Time</td>
</tr>
<tr>
<td>118</td>
<td>2</td>
<td>Elapsed Time</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>112</td>
<td>2</td>
<td>Title Text open</td>
</tr>
<tr>
<td>115</td>
<td>2</td>
<td>Title Text active</td>
</tr>
<tr>
<td>114</td>
<td>2</td>
<td>Title Text unread</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>2</td>
<td>Effects rendered</td>
</tr>
<tr>
<td>4</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>2</td>
<td>Elapsed open</td>
</tr>
<tr>
<td>108</td>
<td>2</td>
<td>Elapsed/Played</td>
</tr>
<tr>
<td>105</td>
<td>2</td>
<td>Elapsed/Played</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>4</td>
<td>Disk Space Used</td>
</tr>
<tr>
<td>105</td>
<td>3</td>
<td>Elapsed Media</td>
</tr>
<tr>
<td>106</td>
<td>3</td>
<td>Rendered Effect</td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>Time marked by editor may show less than actual usage</td>
</tr>
</tbody>
</table>

**Figure 2-2  Sample Spreadsheet Form**
**Memory**

To open the Memory window and display system memory information:

1. Click the Info button in the Project window.
2. Choose Memory from the Fast menu.

   The Memory window opens.

*For more information, see the “Working with the Projects Window” chapter of the Avid Media Composer User’s Guide or Film Composer User’s Guide, or “About Projects and Memory” in the online help index.*

**Hardware**

You can still display the Hardware Tool by choosing Hardware from the Tools menu. However, you can also choose it from the Fast menu in the Info display.

To activate the Hardware Tool:

1. Click the Info button in the Project window.
2. Choose Hardware from the Fast menu.

   The Hardware Tool appears.
New Location for the Attic Folder

The Attic folder is no longer in the Media Composer or Film Composer folder. It is now in the top-level directory.

You retrieve files from the Attic folder in the following circumstances:

- When you want to replace current changes to a sequence or clip with a previous version
- When the current bin file becomes corrupt

When a copy of a bin file is stored in the Attic folder, the system adds the extension “.bak” plus a version number to the bin name. When you view the Attic folder in the Name view, you can identify the most recent backup file based on the name and timestamp of creation displayed in the Last Modified column.

To retrieve a file from the Attic folder:

1. Close all your bins in the Project window.
2. On your desktop, double-click the Avid disk to open it.
3. Open the Attic folder.
4. Select by Name from the View menu if the Folder window is not already in the Name view.
5. Open the project you want to retrieve from the Attic folder, and then lasso or Shift-select the desired bin files.
6. Press and hold the Option key and drag the backup bin files to the desktop. This makes a copy of the files, leaving the original files in the Attic folder.
7. Click the Project window to reactivate it.
8. Choose Open Bin from the File menu or press ⌘−O; select one of the backup bins on the desktop and click Open.

When you open the backup bin, a link to the backup bin is created in the Other Bins folder.
The Avid Composer application does not allow a bin and copy of a bin to be opened at the same time. You must keep all other bins closed and open the backup bins one at a time. The creation date might need to be changed to avoid conflicts.

9. Create a new bin from the Project window.

10. Select the material you want to keep from the backup bin, press and hold the Option key, and drag the duplicates to the new bin.

Repeat steps 8 through 10 for any other backup bins you copied to your desktop.

11. Select and delete the backup bins in the Other Bins folder.

12. Click on the desktop and drag the backup copies of the bins to the Trash on the desktop.
CHAPTER 3

Video and Audio Input and Output

Changes and new features for video and audio input and output are described in the following sections:

- Editcam Media Support
- Media Stream Manager
- Media Conversion Tool
- Relinking Media Files
- Video Input and Output Tools
- Digitizing
- Deck Control
- Audio Tool Enhancements
- Displaying the Audio Hardware Configuration
- AIFF Audio Support
- Eight-Channel Audio Input and Output
- Choosing a Controller in the Serial Ports Tool

New audio features are described in Chapter 7.
Editcam Media Support

Release 7.0 of the Media Composer products supports media captured with an Ikegami® Editcam™. The Editcam is a Digital News Gathering (DNG) camera. After clips are recorded, the FieldPak™ in the Editcam can be ejected from the camera and loaded into an Avid Desktop FieldPak Adapter. The adapter connects to the Avid Composer system and operates via the Avid Composer software.

For more information about setting up and using the Avid Desktop FieldPak Adapter, see the Avid Desktop FieldPak Adapter Setup and User’s Guide.

Currently, the resolutions supported are AVR 70B and 75B. These are digitized, as well as listed in the bin, as AVR 70B and AVR 75B.

Acquiring Editcam Clips

The two ways to acquire Editcam clips from an Avid FieldPak loaded into an Avid Desktop FieldPak Adapter are:

- Use the import procedure to import master clips or sequence play-lists into a bin, as described in “Performing the Import” on page 237 and “Editcam File Specifications” on page 316.
- Use the Media Tool to copy Editcam master clips from the FieldPak into a bin, as described in “Copying Editcam Master Clips by Using the Media Tool” on page 39.

You cannot rename, delete, or overwrite the clips on the FieldPak with the Avid Composer system and adapter.
Copying Editcam Master Clips by Using the Media Tool

You can use the Media Tool to copy Editcam master clips from the FieldPak to the Avid Composer system.

To copy Editcam master clips from a FieldPak by using the Media Tool:

1. Insert the FieldPak into the Desktop FieldPak Adapter.
2. Launch the system and open your project.
3. Open the bin in which you want to store the Editcam clips.
4. Choose Media Tool from the Tools menu.
   The Display Media Selector dialog box appears.
5. Select Other Projects and Digitized Master Clips.
6. Click OK. The Media Tool window opens.
7. Choose Custom Sift from the Media Tool Fast menu.
   The sift dialog box appears.
8. Enter a search criteria to list just the clips on the FieldPak:
   a. Type the name of the FieldPak in the box next to “contain.”
   b. Choose Disk from the adjacent pop-up menu.
   c. Click OK.
      Only the clips on the FieldPak are displayed in the Media Tool window.
9. Select the desired clips in the Media Tool window and drag them into the open bin.

The bin now contains master clips from the FieldPak media files that can be edited with the Avid Composer system.
Media Stream Manager

Media Stream Manager (MSM) is the new media file manager. The media files folder, formerly 6.x MediaFiles, is now called OMFI MediaFiles.

Instead of a media file database, you now have two files:

- **msmOMFI.mdb**, which stores the master clips
- **msmMac.pmr**, which is a cache for mapping files to IDs

The media file database no longer opens when you launch the Avid Composer system. The database is read when you relink, or when you open the Media Tool. This should make your system run faster.

Finding Tape Names

Because the media file database no longer opens when you bring up your Avid Composer system, tape names of all online media files no longer appear automatically.

If the tape name you are searching for does not appear in the Select Tape dialog box, click the Scan for Tapes button. Tape and project names are listed.

Loading the Media Database

The media database is a catalog of master clips and precomputes stored on the external media drives. One use of the media database by the Avid Composer system is to display master clips and precomputes in the Media Tool.

Bins also contain references to some of the media files based on the contents of the bin. The Avid Composer system does not maintain the entire database in memory at all times but instead builds up a partial
database for the bins that have been opened in the current session in order to preserve as much memory as possible for editing.

If you store the master clips and the edited sequences for a project in separate bins, there are two cases in which you need to load the entire database in order to relink clips to their media files:

- **Redigitizing:** When you redigitize the master clips while the sequences bin is closed; quit the Avid Composer application; relaunch the application and open the sequences bin only — the sequences might appear to be offline.

- **Consolidating:** When you consolidate the master clips and relink them to the consolidated media while the sequences bin is closed; quit the Avid Composer application; relaunch the application and open the sequences bin only — the sequences might appear to be offline.

To update the offline sequences with the new media files, choose Load Media Database from the File menu to load all online master clips and precomputes.

*Loading the media database more than once during a single editing session is unnecessary — the database remains in memory until you quit the application or restart the Avid Composer system.*

*If a bin continues to display Media Offline after loading the media database, either the media files are missing or the links have been broken. For more information, see “Relinking Media Files” on page 44.*
**Media Conversion Tool**

You can now convert your version 6.x media files from Media File Manager (MFM) to Media Stream Manager (MSM) using the Media Conversion Tool. The Avid Composer products in Release 7.0 accept only MSM format.

The video format is Joint Photographic Expert Group (JPEG), the audio formats AIFF or Sound Designer II™.

To convert media files:

1. Locate the 6.x MediaFiles folder or the OMFI MediaFiles folder you want to convert on your media drive. This will be your Source Folder.  

   *All the files must be in either MSM or MFM format. Do not mix files of different types in the Source Folder.*

2. Choose the media drive where you want the converted files to be saved. The Media Conversion Tool will automatically create a Destination Folder.  

   *The media drive where you choose the Destination Folder to be created must have at least as much available storage space as the size of your Source Folder.*

3. Double-click the Media Conversion Tool application located in the Utilities folder on the Avid disk.  

   The application launches.
4. Click the Source Folder Find button to navigate to the folder you want to convert.

5. Click the Destination Folder Find button to navigate to the media drive where you want the converted files to go.

   If you select just the media drive, an OMFI MediaFiles folder will be created for you.

6. Select a Source Format and a Destination Format.

   When you select MFM Media as your Source Format, MSM Media becomes your default Destination Format.

7. Select the Audio and Video format. When the Destination Format is MSM Media, the defaults are already selected.

8. Click Convert to convert the media files.
A progress box appears. When the conversion is completed, select another folder to convert or click Quit to exit the tool.

The Media Conversion Tool creates a log of the converted files that can be read by using any word processing or text editing package. Vantage, a text editor program, is included with Media Composer and is located in the Apple menu items and in the Utilities folder.

**Relinking Media Files**

After the media files have been converted to MSM format, your bins and projects will have lost their links to the original media files. When a clip becomes unlinked, it displays the message “Media Offline.”

You can use the Relink command to reestablish the link. The user’s guide has a complete description of all your relinking options.

The command relinks master clips, subclips, and sequences to appropriate media files. The system compares information such as source tape name, timecode information, and channels digitized. You can instruct the system to search specific drives, or all available drives.

*If you recently redigitized or consolidated media for your project and the media appears to be offline in your sequences, you might need to use the Load Media Database command. For more information, see “Loading the Media Database” on page 40.*
To relink clips, subclips, or sequences:

1. Select the unlinked object or objects.
2. Choose Relink from the Clip menu.
   
   The Relink dialog box appears.

<table>
<thead>
<tr>
<th>Relink</th>
<th>Volume</th>
<th>All Available Disks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>☑</td>
<td></td>
</tr>
<tr>
<td></td>
<td>☑</td>
<td></td>
</tr>
</tbody>
</table>

3. Choose an option from the Volume pop-up menu:
   - Choose All Available Disks to search across all drives that are online.
   - Choose a specific drive volume if you know the location of the media, or want to relink to media on a specific drive.
4. Select one of the following options:
   - Relink To Selected – directs a relinking of related subclips or sequences to the highlighted clip in the bin.
   - Relink Master Clips – relinks master clips to associated media files.
5. Click OK. The system searches the selected drives and relinks if possible.

The system disregards capture rate and audio resolution when matching media files.
If you want to be sure to maintain the original capture settings for a subclip or sequence, use the Batch Digitize command; do not use the Relink command.

Video Input and Output Tools

The Video Input Tool has changed in appearance. The Vectorscope and Waveform buttons are now at the top of the tool’s window in both Component and Composite Input settings.

In the Video Output Tool, the More Options button has been replaced by an arrow button, and the Test Patterns and Genlock settings menus have moved to the left, directly under the Composite window.
Digitizing

New digitizing features in Release 7.0 include:

- Broadcast AVRs 70 and 75 provide media compatibility with the Ikegami Editcam digital camera.
- You can digitize a video clip to multiple media files across multiple volumes, resulting in longer clips and longer sessions of unattended continuous digitizing.
- You can record directly into a sequence loaded in the Timeline.
- Improvements in the source tape selection process allow you to more efficiently identify and associate tapes with your projects.
- You can use control track for VTR preroll in order to capture all of the footage following timecode breaks on a tape.
- You can combine fields when you digitize single-field media for a film project. This improves image quality.
- For film projects, you can combine fields when digitizing from film-to-tape transfers for higher image quality.
**AVR 70 and 75**

AVR 70 and AVR 75, in Release 7.0, correspond to AVR 70B and AVR 75B, which are used for recording digital media in the field with the Ikegami Editcam. As a result, you can now transfer media directly from the Ikegami Editcam to an Avid Xpress system for editing.

*For information on transferring media from the Ikegami Editcam, see “Editcam Media Support” on page 38.*

These different AVRs are handled in Release 2.0 as follows:

- When you choose AVR 70 or AVR 75 during digitizing, the video column in the bin will display AVR 70B or AVR 75B for the new clips.
- Edit in AVR 70B and AVR 75B by using all editing features provided by the system.
- If you transfer AVR 70 or AVR 75 media from an earlier release, the Video column in the bin displays AVR 70 and AVR 75 for the older media.
- You can play older AVR 70 and AVR 75 media within Release 7.0, but you cannot digitize in the older format.

**Digitizing to Multiple Media Files**

You can digitize video to multiple media files across multiple drive volumes, with the following advantages:

- You can create longer clips whose media files would otherwise exceed the Macintosh operating system file size limitation of two gigabytes.
- You can group all drive volumes with the multiple files options, enabling the system to record continuously during digitizing of long video clips — such as satellite feeds or program airchecks.
The system makes more efficient use of drive space, particularly when digitizing long clips.

This feature applies to video files only, because audio media files rarely exceed two gigabytes.

To digitize video to multiple media files:

1. Double-click Digitize in the Settings scroll list of the Project window.

   The Digitize Settings dialog box appears.

   ![Digitize Settings dialog box]

   - **General Digitize Settings (Current)**
     - Digitize Video to Multiple Files.
     - Prepare multiple files for (minutes): 30
     - Always display incoming video in the client monitor.
     - Ask before discarding a canceled clip.
     - Capture a single video frame only.
     - Use control track instead of timecode for preroll.
     - Digitize across timecode breaks
     - Switch to emptiest drive when

   - **Batch Digitize Settings**
     - Log errors to the console and continue digitizing.
     - Digitize the tracks logged for each clip.
     - Use the audio compression logged for each clip.
     - Use the video compression logged for each clip.
     - Switch to the emptiest drive if current drive is full.
     - Stop deck when done.
     - Pause deck when done.

   - OK  Cancel

2. Select the option “Digitize Video to Multiple Files”.

49
3. Select the option “Prepare multiple files for (minutes).” You can accept the default or enter a different time limit in the text field, based on the following explanation.

Prior to digitizing, the system goes through a process of preparing the drive volumes. This process is called preallocation. With the “Digitize Video to Multiple Files” option selected, the allocation process can take time in preparation for potentially unlimited video clip lengths. This option instructs the system to preallocate according to an estimated maximum video clip length. The default is 30 minutes.

⚠️ If you think that any of your digitized video clips might exceed 30 minutes, make sure you enter a higher estimate in this field; otherwise, the system will stop digitizing at 30 minutes.

4. Click OK to close the dialog box and apply the options.

5. Enter Capture mode or open the Digitize Tool.
6. To digitize to multiple files across drive volumes, choose Change Group from the One/Two Disk Mode pop-up menu in the Digitize Tool.

The Volumes dialog box appears.

7. Shift-select multiple volumes to include in the digitizing session, or click the All button to select all volumes.

8. Click OK to close the dialog box and apply the changes.

When you digitize, any clip that exceeds the capacity of a volume (whether that volume is empty or already contains media files) will continue digitizing onto another volume in the group.
For media file management purposes, any video clip whose media exceeds the 2-gigabyte limit will have more than one media file associated with it. When you view the source Timeline for the clip loaded in the Source monitor, you will also notice edit breaks based on the separate media files (the breaks do not appear in the record-side Timeline).

For more information on managing media files, see “Managing media files: overview” in the online help index.

Recording to the Timeline

You can digitize footage directly from tape into a sequence loaded in the Timeline in one step, bypassing several steps such as organizing and reviewing clips, marking edit points, and performing edits.

To digitize to the Timeline:

1. Prepare for digitizing, by using standard procedures. For more information, see “Preparing to digitize, overview” in the online help index.
2. Load a sequence into the Record monitor.
3. Mark an IN point in the sequence or place the blue position indicator where you want the edit to take place.
4. Mark the source material that you want to digitize by using the Digitize Tool logging controls. For information on setting modes, see “Digitizing and Logging at the Same Time” in the Digitizing chapter of the user’s guide.
5. (Option) You can mark an OUT point based on the following:
   - If you are digitizing to the middle of a sequence in the Timeline, mark both IN and OUT points for frame accuracy.
   - If you are digitizing onto the end of a sequence, you can mark just an IN point and then mark the OUT point later on-the-fly.
6. Click the Splice-in button or the Overwrite button in the Digitize Tool to choose the type of edit.

7. Click the red Record button to begin digitizing.

8. If you did not mark the OUT point in advance, click the Record button again when the footage reaches the appropriate frame.

If you already marked an OUT point, digitizing will stop automatically.

When digitizing ends, the clip appears in place in the sequence, and a master clip appears in the bin.

Selecting a Source Tape

The process for selecting and naming a source tape has been improved. When you click the Tape Name button in the Digitize Tool, a new Select Tape dialog box opens.
Improvements are as follows:

- You can cancel the process at any time by clicking the Cancel button.

- Tape names and associated projects are listed clearly in two columns.

- You can select the option “Show other project’s tapes” to display the tape names and associated project names for all bins that have been opened in the current session.

- Because of changes in the underlying media file structure and management, tape names associated with all online media files no longer appear automatically when you launch the system. You can click the Scan for Tapes button to scan the system and display tape names and associated project names for all media files that are currently online (in other words, volumes that are currently mounted on the system).
Saving a Default Video Input Setting

Each time you insert a new tape into the VTR, the Video Input Tool reverts to its default settings for composite input, and the Settings pop-up menu displays the name “Untitled.”

Use the following procedure to save your own custom default setting for the current project — for example, if you want the Video Input Tool to display a set of calibrations for component video each time you put in a new tape.

*The default setting for the Video Input Tool is a project setting. You must create a new default setting for each project.*

To save a new Video Input setting default:

1. (Option) Insert a tape into the VTR and cue up the bars.
2. Choose Video Input Tool from the Tools menu.
   
   The Video Input Tool opens.
3. Calibrate the default settings that you want to save.
4. Choose Save As from the Settings pop-up menu.
5. Type the name “Default,” and click OK.

*You must use the name “Default” for the setting, otherwise it will not function as the default. Alphabetic case does not affect it.*

The system uses the default setting in the current project whenever you load a new tape that does not have its own setting.
Preroll Option for Digitizing Across Timecode Breaks

You can use control track instead of timecode for VTR preroll when digitizing across timecode breaks.

Control track preroll allows you to capture all the footage following a timecode break. Otherwise the system uses approximately one to six seconds of unbroken timecode following the break to perform the preroll before digitizing begins.
Combine Fields Option for Film Projects

When digitizing single-field media (using AVRs 2s, 3s, 4s, 6s, 8s, and 9s, 2m, 3m, 4m, 5m and 6m) for a film project, you can select the Combine Fields option in the digitize settings to improve image quality.

During digitizing, this option instructs the system to combine the two video fields that were generated for the same film frame during transfer. This applies to both NTSC and PAL transfers. The result is better image quality for the digitized media, with lower storage requirement.
Deck Control

New deck control features in Release 7.0 provide greater flexibility in configuring single or multiple decks. Changes also include enhancements to VTR emulation, the Deck Controller, and the Digital Cut Tool which now includes its own Deck Controller.

Deck configuration settings and global deck control preferences appear as separate items in the Settings scroll list of the Project window.

![Deck control settings]

Deck Configuration Settings

Deck configuration settings allow you to establish deck control parameters for a single deck or for multiple decks. As with all settings, you can create multiple versions, allowing you to select among them for frequent changes in hardware configurations.

You must manually configure the appropriate hardware connections before deck configuration settings can take effect. For more information, see the Avid Media Composer Products Setup Guide or Avid Media Composer Products Connecting Audio and Video Equipment.
To configure a deck or multiple decks:

1. Double-click Deck Configuration in the Settings scroll list. The Deck Configuration dialog box appears.

2. If you are configuring your system for the first time, click the Add Channel button to add a new channel box on the left side of the Deck Configuration dialog box and automatically open a Channel dialog box.
Channel refers to the signal path for deck control, whether through a serial port or a V-LAN VLXi system. Direct serial port connection provides two channels (modem port and printer port). A V-LAN VLXi system provides multiple channels.

3. Choose either Direct (serial port) or V-LAN VLXi from the Channel Type pop-up menu, depending upon your system configuration.

4. If you chose Direct for the channel type, choose either Printer Port or Modem Port from the Port pop-up menu.

If you are not sure which port to choose, check the serial cable connection on the back of the Macintosh.

5. Click OK to close the Channel dialog box.

A new channel appears in the display area of the Deck Configuration dialog box.

Channel boxes appear on the left side
You can reopen the channel settings to change the options at any time by double-clicking the channel box.

6. Click the channel box to select it.

7. Click Add Deck to add a new deck box on the right side of the Deck Configuration dialog box and automatically open a Deck Settings dialog box.

With a deck already connected to the system, you can also click the Autoconfigure button to bypass the Deck Settings dialog box and automatically configure a deck with the default settings.

8. Configure deck settings based on Table 3-1.
### Table 3-1 Deck Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Includes a text field for typing your own custom name for the tape deck. The default name matches the deck type.</td>
</tr>
<tr>
<td>Description</td>
<td>Includes a text field for entering notes about the deck.</td>
</tr>
<tr>
<td>Deck Type</td>
<td>Provides a list of supported decks. Choose your manufacturer and model from the menus for accurate deck control.</td>
</tr>
<tr>
<td>Address</td>
<td>For V-LAN VLXi use only (see your V-LAN VLXi documentation). If you are using direct serial port deck control, this option remains dimmed.</td>
</tr>
<tr>
<td>Preroll</td>
<td>Determines how many seconds you want the tape to roll before a digitize or digital cut starts. The default is based on the type of VTR.</td>
</tr>
<tr>
<td>Fast Cue</td>
<td>Fast cue is useful only for decks that can read timecode in fast forward or rewind mode. If your decks can do this, fast cue can speed up long searches.</td>
</tr>
<tr>
<td>Switch to ff/rew</td>
<td>This option instructs the system to switch to fast forward or rewind if the target timecode is farther than the specified number of seconds from your current location on the tape.</td>
</tr>
<tr>
<td></td>
<td>By default, the deck switches to fast forward or rewind to reach a target timecode that is more than 60 seconds away.</td>
</tr>
<tr>
<td></td>
<td>If your deck shuttles very quickly, you can increase this number so that the system uses fast cue only for long searches.</td>
</tr>
<tr>
<td>Switch to search</td>
<td>This option instructs the system to switch out of fast forward or rewind when it is within the specified number of seconds of the target timecode. By default, the system switches to search mode when it is 14 seconds from the target timecode.</td>
</tr>
</tbody>
</table>
9. Click OK to close the Deck Settings dialog box and return to the Deck Configuration dialog box.

You can reopen the Deck Settings dialog box to change the options at any time by double-clicking the deck box.

10. Repeat steps 2 to 9 for each additional channel or deck you want to configure.

11. Click Apply to complete the configurations and close the Deck Configuration dialog box.

12. If necessary, double-click Deck Preferences in the Settings scroll list of the Project window to adjust global deck control options for default timecode format, insert or assemble editing, and stop key and shuttle operation.
Deleting Configurations

You can delete deck configuration elements to remove or replace them.

To delete deck configuration elements in the Avid Composer system:

1. Double-click Deck Configuration in the Settings scroll list of the Project window.

   The Deck Configuration dialog box appears.

2. Click a channel box, a deck box, or the entire configuration to select it.

3. Click the Delete button in the dialog box, or press the Delete key to delete the element.

Deck Preferences

Deck preferences are global settings for basic deck control. These settings apply to all decks connected to your system, regardless of your deck configuration. You can open the Deck Preferences dialog box from the Settings scroll list of the Project window.
Table 3-2  Deck Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When no tape in deck log as</td>
<td>Displays a pop-up menu that lets you choose the default timecode format (drop frame or non-drop frame) to use when logging clips without a tape in the deck. If a tape is in the deck, the Avid Composer system automatically uses the existing timecode format on the tape.</td>
</tr>
<tr>
<td>Allow assemble edit for digital cut</td>
<td>Allows you to use assemble-edit features in the Digital Cut Tool along with assemble-editing capabilities of your record deck, to quickly record frame-accurate digital cuts without striping entire tapes in advance. For more information, see “Assemble edit recording” in the online help index.</td>
</tr>
<tr>
<td>Stop key pauses deck</td>
<td>Defines how the stop key (space bar) on the keyboard functions. If you select “Stop key pauses deck”, the space bar maps to the Pause button on the deck. If you deselect the box, the space bar maps to the Stop button. If the videotape heads are down in “Stop key pauses deck” mode, pressing the space bar brings up the heads and pauses the deck. The Stop button on the Digitize Tool and Deck Controller Tool always stops the decks. (Choose New Deck Controller from the Tools menu to access the Deck Controller Tool.)</td>
</tr>
<tr>
<td>Shuttle holds speed</td>
<td>Determines whether the Shuttle button (located in the Digitize Tool or Deck Controller) will continue shuttling at a constant speed or stop when you release it.</td>
</tr>
</tbody>
</table>

VTR Emulation Settings

Release 7.0 includes a new dialog box of settings that apply only to VTR emulation. In addition, a new option allows you to inhibit pre-loading when cueing by a single frame. You can open VTR Emulation Settings from the Settings scroll list of the Project window.
For information on configuring a system for VTR emulation, see Avid Media Composer Products Connecting Audio and Video Equipment.

Table 3-3 describes the VRT emulation settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Code</td>
<td>The device code identifies the VTR that the system will emulate so that the controller can adjust. The default value identifies a Sony® PVW 2800, which performs all of the common play and record functions. Recording is supported only in Media Station Telecine (not in Media Composer). Changing the device code value is unnecessary unless your edit controller does not recognize the VTR emulator or you have a specific VTR that you want to emulate.</td>
</tr>
</tbody>
</table>
Edit Delay  The edit delay value is used only by Media Station Telecine. Every VTR has an edit delay value that it uses when performing frame-accurate edits. On an actual VTR machine, the edit delay corresponds to the time it takes for the recording heads to engage. Media Station Telecine VTR emulation uses the edit delay time to switch from play to record mode. The default value is 24 fields. In other words, the system can switch from play to record mode in the time that it takes to play 24 fields. The Avid Composer system uses the edit delay value for both the IN point and OUT point for frame-accurate edits.

When you attach a deck to an edit controller, the edit controller usually determines the edit delay value automatically. Because this does not happen with VTR emulation, make sure the value on the edit controller matches the Edit Delay value in the VTR Emulation settings. If the values don’t match, your recording might always be a few frames off.

Always adjust the value on the edit controller. If the values don’t match, consult the documentation that came with the edit controller to determine how to assign the edit delay value. Leave the Media Station setting at the default of 24 fields unless told otherwise by an authorized Avid support representative.

Runup (frames)  Each deck has a runup value which corresponds to the amount of time it takes the deck to start playing from a cued position. The time is measured in frames.

When the runup time of two video devices is similar, it is easier for the edit controller to synchronize the devices during preroll. If your Avid VTR emulator does not sync up as often as you would like, try adjusting this value so that the two devices attain full speed at nearly the same time. The default value is 5 frames.

Inhibit preloading when cueing by single frame  Preloading occurs by default in the Avid Composer system as a way of preparing the digital media for playback each time you cue a new frame, thereby improving playback performance. Do not inhibit preloading under normal circumstances.

By inhibiting preloading, this option causes the system to match the behavior of a tape deck when you are stepping (jogging) through footage frame by frame. This option is only recommended for projects that require quick cueing of one frame after another — for example, when you are using the system to present a sequence of still images as in a slide presentation.
Deck Controller Enhancements

Improvements to deck configuration and control in Release 7.0 include added functionality in all Deck Controllers. These improvements apply not only to individual controllers you open by choosing New Deck Controller from the Tools menu, but also to the Deck Controllers built into the Digitize Tool and the Digital Cut Tool.

Changes to the Deck Controller are as follows:

- The Deck Selection pop-up menu allows you to specify a deck with deck control parameters that you can customize in the Deck Configuration dialog box. For more information, see “Deck Configuration Settings” on page 58.
- You can associate a tape name with the controller by clicking the Tape Name button and selecting a tape in the Tape Selection dialog box. For more information, see “Selecting a Source Tape” on page 53.

Digital Cut Tool Enhancements

The Digital Cut Tool in Release 7.0 includes its own Deck Controller for cueing a record deck and marking points during recording of digital cuts. Track selection buttons for the record deck have also been added.
The advantages of these changes are as follows:

- Deck control within the tool allows you to cue the tape from within the tool and log your own IN and OUT points for frame-accurate recording during a digital cut. This capability applies when you choose Mark In Time from the pop-up menu.

For more information on logging procedures, see “Logging: overview” in the online help index. For more information on performing a digital cut, see “Recording: digital” cut in the online help index.

- The record track buttons allow you to specify which tracks on the record tape you want to record to from the selected source tracks.
Audio Tool Enhancements

The Audio Tool in Release 7.0 includes several enhancements such as the ability to resize the tool, assign all output parameters from within the tool, and create media and clips for customized calibration tone.

Resizing the Audio Tool

You can resize the Audio Tool for greater visibility during input and output. For example, when batch digitizing in a busy facility, you can make the tool larger for keeping an eye on levels from across a room.

To adjust the size of the Audio Tool, click the size box in the lower corner and drag to the preferred size.

Configuring Output Parameters

The Audio Tool in Release 7.0 provides controls for adjusting output parameters.
To adjust output parameters:

1. Click the Output Level button (speaker icon) to open the master attenuator.

2. Click the Output Options button to open the Output Options panel.

3. Choose a type of output from the Output Type pop-up menu:
   - Choose Stereo Mix to mix the currently monitored audio tracks into a stereo pair.
   - Choose Mono to pan all the currently monitored tracks to center.
   - Choose Direct Out to map tracks directly to up to eight channels of output (depending on your hardware configuration).

4. (Option) Depending on your type of output, you can make additional adjustments:
• By default, Stereo Mix directs the mixed tracks to output channels 1 and 2. Alternatively, you can choose Mix To 3 & 4 from the Mix Tracks pop-up menu.

• By default, Direct Out maps all audio tracks in numerical sequence to existing output channels. You can remap a track to any channel by clicking the channel assignment display and choosing another channel.

• You can select Ignore Volume or Ignore EQ to disable customized pan, volume, or equalization effects you applied with the audio tools.

5. Click the In/Out toggle buttons above the meters to display O for Output.

6. Play the sequence, watch the levels in the meters, and adjust the master attenuator to the level that you want.

To adjust levels for individual tracks, you must use the Audio Mix Tool. For more information, see “Audio Mix Tool: using” in the online help index.

7. (Option) Record a digital cut after adjusting the levels. For more information, see “Digital Cut Tool Enhancements” on page 68, or see “Digital Cut” in the online help index.

**Creating Tone Media**

Prior releases of the Avid Composer products allowed you to set up your own custom calibration tone for output to tape. Release 7.0 allows you to create your own tone media and master clips for editing directly into sequences.
To create tone media:

1. Choose Create Tone Media from the Peak Hold pop-up menu in the Audio Tool.

   A dialog box appears.

   ![Dialog box](image.png)

   - **Tone media level in dB:** -14.00
   - **Tone media frequency in Hz:** 1000
   - **Tone media length in seconds:** 1
   - **Target Bin:** *<Enter Bin Name>*
   - **Target Disk:** *<Enter Disk Name>*
   - **OK**
   - **Cancel**

2. Set the appropriate calibration tone parameters for the project. You can also use the default output tone of –14 dB (digital scale) with a 1000-Hz signal.

   If you set the tone media frequency to zero, the system generates random noise.

3. Choose a target bin for the tone master clip and a target disk for the tone media from the pop-up menus.

4. Click OK.

   After a few seconds, the media file is created and a master clip appears in the target bin. The default name reflects the options you selected. You can rename the clip by typing a new name.
Displaying the Audio Hardware Configuration

Release 7.0 displays the audio hardware configuration in the Audio Settings dialog box. In previous releases of the Avid Composer products, this information was displayed in the Audio Tool when you clicked the Audio Setup button.

You can use the Audio Settings dialog box to check the current configuration of the audio hardware, and to choose various input options.

To adjust audio settings:

1. Double-click Audio in the Settings scroll list of the Project window to open the Audio Settings dialog box.

   The first three items in the display are informational, and cannot be changed from within the Audio Settings dialog box.

   Adjust the Sample rate on the audio interface or audio converter.

2. Choose the audio interface configuration from the Peripheral pop-up menu.

3. Choose the audio sync sources from the Sync Mode pop-up menu.

   • **Internal**: This sets the clock and timing for the sample rate internally. Choose this setting if your system is equipped with the Digidesign audio interface and black burst generator.
• **Digital**: Choose this setting if you are using a digital source that provides a digital word-clock signal. Also choose this setting if you are digitizing from DAT (digital audiotape).

You must plug a digital source device through the Digidesign audio interface if your system is configured with a four- or eight-channel audio board.

4. Choose the type of audio input from the Input Source pop-up menu, either Analog or Digital.

5. If you choose Digital as the input source, you have two options from the Digital Format pop-up menu.

   • **AES/EBU** (Audio Engineering Society/European Broadcast Union) — the industry format.
   
   • **S/PDIF** (Sony/Phillips Digital Interface Format) — the consumer format.

### AIFF Audio Support

Release 7.0 supports creation of audio media in AIFF format, the industry-standard Audio Interchange File Format (AIFF). Release 7.0 continues to support the Sound Designer II™ format supported in previous releases.

*AIFF audio files in Avid Composer products are encapsulated in OMFI (Open Media Framework® Interchange) files and are referred to as OMF (AIFF) files in General Settings dialog box.*
Choosing an Audio File Format

AIFF and Sound Designer II audio media files are mixable within a project. The system default is 16-bit OMF (AIFF) audio.

*Choose the Sound Designer II format for all audio media when you need to transfer audio media files directly to a Pro Tools® or AudioVision system for audio sweetening.*

To choose either AIFF or Sound Designer II:

1. Double-click General in the Settings scroll list of the Project window. The General Settings dialog box appears.

2. Choose either OMF (AIFF) or OMF (SDII) from the Audio File Format pop-up menu.

3. Click OK to close the General Settings dialog box.

Audio is written in the chosen file format when you:

- Digitize audio tracks in Capture mode
- Create new clips by using the Audio Punch-In Tool
- Create tone media by using the Audio Tool
• Mix down audio tracks by using Audio Mixdown
• Import files by using the Import dialog box
• Apply a Digidesign® audio plug-in that creates new source audio

If you switch the audio format in the middle of a project, all new audio media files will be written in the new format with the following exceptions:

• **Media files written when rendering audio effects:** The system uses the file type of the A-side (outgoing audio) media for a transition. For example, if the A-side of an audio dissolve is in AIFF format and the B-side (incoming) is Sound Designer II, the rendered file will be AIFF.

• **Audio media files written when using the Consolidate feature:** Media files that are copied or created during a consolidate procedure retain their original file types.

## Exchanging Audio Media Files Between Systems

You can transfer audio media files directly from the OMFI MediaFiles folder for use in any third-party application that supports the AIFF or Sound Designer II formats:

• To identify the appropriate media files in the OMFI MediaFiles folder, use the Media Tool. For more information, see “Transferring:files” in the online help index.

• To convert some or all of the media files on a mixed project to either the Sound Designer II or AIFF format for direct transfer to a third-party application, choose the format you want when exporting the master clips from the bin. For more information on exporting audio files, see Chapter 9.

• To copy the selected files quickly onto a target drive, use the Consolidate feature. See “Consolidating:media” in the online help index.
To transfer the files, transport them on a removable or fixed drive. For more information, see “Transferring media files between systems” in the online help index.

To transfer audio media files back into an Avid Composer product, use the import procedures. For more information, see Chapter 9.

You cannot transfer audio media files that have been altered in a third-party application directly into the OMFI MediaFiles folder on an Avid Composer system.

## Eight-Channel Audio Input and Output

Release 7.0 supports direct input and output of up to eight channels of audio, depending upon your model. Systems supporting eight-channel input and output provide the following features:

- For eight-channel audio input, source track assignments are mapped directly to audio tracks in the digitized clips. For example, when you digitize source footage with audio channels 1 to 5, the resulting master clip has matching audio tracks 1 to 5.

- For eight-channel audio output, you can reassign output channels from tracks in a sequence or clip to any of the eight optional output channels. For more information, see “Configuring Output Parameters” on page 70.

Eight-channel audio input and output require the appropriate hardware configuration. For information on installing an eight-channel audio system, see the Avid Media Composer Products Connecting Audio and Video Equipment manual.

When you launch the Release 7.0 software, a dialog box appears.
Choose the appropriate configuration and click OK.

You can switch the hardware configuration to use either four-channel or eight-channel audio. If you change the configuration after launching the software, you can choose a new configuration in the Audio Settings dialog box without restarting the software.

To change the audio interface configuration after launching the software:

1. Reconfigure the hardware. For more information, see *Avid Media Composer Products Connecting Audio and Video Equipment*.

2. Double-click Audio in the Settings scroll list of the Project window. The Audio Settings dialog box appears.

3. Choose the new audio interface configuration from the Peripheral pop-up menu.
**Using Digital Sync with the Eight-Channel Audio Converter**

The eight-channel audio converter is limited to acquiring digital sync signal from channels 1 and 2.

Channels 1 and 2 are often the first choice for input of a signal that provides digital sync. To input audio from channels 3 through 8 however, you must have a valid digital signal coming in on either channel 1 or 2.

To check for a valid digital sync signal:

- If the green indicator light, labeled DIGITAL on the audio converter, shines steadily during input, the system is receiving a valid digital sync signal.
- If the green light blinks during input, the system is not receiving valid sync signal. Make sure you have a digital sync signal source correctly connected to channel 1 or channel 2.

The effects of capturing audio without a valid digital sync source can include random noise, silence, or a jittering effect in the audio when played back.

**Choosing a Controller in the Serial Ports Tool**

The Serial Ports Tool has changed. You need to specify a controller and its serial port. You can specify the AvidDroid controller, the Steenbeck, or the manual user interface (MUI). You no longer choose a controller from the Deck Settings dialog box.

To bring up the Serial Ports Tool, choose Serial Ports from the Tools menu. The Serial Ports Tool appears.
The Deck Control pop-up menu appears only if you have already selected a deck from the Deck Configuration window. The Audio Faders pop-up menu appears only if you choose the Automation Gain Tool from the Tools menu.

### Specifying the AvidDroid Controller

To specify the AvidDroid controller and its port:

1. Choose Serial Ports from the Tools menu.

   The Serial Ports Tool appears.

   ![Serial Ports Tool](image)

2. Choose Avid Controller from the Controller type pop-up menu.
3. From the Avid Controller pop-up menu, choose the port to which you connected the AvidDroid cable. See the AvidDroid Setup and User’s Guide for more information about connecting cables.


5. Continue setting up the AvidDroid as described in the AvidDroid Setup and User’s Guide.

**Specifying the Steenbeck Controller**

To specify the Steenbeck controller and its port:

1. Choose Serial Ports from the Tools menu.
   
The Serial Ports Tool appears.

2. Choose Steenbeck from the Controller type pop-up menu.

3. Check the back of your Avid system to see which port the Steenbeck cable is plugged into.

4. From the Steenbeck pop-up menu, choose the port to which you connected the Steenbeck cable.

5. Close the Serial Ports Tool.
Specifying the MUI Controller

To specify the MUI controller:

1. Choose Serial Ports from the Tools menu.

The Serial Ports Tool appears.

2. Choose MUI from the Controller type pop-up menu.

3. You don’t need to specify a port for the MUI.

CHAPTER 4

Editing

This chapter describes new editing features in the following sections:

- Reveal File
- Timeline Enhancements
- Zoom Box
- Clip Information Window
- Timecode Enhancements
- Using the Command Palette
- Changes to the Consolidate Window
Reveal File

Reveal File allows you to select a clip in a bin and automatically open up its related media file. This is useful if you want to delete, move, or label the media file.

To find a related media file:

1. Select the clip you want to find the media file for.
   
The clip is highlighted.

2. Choose Reveal File from the File menu.
   
The system searches on all available drives and opens the folder and highlights the related media files.
### Timeline Enhancements

This section covers the following enhancements:

- **Scrolling Timeline**
- **Using Default Timeline View**
- **Displaying Detail in the Timeline**
- **Accessing Timeline Settings**

### Scrolling Timeline

The Timeline scrolls over the position indicator while you play a sequence.

To set the scroll option:

1. Click Settings in the Project window to display a list of your current settings.
2. Double-click Timeline to display a list of your current Timeline settings.
3. Select the Scroll While Playing option.
4. Click OK.

When you play a sequence in the Timeline, the sequence scrolls over the position indicator. When the Timeline has passed the playhead and the end of the Timeline is revealed, the Timeline stops moving and the blue position bar travels the remaining distance.

For the Timeline to scroll, you might need to display more detail in the Timeline to expand the sequence. Click the scale box and drag it to the right to expand the Timeline.

All effect icons are hidden as you scroll.
Using Default Timeline View

To restore the default view in the Timeline, choose Default Setup from the Timeline Fast menu.

Displaying Detail in the Timeline

The scale bar stretches and contracts the Timeline area centered around the blue position bar. This allows you either to zoom in to focus on a specific area of your sequence, or to zoom out to display your whole sequence. This feature is especially useful when you have a lengthy sequence with many edits.

The scale bar replaces three buttons formerly in the Timeline tool bar: Show More Detail, Show Less Detail, and Show Entire Sequence.

To zoom in on a section of the Timeline at the position indicator and then zoom back to your original display:

1. Click the scale box and drag it to the right.

The following happens:

- The Timeline expands horizontally.
- The Timeline track shows more detail.
• The position indicator splits into a solid blue line and a dotted blue line (or “shadow”), marking the beginning and end of the current frame. You can click either the line or the shadow to move exactly one frame forward or back.

2. Move the scale box back to the left.
   The Timeline shrinks to its original size.

**Accessing Timeline Settings**

The Timeline Settings window has expanded to include all settings associated with the Timeline.

To access the Timeline settings:

1. Click Settings in a Project window.
   The Project Settings window opens.

2. Scroll down to find Timeline and double-click it.
   (You can also type T on the keyboard.)
   The Timeline Settings (Current) dialog box appears.

3. Select the appropriate options.
To deselect an option, click it again.

Table 4-1 briefly describes the Timeline settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dupe Detection Handles</td>
<td>Previously on Timeline Fast menu.</td>
<td>Labels each set of duplicate frames with a color.</td>
</tr>
<tr>
<td>Show Position Bar</td>
<td>Previously on Timeline Fast menu.</td>
<td>Changes the Timeline scroll bar to a blue position bar.</td>
</tr>
<tr>
<td>Show Scale Bar</td>
<td>New</td>
<td>Displays the scale bar.</td>
</tr>
<tr>
<td>Show Effect Contents</td>
<td>Previously on Timeline Fast menu.</td>
<td>Toggles the display of effect information.</td>
</tr>
<tr>
<td>Show Marked Region</td>
<td>Previously on Timeline Fast menu as Highlight In-Out.</td>
<td>Highlights the region from the IN to OUT mark.</td>
</tr>
<tr>
<td>Show Marked Waveforms</td>
<td>New</td>
<td>Shows waveforms drawn between a marked IN or OUT point instead of over the entire composition. Showing marked waveforms is faster and more convenient; it lets you focus on the area you are concerned with instead of having to hunt for it.</td>
</tr>
<tr>
<td>Show Segment Drag Quads</td>
<td>New</td>
<td>Shows the head and tail of incoming or outgoing frames of video when you drag a segment.</td>
</tr>
</tbody>
</table>
Using the Auto Patching Option

The Auto Patching option automatically patches the enabled source tracks to the tracks enabled in the Timeline. For example, you enable tracks V1 and A1 in the source clip, and V1 and A2 in the Timeline. With Auto Patching set, V1 is patched to V1, and A1 is patched to A2.

Auto Patching prioritizes patching by using several sets of criteria:

- First, the system edits source tracks to the same Timeline tracks: a clip with V1 and A1 is edited onto V1 and A1 in the Timeline.
- Second, if that is not possible, the system patches odd tracks to odd tracks and even tracks to even tracks: A1 is patched to A3, and A2 is patched to A4. For example, a V1 and A1 source clip, with V1, A2, and A3 enabled in the Timeline, is edited to V1 and A3.
- Third, if patching the odd tracks and even tracks together is not possible, the system tries to patch tracks wherever possible. As a result, a V1 and A1 source clip, with V1 and A4 enabled in the Timeline, is edited to V1 and A4.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Origination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll While Playing</td>
<td>New</td>
<td>The Timeline scrolls over the position indicator while you play a sequence.</td>
</tr>
<tr>
<td>Double Click Shows</td>
<td>Previously could</td>
<td>Displays nested effects when you double-click segments in the Timeline.</td>
</tr>
<tr>
<td>Nesting</td>
<td>not be displayed.</td>
<td></td>
</tr>
<tr>
<td>Auto Patching</td>
<td>New</td>
<td>Automatically patches the enabled source tracks to the tracks enabled in the Timeline.</td>
</tr>
</tbody>
</table>
To use Auto Patching:

1. Click Settings in the Project window to display your current settings.
2. Double-click Timeline to display your current Timeline settings.
4. Click OK.

**Zoom Box**

The zoom box allows you to shrink the Source and Record monitors and any pop-up monitor, displaying only the position bars for each window, the editing buttons, and the Timeline. No video is displayed.

To shrink the monitors:

1. With the Record monitor active, click the zoom box located in the upper right corner of the Record monitor.

   ![Zoom box](image)

   The video disappears. Only the Source and Record monitors, position bars, buttons, and Timeline are displayed.
2. With the Record monitor active, click the zoom box again to redisplay the video.
Clip Information Window

The Clip Information window displays statistical information about the clip. You can open the Clip Information window from a bin, Source and Record monitors, a pop-up monitor, or a script window. This window also updates information automatically. For a description of the headings displayed, see the “Organizing with Bins” chapter of the user’s guide.

Opening the Clip Information Window

With the Timeline active, click in the gray area just above the Splice-in or Overwrite buttons.

- To display information about the clip or sequence in the Source monitor, click above the yellow Splice-in button (shown in the center of the screen as a yellow broken arrow).
- To display information about the sequence in the Record monitor, click above the red Overwrite button (shown in the center of the screen as a red arrow).

Only fields with data will be displayed.

As you move the position indicator through the clip in the Source or Record monitor, the information in the window is updated.
Around the Source and Record monitors, you can click almost anywhere within the gray area to open the Clip Information window.

If no clip is loaded in the Source or Record monitor, the Clip Information window does not open.

To open the Clip Information window from a Pop-up monitor:
1. With a pop-up monitor open, click in the gray area at the top of the pop-up monitor.
2. Drag the window to a new location to leave the window open.

To open the Clip Information window from a bin:
1. Press the Command (⌘) key and click the clip for which you want to display information.
2. Drag the window to a new location to leave the window open.

To display the Clip Information window from a script window:
1. Press the Option key and click the take tab.
2. Drag the window to a new location to leave the window open.

For information on script integration, see the “Using Script Integration” chapter of the user’s guide.

**Moving the Clip Information Window**

While holding the mouse button down to display the Clip Information window, move the cursor over the window and drag it to a new location or another monitor.

An outline of the window appears. When you release the mouse button, the Clip Information window opens.
Copying Text from the Clip Information Window

You can cut, copy, and paste information from the Clip Information window anytime, but you cannot edit or change any information within the window.

To copy text from the Clip Information window:
1. Click and drag your cursor over the information you want to copy.
2. Press \textasciicircum-c to copy the information.
3. Create a customized column in a bin where you want to paste the information.
4. Click the location where you want to paste the information and press \textasciicircum-v.

Timecode Enhancements

This section describes the following features:

- Setting Timecode Displays
- Setting Timecode Fonts and Point Size

Setting Timecode Displays

Each pop-up monitor has two lines available to display timecode. The Timeline also displays two lines of timecode. The Timecode window allows you to display up to eight lines of timecode in a separate window.

To set a timecode display:
1. Choose Timecode from the Tools menu.
   The Timecode window opens.
If you resize the Timecode window, the text adjusts to fit the window.

2. Click anywhere in the Timecode window. The Timecode pop-up menu appears.

3. Choose an option from the Timecode pop-up menu. See Table 4-2 for a description of these options.

   The window displays the timecode you have chosen.

To set multiple timecode displays:

1. Place the cursor anywhere in the Timecode window, and press the mouse button.

2. Select Add Display from the pop-up menu. The maximum number of lines to display is eight.

   You might need to resize the timecode display to see all the options. To do so, click and drag the lower right corner of the window.

3. Click the close box to close the Timecode window.

Table 4-2  Timecode Display Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mas</td>
<td>Displays master timecode at present location.</td>
</tr>
<tr>
<td>Dur</td>
<td>Displays total duration of the sequence.</td>
</tr>
<tr>
<td>I/O</td>
<td>Displays duration between IN and OUT marks.</td>
</tr>
</tbody>
</table>
Setting Timecode Fonts and Point Size

This feature allows you to apply a font and point size to the clip or sequence name and to timecode information displayed above the Source or Record monitors in the Composer window.

To set timecode fonts and point size:

1. With the Composer window active, choose Set Font from the Edit menu.
   The Set Font dialog box appears.
2. Choose a font and type a point size.
3. Click OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs</td>
<td>Displays absolute time duration at present position.</td>
</tr>
<tr>
<td>Rem</td>
<td>Displays time remaining at present position.</td>
</tr>
<tr>
<td>V1</td>
<td>Displays the source track of the video on track 1.</td>
</tr>
<tr>
<td>A1</td>
<td>Displays the source track of the audio on track 1.</td>
</tr>
<tr>
<td>A2</td>
<td>Displays the source track of the audio on track 2.</td>
</tr>
<tr>
<td>Timecode</td>
<td>Displays tracking information as timecode.</td>
</tr>
<tr>
<td>Footage</td>
<td>Displays tracking information as feet and frames.</td>
</tr>
<tr>
<td>Frames</td>
<td>Displays tracking information as total frames.</td>
</tr>
<tr>
<td>None</td>
<td>Hides the display of information.</td>
</tr>
<tr>
<td>Add Display</td>
<td>Allows you to set multiple timecode displays.</td>
</tr>
</tbody>
</table>
The new font and point size are applied to the clip or sequence name and timecode information.

**Using the Command Palette**

The Command Palette provides a central location for all *user-selectable buttons* that you can map to various locations for ease of use. User-selectable buttons allow you to perform a wide range of commands with a single click. You can map buttons to any command palette in a pop-up, Source, or Record monitor and to reconfigure the keyboard, AvidDroid buttons, or the Manual User Interface (MUI) keys. You can also map menu commands to various buttons and keys.

The Command Palette buttons are grouped according to the types of editing functions they perform. Tabs are displayed for each group: Move, Play, Edit, Trim, FX, 3D, MCam, Other, and More. When you select a tab, its group of buttons appears. The nine editing function tabs and the buttons associated with each are shown in Figure 4-1 and Figure 4-2.
Figure 4-1 Command Palette Tabs 1-5
Figure 4-2  Command Palette Tabs 6-9
Buttons on Film Composer Tabs

The Move tab and the Trim tab on the Film Composer Command Palette have slightly different buttons. The Move tab buttons on the Film Composer that differ are:

- Step Forward 8 Frames
- Step Backward 8 Frames

The Trim tab buttons that differ are:

- Trim Left 8 Frames
- Trim Right 8 Frames

Mapping User-Selectable Buttons

The procedure for mapping user-selectable buttons and menu commands has changed.

To remap buttons or keyboard keys:

1. Open a window that has a user-selectable button palette by doing one of the following:
   - Activate the Source or Record monitor in the Composer window. To do this, click and then drag the tear-off palette from the Fast menu to another location. Then, open a clip in a pop-up monitor.
   - Enter Trim mode in the Composer window.
   - Open the Keyboard or the MUI or Steenbeck palette from the Project window.

2. Choose Command Palette from the Tools menu.
   
   The Command Palette appears.

3. Select the tab or palette from which you want to choose a user-selectable button. In this example, the Move tab is selected.
4. Select the Button to Button Reassignment box to enable reassignment.

5. Click and drag the button from the Command Palette to the tear-off palette or to any other active palette, such as the keyboard palette.

If you want to perform a command function from the Command Palette, for example, click the Play button in the Command Palette to play the material in the Source window. You must have both the Button to Button and Menu to Button Reassignment boxes unselected. Then activate the Source window and click Play in the Command Palette.

**Mapping Menu Commands**

To map menu commands to either a button or a keyboard key:

1. Open a window that has user-selectable buttons by doing one of the following:
   - Activate the Source or Record monitor in the Composer window.
   - Tear off one of the user command palettes.
   - Open a clip in a pop-up monitor.
   - Enter Trim mode in the Composer window.
1. Open the Keyboard or MUI or Steenbeck palette from the Project window.

2. Choose Command Palette from the Tools menu.

   The Command Palette appears.

   ![Command Palette Image]

3. Select the Menu to Button Reassignment box to enable reassignment.

4. Press a user-selectable button on a palette (for example, under the Source or Record monitor).

   The pointer changes to a small white menu.

5. Choose a command item from one of the menus.

   The initials for the command appear on the button.

   ![Menu Command Mapped to a Key Image]
New and Changed Buttons on the Command Palette

Table 4-3 lists the new buttons added to the Command Palette for Release 7.0.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Start</td>
<td>Move</td>
<td>Moves you to the start of the sequence.</td>
</tr>
<tr>
<td>Go to End</td>
<td>Move</td>
<td>Moves you to the end of the sequence.</td>
</tr>
<tr>
<td>Play Loop</td>
<td>Play</td>
<td>Plays the sequence continuously. Formerly called the Play Transition button</td>
</tr>
<tr>
<td>Play Length Toggle</td>
<td>Play</td>
<td>Toggles between playing an entire sequence and playing a limited duration of it. You define the duration (in minutes) in the Console window.</td>
</tr>
<tr>
<td>Audio Mark IN</td>
<td>Edit</td>
<td>Creates a split edit (L cut) for an audio track during splice or overwrite. This works the same as a mark IN, but it only affects the audio track. You can set the video IN point and audio IN point separately when you perform an insert or overwrite.</td>
</tr>
<tr>
<td>Fade Effect</td>
<td>FX</td>
<td>Fades a title or other effect. (Previously the Fade Title button.)</td>
</tr>
<tr>
<td>Rectangle Tool</td>
<td>FX</td>
<td>For the paint and AniMatte effects, paints an object shaped like a rectangle.</td>
</tr>
<tr>
<td>Oval Tool</td>
<td>FX</td>
<td>For the paint and AniMatte effects, paints an object shaped like an oval.</td>
</tr>
</tbody>
</table>
Table 4-3  Changes to Command Palette Buttons (Continued)

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poly Tool</td>
<td>FX</td>
<td>For the paint and AniMatte effects, paints an object shaped like a polygon.</td>
</tr>
<tr>
<td>Curve Tool</td>
<td>FX</td>
<td>For the paint and AniMatte effects, paints a freehand object with curves.</td>
</tr>
<tr>
<td>Brush Tool</td>
<td>FX</td>
<td>For the paint and AniMatte effects, paints an object with an artist’s brush stroke.</td>
</tr>
<tr>
<td>Arrow Tool</td>
<td>FX</td>
<td>Selects paint and AniMatte objects only in Effect mode.</td>
</tr>
<tr>
<td>Reshape Tool</td>
<td>FX</td>
<td>Reshapes paint and AniMatte objects in Effect mode.</td>
</tr>
<tr>
<td>Grid</td>
<td>FX</td>
<td>Displays guidelines in the Effect Preview monitor, depending on the grid settings. (Previously Safe Title/Action button.)</td>
</tr>
<tr>
<td>Outline/Path</td>
<td>FX</td>
<td>For 2D and 3D effects, enables the motion path editor. For paint and AniMatte effects, displays a wireframe representation.</td>
</tr>
<tr>
<td>Previous in Group</td>
<td>MCam</td>
<td>Selects the previous video track in a group of clips.</td>
</tr>
<tr>
<td>Next in Group</td>
<td>MCam</td>
<td>Selects the next video track in a group of clips.</td>
</tr>
<tr>
<td>Dual Split</td>
<td>Other</td>
<td>Divides the effect Preview in half so you can see the image with and without an effect applied to it. For the Source and Record monitors, it allows you to see two sequences (determined by the IN and OUT mark) simultaneously.</td>
</tr>
</tbody>
</table>
Using the Go to Start and Go to End Buttons

The Go to Start button moves you to the beginning of sequence in the Timeline. The Go to End button moves you to the end of the sequence in the Timeline.

To go to the beginning of a sequence:

1. Click the Move tab in the Command Palette.
2. Click the Go to Start button.

The position indicator moves to the beginning of the sequence.

To go to the end of a sequence:

1. Click the Move tab in the Command Palette.
2. Click the Go to End button.

The position indicator moves to the end of the sequence.

Table 4-3  Changes to Command Palette Buttons (Continued)

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Other</td>
<td>Enables you to replace a defined button with an undefined button. If you do not use specific buttons within a user tear-off palette, any pop-up menu, or the Record or Source monitor, you can replace the buttons with a Blank button.</td>
</tr>
<tr>
<td>through</td>
<td>More</td>
<td>Saves up to 8 customized workspaces.</td>
</tr>
</tbody>
</table>
Using the Audio Mark IN Button

The Audio Mark IN button creates a split edit (L cut) for an audio track during splice or overwrite. To create a split edit on an audio track:

1. Click the Edit tab in the Command Palette.
2. Move your position indicator to the location where you want to create an audio edit.
3. Click the Audio Mark IN button.
   
   An edit appears on the audio track.

Name Changes to Effects in the Effect Palette

Table 4-4 lists effects that have had their name changed in the Effect Palette for Release 7.0.

<table>
<thead>
<tr>
<th>New Effect Name</th>
<th>Old Effect Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal (Edge Wipe)</td>
<td>Vertical</td>
</tr>
<tr>
<td>Horizontal Open (Edge Wipe)</td>
<td>Vert Open</td>
</tr>
<tr>
<td>Horizontal Open (Saw Tooth Wipe)</td>
<td>Vert Open Saw Tooth</td>
</tr>
<tr>
<td>Horizontal (Saw Tooth Wipe)</td>
<td>Vert Saw Tooth</td>
</tr>
<tr>
<td>Horizontal Blind (Shape Wipe)</td>
<td>Vert Blind</td>
</tr>
<tr>
<td>New Effect Name</td>
<td>Old Effect Name</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Vertical (Edge Wipe)</td>
<td>Horizontal</td>
</tr>
<tr>
<td>Vertical Open (Edge Wipe)</td>
<td>Horz Open</td>
</tr>
<tr>
<td>Vertical Open (Saw Tooth Wipe)</td>
<td>Horz Open Saw Tooth</td>
</tr>
<tr>
<td>Vertical (Saw Tooth Wipe)</td>
<td>Horz Saw Tooth</td>
</tr>
<tr>
<td>Vertical Blind (Shape Wipe)</td>
<td>Horz Blind</td>
</tr>
</tbody>
</table>
Changes to the Consolidate Window

The Consolidate window has a new look; the functions remain the same.

Target Volume and Target Disk are equivalent.

Choose Consolidate from the Clip menu to see the new look. See “Consolidating” in the online help index.
CHAPTER 5

Effects

This chapter describes new effects in the following sections.

- Using the Effect Editor
- Position Information in Effect Mode
- Typing Timecode in Effect Mode
- Working with the Effect Grid
- Color Effect Enhancements
- Beveled Video Border for 3D Effects
- Expanded Support for Plug-Ins
- Submaster Editing
Using the Effect Editor

The Effect Mode button now brings up the Effect Editor, not the Effect mode as in earlier releases. You can also choose Effect Editor from the Tools menu. The Effect Editor window can be resized and moved. The following illustration shows the new layout for a 3D Picture-in-Picture effect.

The parameter list and buttons change for each effect. However, a core group of buttons appears on most effects. The following illustration shows the Effect Editor and the common buttons.
Table 5-1 describes the buttons that are common to most effects.

### Table 5-1  Common Effect Editor Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduce and Enlarge</td>
<td>Reduces or enlarges the image in the Effect Preview monitor. These appear on the Effect Editor for all effects. Option-click either button to return to the default magnification.</td>
</tr>
<tr>
<td>Dual Split</td>
<td>Splits the screen in half to show the image with and without effects applied to it.</td>
</tr>
</tbody>
</table>
### Table 5-1  Common Effect Editor Buttons  (Continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play Loop</td>
<td>Continuously plays a transition or segment effect. Click the button again or click in the key frame window to stop.</td>
</tr>
<tr>
<td>Play Forward</td>
<td>Plays the effect through once.</td>
</tr>
<tr>
<td>Transition Effect Duration box</td>
<td>Enables you to enter the length of a transition in seconds and frames.</td>
</tr>
<tr>
<td>Transition Effect Alignment menu</td>
<td>Enables you to choose whether a transition effect starts, ends, or is centered on a cut.</td>
</tr>
<tr>
<td>Grid</td>
<td>Displays the effect grid for precise placements of effects.</td>
</tr>
<tr>
<td>Outline/Path</td>
<td>Displays a wireframe representation to illustrate the movement of an effect from the first key frame through the last key frame.</td>
</tr>
<tr>
<td>Render Effect</td>
<td>Renders the effect.</td>
</tr>
<tr>
<td>Play Preview</td>
<td>Plays back a preview of an unrendered effect.</td>
</tr>
<tr>
<td>Add Key Frame</td>
<td>Adds a key frame at the current position of the blue position indicator in the effects Timeline.</td>
</tr>
</tbody>
</table>
**Big Effect Mode**

If you have a high resolution monitor and are in the Effect Editor, you can click the Effect Mode button again to bring up Big Effect mode.

Big Effect mode provides an enlarged window that makes working with effects easier. The Source monitor disappears and the Avid Composer transforms the Record monitor into a larger working space that makes it easier to create effects and make changes to them. You must be using a high-resolution Edit monitor to enter Big Effect mode.

To enable Big Effect mode:

1. In Composer mode, click and drag the Source and Record window so that it fills the screen of your high-resolution Edit monitor from side to side.

2. Click the Effect Mode button.
   
   The Effect Editor appears.

3. Click the Effect Mode button again.

   The Avid Composer system enables Big Effect mode. You might want to click and drag the Effect Editor to the free space to the left of the Big Effect monitor. Use the buttons in the Effect Editor to adjust the parameters of effects and to access the controls for playing and rendering effects.
4. To return to normal Effect mode, click the Effect Mode button at the bottom of the screen.

If you do not return to normal Effect mode, Big Effect mode remains the default state when you enter Effect mode in the future.
The Profile Parameter

The Profile window in the Effect Editor is a graphical representation of the foreground level and acceleration applied to effect key frames:

- **Foreground level** affects the opacity of the effect. The greater the opacity, the closer to the top of the Profile graph the key frame appears. For more information, see the following section, “Adjusting Foreground Level in the Profile Window.”

- **Acceleration** affects the rate of movement into and out of key frames. The greater the acceleration, the more rounded the lines appear in the Profile window. You can adjust Acceleration with the Acceleration slider in the Effect Editor only. For more information, see “Adjusting Acceleration” on page 116.

Adjusting Foreground Level in the Profile Window

Foreground level controls the opacity of a 3D effect layer. You can adjust levels for various key frames directly in the Profile window. Adjustments you make with the Foreground Level slider in the Effect Editor are also represented in the Profile graph.

To adjust foreground level within the Profile window:

1. Select the appropriate key frame in the effect’s timeline.
2. Click on the round white key frame indicator that appears on the Profile graph and drag it up or down to increase or decrease the opacity of the foreground image.
Adjusting Acceleration

Acceleration changes the speed of movement into and out of key frames. This is also known as _ease in_ and _ease out_. Zero (0) on the slider is no acceleration; 100 is full acceleration.

⚠️ Acceleration applies to every key frame in the same way. The last time you change this parameter determines the acceleration for all key frames in the effect.

Acceleration affects the following 3D Effect parameters:

- Shape (X and Y position)
- Position (if Spline is disabled)
- Scaling
- Rotation
- Axis
- Target
- Perspective
- Skew
- Crop
- Shadow (X and Y position)
Position Information in Effect Mode

In Effect mode, you can always view the length of the effect and your current position in the effect. The following illustration shows these two position information displays. These are the Abs (absolute position) and Dur (duration) values available from the Tracking information pop-up menu.

If the boxes do not appear, increase the size of your Effect monitor. These boxes always appear in Big Effect mode.

Typing Timecode in Effect Mode

This feature is similar to typing in timecode in the Record monitor. Click in the Effect monitor and begin typing. Use the number keys on the right side of the keyboard. The system determines when to add the colon to separate minutes, seconds, and frames.

The following example jumps forward 2 seconds and 30 frames. To get this result, simply type +230 and press Return.
Use the following options for typing in timecode:

- Don’t type the colon (:). The system automatically adds the character.
- To jump to a specific timecode, type the value and press Return.
- To jump forward or backward, type the amount to step and type a plus or minus sign. You can type the plus or minus sign before or after you type the number.
Working with the Effect Grid

The Effect Grid provides a variety of ways to position effects accurately and to previsualize them in the Effect Preview monitor. The following illustration shows a 12-field grid displayed in a video project.

In video and film projects, you can use the Effect Grid to:

- Display Safe Title and Safe Action guidelines.
• Display the aspect ratios for film categories such as standard film, Academy, Super 35 mm, and Anamorphic, as well as the 4 x 3 safety area for the 16 x 9 aspect ratio.

• Show coordinate information to track the exact location of an effect in the frame.

• Use the snap-to-grid feature to easily position effects.

In film projects only, you can use the Effect Grid to:

• View the results of a Blowup, Paint, or AniMatte effect.

• Interpret the path of a Paint or AniMatte effect over a series of frames using key frames. The coordinates show up when you generate a cut list, which enables the editor at the optical facility to track your effects accurately.

See Chapter 8, “Film Features.”

**Setting the Effect Grid Options**

To set the default grid values on your system, choose Grid from the Settings scroll list in the Project window. The following illustration shows the Grid Settings dialog box.
You can turn on the Effect Grid or turn it off by clicking the Effect Grid button in either Source/Record or Effect mode.

Setting Up the Effect Grid in a Film Project

In a film project, the Grid parameter pane values in Effect mode define a local grid effect that allows you to set the grid differently for each effect. If you save the effect as a template, the Avid Composer system automatically saves the local grid parameters as part of the template.
Use the Grid enable button to turn the local Grid effect on or off. If you disable the local Grid effect, the Avid Composer system uses the global settings defined by the Grid Settings dialog box. You can display the dialog box from two locations:

- Choose Grid from the Settings scroll list in the Project window.
- Click the Grid Settings dialog box button.

The Transfer fast menu values appear on the parameter pane but do not appear on the Grid Settings dialog box. The fast menu enables you to specify how the film was transferred to video as follows:

- Full Aperture — Transferred everything that is visible in the frame.
- Academy — Did not transfer the sound track area that appears on the left-hand side of the film.
### Grid Options

Table 5-2 describes the features of the Grid Settings dialog box.

**Table 5-2   Grid Settings Dialog Box Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>Determines the number of tick marks along the grid axes as well as the number of visible grid points. Since different optical houses expect different Field and Sub Field values, you should check with your optical house before defining your grid.</td>
</tr>
<tr>
<td>Sub Fields</td>
<td>Determines the snap-to-grid feature between visible grid points. The value determines how many jumps are in between each visible point. A value of 1 snaps only to visible points. A value of 2 provides 1/2 field jumps. A value of 4 provides 1/4 field jumps, and so on. A value of 0 turns off the snap-to-grid feature.</td>
</tr>
<tr>
<td>Source Scan Size</td>
<td>Uses these values if an optical house will use a film scanner to process your film (and add visual effects). Match the values to those used by your effects house.</td>
</tr>
<tr>
<td>Source Grid Offset</td>
<td>These values enable you to move the grid on the image. They are typically applied for reference purposes after the film has been scanned at the optical house. The offset allows you to sync up the telecine version with the scanned version. For example, you can add a marker to identify a specific location on one frame. If the optical house has different coordinate values for that point, you can offset the grid on the Film Composer system to match the optical house’s coordinates.</td>
</tr>
<tr>
<td>Type</td>
<td>Selects a different grid for each of the standard film types:</td>
</tr>
<tr>
<td>Standard Film</td>
<td>For 1.85, 1.77, and 1.66 and aspect ratios.</td>
</tr>
<tr>
<td>Academy</td>
<td>For 1.85, 1.77, and 1.66 aspect ratios with guides for the loss soundtrack area.</td>
</tr>
<tr>
<td>Super 35</td>
<td>For 2.35 aspect ratio.</td>
</tr>
<tr>
<td>Anamorphic</td>
<td>For 2.35 aspect ratio.</td>
</tr>
<tr>
<td>Color</td>
<td>Enables you to choose a color for the grid axes and the grid points.</td>
</tr>
</tbody>
</table>
Displaying the Position Coordinates in Effect Mode

The Avid Composer system uses compass coordinates and X, Y coordinates to describe the position of an effect. To view the coordinates, you must choose the Show Position Info option in the Grid dialog box and enable the Effect Grid. For compass coordinates, the point (0, 0) is the center of the axes. For X, Y coordinates, the point (0, 0) is the upper-left corner of the Source monitor. X values increase to the right and Y values increase as you move up.

The compass coordinates describe the effect’s position in terms of optical house standards. Each compass coordinate begins with a direction (N, S, E, or W, the abbreviations for North, South, East, or West) fol-

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Safe Title</td>
<td>Displays the safe title area. Create film titles within this area.</td>
</tr>
<tr>
<td>Show Safe Action</td>
<td>Displays the safe action area for video display. This box is self-adjusting for PAL and NTSC projects.</td>
</tr>
<tr>
<td>4 x 3 Safety for 16 x 9</td>
<td>Displays the safe area for the 4x3 aspect ratio when you are working in a 16x9 aspect ratio project</td>
</tr>
<tr>
<td>Show Axes</td>
<td>Displays the axes.</td>
</tr>
<tr>
<td>Show Tick Marks</td>
<td>Shows tick marks along the axes. Use the Fields parameter to set the number of tick marks.</td>
</tr>
<tr>
<td>Show Aspect Lines</td>
<td>Displays the aspect-ratio lines. Each grid type has different aspect-ratio lines.</td>
</tr>
<tr>
<td>Show Points</td>
<td>Shows the grid points. Use the Fields parameter to set the number of grid points.</td>
</tr>
<tr>
<td>Show Position Info</td>
<td>Enables you to display the coordinates of any point in the Record monitor.</td>
</tr>
</tbody>
</table>
lowed by a numerical value. This numerical component reflects the Field and Subfield parameters you choose in the Grid dialog box or the Grid Parameter pane.

The X, Y coordinates describe position in terms of the Source Scan Size parameters you choose in the Grid dialog box or Grid Parameter pane.

To display the coordinates in Source/Record mode, hold the mouse button down, and drag the cursor in the Record monitor.

To display the coordinates in Effect mode:
1. Deselect all tools in the Effect Editor (including the Selection Tool and the Path button).
2. Hold the mouse button down and drag the cursor in the Effect Preview monitor.

**Using the Effect Grid in a Film Project**

You can use the Effect Grid to include position information in a cut list for the Paint and AniMatte effects on a key-frame-by-key-frame basis. Additionally, you can display the position information for the first key frame of a Blowup effect in a cut list. You must enable the Effect Grid before you generate the cut list to display the coordinate information in the cut list.
Position Information for the Blowup Effect

The event section of the cut list displays the compass coordinates of the effect at the first key frame in the segment. Additionally, the Field parameter you have chosen for the effect appears before the position coordinates.

For information on the parameters available with the Blowup effect, see the Avid Media Composer and Film Composer Effects Guide.
Position Information for the Paint and AniMatte Effects

By enabling Key Frames in the Optical List Options of the Cut List Tool, you can track the position of each Paint and AniMatte effect on a key-frame-by-key-frame basis. You must enable the Effect Grid before you generate the cut list, or the coordinate information will not appear in the cut list. The following illustration shows a cut list that includes coordinates for a Paint effect.

```
<table>
<thead>
<tr>
<th>Level</th>
<th>Key Frames Footage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0:00</td>
</tr>
<tr>
<td></td>
<td>Chapel Solid (R: 255, G: 0, B: 6)</td>
</tr>
<tr>
<td></td>
<td>(3: 2.0, V: 9.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 2.0, V: 5.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 6.0, V: 5.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 6.0, V: 9.0)</td>
</tr>
<tr>
<td></td>
<td>5:04</td>
</tr>
<tr>
<td></td>
<td>Chapel Solid (R: 255, G: 0, B: 6)</td>
</tr>
<tr>
<td></td>
<td>(X: 5.0, V: 5.0)</td>
</tr>
<tr>
<td></td>
<td>(X: 5.0, V: 1.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 1.0, V: 1.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 1.0, V: 5.0)</td>
</tr>
<tr>
<td></td>
<td>18:06</td>
</tr>
<tr>
<td></td>
<td>Chapel Solid (R: 255, G: 0, B: 6)</td>
</tr>
<tr>
<td></td>
<td>(X: 4.0, V: 5.0)</td>
</tr>
<tr>
<td></td>
<td>(X: 4.0, V: 9.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 2.0, V: 9.0)</td>
</tr>
<tr>
<td></td>
<td>(3: 2.0, V: 5.0)</td>
</tr>
</tbody>
</table>
```

Compass coordinates: X, Y coordinates
The compass coordinates for Paint and AniMatte effects indicate the position of each corner of the effect for each key frame. For example, a pentagon you create with the Paint effect shows five associated compass coordinates. The X, Y coordinates in the cut list indicate the position of the center of the effect at each key frame.

For information on getting started with the Effect Grid and the Paint and AniMatte effects, and for generating a cut list that shows the position coordinates, see the *Avid Media Composer and Film Composer Effects Guide*.

**Displaying the Safe Title and Safe Action Guidelines**

Many effects can utilize the outer edges of the viewing screen area. If you are editing material that will be viewed on screens with more limited viewing areas, such as standard televisions, you can use the Safe Title and Safe Action options to provide visual guidelines in the Effect Preview monitor that replicate the actual viewable area on a standard television screen.

For example, you can use the Safe Title option as a template for the area in which you want the effect to operate. In this way, you can avoid the appearance of the effect floating off into a nonviewable area of a standard television screen.
Activate the Safe Title and Safe Action options in the Grid dialog box as described in "Setting the Effect Grid Options" on page 120. To display the Safe Title and Safe Action guidelines in Source/Record mode or Effect mode, Option-click the Effect Grid button.

Two outlined boxes appear in the Effect Preview monitor. The inner box is the Safe Title area. All text and objects should remain within the inner box. The outer box is the Safe Action area for video display.
Displaying the Aspect Ratio Grid for Film Projects

The Effect Grid displays several guidelines to show you where you could crop the top or bottom of your frame to achieve the “letter-box” effect. Use this feature to determine if an undesired element can be seen during screening, if an alternate take should be used, or if a resize is required. The following illustration shows the Standard Film aspect ratios.

Activate the film aspect ratio options as described in “Setting the Effect Grid Options” on page 120. To display the aspect ratios in Effect mode or Source/Record mode, click the Effect Grid button.

If you want to apply a mask effect, select one of the Film masks from the Effect Palette. For more information about applying effects, see “Real-Time Effects” in the Avid Media Composer and Film Composer Effects Guide.
Color Effect Enhancements

Release 7.0 adds the following features to the Color effect:

- Black and white point adjustment
- Luma clipping
- Gamma correction

The color effect is in the Image category of the Effect palette. The following illustration shows the Color Effect displayed in the Effect Editor.
Luma Adjust

Luma brightness and contrast are unchanged from previous releases:

- Bright (brightness) changes the brightness of the picture. The brightness parameter ranges from -100 to +100, where a value of zero indicates that the image is unchanged. Moving the slider in the negative direction darkens the image and moving the slider in the positive direction brightens the image.

- Cont (contrast) controls the contrast of light and dark areas in the picture. Values range from -100 to +100, where a value of zero indicates the image is unchanged. Moving the slider in the negative direction reduces contrast. Moving the slider in the positive direction increases contrast.

Luma Range

Luma Range is new for this release.

- Fast Menu - there are two selections: “16-235” and “0-255”. This menu allows you to specify the output range of the Black Point and White Point parameters. It is set to 16-235 by default, which is the default for video images.

Select 0-255 if you want to map normal video to alpha ranges. This is useful if you have a high contrast image that you want to expand to the full dynamic range. For example, use this value when you want to convert video to alpha for matte key effects.
• W Point (White Point) - allows you set the white point in the image. All pixels with that value become white and all pixels with higher values are also clipped to white. The default is 235 (the broadcast value for white).

• B Point (Black Point) - allows you set the black point in the image. All pixels with that value become black and all pixels with lower values are also clipped to black.

For example, you could use the eye dropper to select a shadow on the floor and change it from gray to black, clipping everything below that shade to black. The default is 16 (the broadcast value for black).

• Gamma - allows you to adjust the midtones in an image without affecting the extreme white or black values. Lowering the value darkens midtones and brings the image closer to black. Raising the value lightens the midtones and brings the image closer to white.

For example, a person shot in front of a window in daylight may be very dark, almost in silhouette. You can use gamma correction to increase the midtones without changing the blacks or whites. Values range from -100 to +100 with 0 being no change.

The number of shades of gray in an image are determined by the W-Point, B-Point, and Luma Clip sliders. The Gamma point allows you to move the distribution of the shades closer to black or closer to white. Negative values move the distribution closer to black. Positive values move the distribution closer to white.

Raising the Black Point and lowering the White Point values increases the contrast by reducing the number of shades of gray in an image. The number of shades are reduced because you map some to extreme black and others to extreme white.

*When you change the Luma Range to 0-255, the system attempts to go from 0 to 255 but will be clipped by the Low Clip and High Clip values. If it is your intent to “open up” the image to the full dynamic range, you need to change the Low Clip and High Clip values to 0 and 255, respectively.*
Black Point control does not change the Black setup level. That is done on the Video Output tool.

Luma Clip

Luma Clip is new for this release.

- High - provides a simple clip function for brightness values. When you specify a value for High, no pixel in the image can be brighter than that value. The default is 235 (the broadcast value for white).

- Low - provides a simple clip function for darkness values. When you specify a value for High, no pixel in the image can be darker than that value. The default is 16 (the broadcast value for black).

When preparing video for broadcast you usually don’t adjust these values. They allow you to adjust the brightness and contrast (using other controls in the color effect) while still maintaining legal broadcast values for black and white.

The Chroma Adjust, Color Style, and Color Gain parameters have not changed for this release. For a description of these parameters, see the Media Composer and Film Composer Effects Guide. Refer to the Image section in the 2D Effects Reference chapter.
Using the Color Effect to Adjust a High Contrast Image

This section describes how to enhance high contrast images used in Matte Key effects.

1. Apply the Color Effect and change the Luma Range to 0-255.
2. Set the Luma Clip High and Low sliders to 255 and 0, respectively.
3. Use the Chroma Adjust to remove all saturation from the image.
4. Adjust the Gamma to change the color of the mid tones. Note that this is the only non-linear function in the Color Effect.
5. Choose the Key category in the Effect palette and Option-drag the Matte Key effect icon onto the Color Effect. This nests the Color Effect within the Matte Key effect.

Black portions of the high contrast image will be transparent; white portions will be opaque. To switch the order, use the Reverse parameter on the Foreground parameter pane of the Matte Key effect.
Beveled Video Border for 3D Effects

There is an additional Video border choice for 3D Effects. The following illustration shows an example of the border on a Picture-in-Picture effect.

The Video border uses the video as part of a beveled edge.
Expanded Support for Plug-Ins

A plug-in is a small application designed to do a specific task that can be loaded and accessed by a host application such as an Avid Composer system. Plug-ins allow new effects to be added to the Avid Composer system, or an effect to be updated, with no changes to the Avid Composer system.

The three basic types of plug-ins supported in Release 7.0 are:

- AVX (Avid Visual Extensions) plug-ins (new for Release 7.0)
- Adobe Photoshop® 2.5-compatible plug-ins (no change from Release 6.5)
- Digidesign AudioSuite™ plug-ins (new for Release 7.0)

This section describes AVX plug-ins.

For information on using Photoshop 2.5 compatible plug-ins, see the Avid Media Composer and Film Composer Effects Guide. For information on Digidesign AudioSuite plug-ins, see Chapter 7.

Installing AVX Plug-In Effects

AVX is a plug-in standard for integrating various third-party effects with the Avid Composer system. AVX uses a cross-platform software architecture designed to allow software effect modules to be dynamically linked with a host application such as the Avid Composer system.

You can purchase these plug-ins directly from a third-party vendor. The following list has three of the current vendors, along with each vendor’s plug-in product name and internet web address.

- Ultimatte® Corporation (Ultimatte™)
  http://www.ultimatte.com
AVX plug-ins usually come complete with any necessary documentation. This section describes how to install the plug-ins and how to access them from the Avid Composer system.

To install AVX plug-ins:

1. Exit the Avid Composer application.

   **Do not add or remove plug-ins while the Avid Composer application is running.**

2. Copy the plug-in files from the software vendor’s folder to the AVX_Plug-Ins folder on the Avid drive.
You must place the plug-ins directly in this folder. They cannot be inside another folder within this folder or elsewhere on the Avid Composer. If they are, the system will not recognize them.


The following is an example of how AVX plug-in effects appear in the Effect Palette. This example shows several Boris effects.

For information on applying third-party effects, see “Applying a Third-Party Plug-In Effect” on page 141.

Some plug-in effects come with their own installation program. In that case, follow the directions supplied with the package.

Troubleshooting AVX Plug-Ins

This section describes solutions to problems that you may encounter with AVX Plug-Ins.

Blank Effect Icons in the Timeline

AVX Plug-Ins have a plug icon in the Effect palette and in the Timeline. If the Effect icon in the Timeline is blank, the Avid Composer either could not find the plug-in or the plug-in version doesn't match the version of software that you used to create the plug-in.
To determine the cause of the problem, open the Console window (choose Console from the Tools menu) and look for the message "Can't find effect". The message will identify the Plug-In that can't be displayed.

The following are the most common problems:

- The plug-in may be missing from the AVX_Plug-Ins folder. Open the AVX_Plug-Ins folder (located in the SupportingFiles folder) and look for your plug-in. If it is missing, replace it. This may involve reinstalling the plug-in.

- The plug-in in the AVX-Plug-Ins folder may be incompatible with the effect in the Timeline. This might happen if you update the plug-ins on your system. For example, if you create an effect with Version 1.1 of the plug-in software and then update your plug-ins to Version 2.5, the new software may not be compatible with the old effect.

Plug-ins should be compatible with minor releases but not necessarily with major releases of the plug-in software. For example, Version 1.0 of a plug-in should be compatible with Version 1.1 or 1.2 (minor revision). But Version 1.0 may not be compatible with Version 2.0 (major revision change).

If the plug-in is correctly installed, contact the plug-in vendor and ask if there are any known version compatibility problems with the plug-in.

**Missing Effect Categories in the Effect Palette**

If the Plug-In categories are not visible in the Effect palette, they are either not installed correctly or you may have an incorrect version of the AVXLibrary. In this case, check the Console window for a message that states that AVX was disabled. If it was not disabled, quit the Composer application, reinstall the plug-ins, and restart the application.
If the message in the Console states that AVX software was disabled, call Avid Customer Support to determine whether you need a new version of the AVXLibrary.

The Avid Composer System Cannot Render the Plug-In

If the Avid Composer cannot render the plug-in, check the Console window. Some plug-ins write more information about the failure to the Console window. Also, some plug-ins may report the problem as a message at the bottom of the Composer monitor. In general, contact the plug-in vendor if a plug-in doesn't work as expected.

Applying a Third-Party Plug-In Effect

Third-party plug-in effects are applied to a sequence using procedures that are similar to those used for an Avid Composer effect. The only difference is that parameters for third-party plug-in effects appear automatically in dialog boxes when you apply the effect to the sequence. Third-party plug-in effects you can apply to a sequence include plug-ins compatible with Adobe Photoshop Version 2.5, AVX plug-ins, and Digidesign AudioSuite Plug-Ins.

Applying a plug-in effect is similar to applying a standard Avid Composer effect.

1. Choose Effect Palette from the Tools menu.
   The Effect Palette appears.

2. Choose the effect category that contains the plug-in. For example, the following illustration shows the Boris plug-ins.
3. Drag the effect onto your clip or transition in the Timeline.

4. Click the Effect Mode button.

The Effect Editor appears. Plug-in vendors have the following styles for dialog boxes:

- The Avid Composer-style Effect Editor controls only. This means that you only see controls in the Avid Composer Effect Editor window.

- Custom dialog box only. In this case, when you open the Effect Editor, the window does not display any Avid Composer-style controls. Click the Other Options button to open the Plug-in dialog box.

- Combination Avid Composer-style and custom. In this case, the Avid Composer-style controls appear and you also see the Other Options button. Click the button to see the additional dialog box.

5. Adjust and preview the effect depending on the controls in the dialog box. The plug-in vendor usually supplies documentation on how to adjust the effect.

6. When appropriate, render the effect.
Applying a third-party plug-in to a clip can cause the clip levels to be illegal by NTSC standards. Use an external vectorscope to check if the chroma and luma levels are still appropriate. If they are not, apply a color effect within the Avid Composer to correct the levels.

Submaster Editing

The Submaster effect is in the Image effect category. When you render this effect, Avid Xpress creates a single media file from several clips or effects in a sequence. This saves the new submaster clip to the disk as a single media file. However, each element that makes up the composite is left untouched so you can still manipulate any element.

The Submaster effect is a single-track segment effect and is available only if your Avid Xpress system supports the nested editing option.

- You can nest up to 24 tracks inside a Submaster effect.

An EDL for a sequence that contains a Submaster effect represents the contents of the submaster as a single cut. To work around this, you can create a new sequence with the contents of the submastered material and generate a separate EDL for that sequence.

Submaster Editing of Multiple Clips

The Submaster effect is useful when you want to play back bandwidth-limited sequences, such as sequences made of several seconds, worth of single-frame clips. It is much faster to use the new submaster clip than to use older methods such as applying a graphic, Mask, Resize, or Picture-in-Picture effect. Normally, submaster effects render at about the same rate as motion effects.

To apply a Submaster effect to multiple clips:
1. Choose New Video Track from the Clip menu, or press ⌘-Y.

2. On the new video track (V2 in the example), use the Add Edit button to mark two add edit marks at the start and end of the clips to be submastered.


4. Click and drag the Submaster effect icon from the Image effect category between the add edits you added on the new track.

   The system creates a new single-track segment clip from the clips below the Submaster effect.
Submaster Editing of Multiple Effects

The Submaster effect is also useful when you have combined effects, such as when you have layered or nested effects, or when you have segments or motion effects that begin or end with a transition effect.

Rendering a Submaster effect creates a single media file that contains all the selected effects.

A Submaster effect maintains links to the original media files so you should not delete the original files. If you want to combine tracks to create a sequence that is independent from the original media files, use Video Mixdown.

The Submaster effect does not render each track separately, so you cannot play each track individually, and the blue dot remains in the effect icon. In addition, you cannot delete a track below a Submaster effect or it becomes unrendered.

To apply a Submaster effect to multiple effects:

1. Choose New Video Track from the Clip menu or press Ctrl+Y.

2. On the new video track (V4 in the following example), mark two add edits at the start and end of the clips that contain effects to be submastered.

3. Choose Effect Palette from the Tools menu, or press Ctrl+8.

Add edit marks on new track V4; bracket clips on tracks V1, V2, V3

3. Choose Effect Palette from the Tools menu, or press Ctrl+8.
4. Click and drag the Submaster effect icon from the Image effect category between the add edits you added on the new track.

5. Highlight the V4 track selector and deselect any other tracks.

6. Place the blue position indicator over the Submaster effect in the Timeline.

7. Choose Render at Position from the Clip menu.

   The Render Preferences dialog box appears.

8. If you do not want to render the real-time effects in the selected group of effects, select Skip Real-Time Effects.

9. Click OK.

   All effects at the position indicator are rendered.
Collapsing Layers into One Submaster Effect

You can use the Collapse button to build a multilayer effect. This feature allows you to nest your effects after building them on separate tracks.

The Collapse function allows you to build your effect at the topmost level and, when you are finished, collapse the layers automatically into one Submaster effect. This function is useful for simplifying a sequence with complex compositing. Once you have collapsed a complex composite, you can easily add transition effects to the start and end of the newly created submaster composite effect.

After the tracks are collapsed into a Submaster effect, Avid Xpress recognizes a Submaster effect as a multiple-layer effect instead of a single-layer effect. This allows you to add more multiple-layer effects to the nested tracks within a Submaster effect.

You can drag “two-channel” effects (such as chroma key) onto submaster effects if the submaster contains two or more nested tracks. This is useful after performing a Collapse operation to composite the newly created submaster over another background.

To collapse a sequence:

1. Highlight all the tracks you want to collapse. The tracks must be adjacent.
2. Mark an IN and OUT point around the area to be collapsed.

Select the Collapse button from the Tear-off palette.
CHAPTER 6

Downstream Keying and Title Tool Enhancements

This chapter describes the following features and enhancements for creating titles in the Title Tool, and editing titles and graphics imported with alpha channel using the Avid Composer system’s downstream key capabilities:

- Downstream Keying of Titles and Graphics
- Creating Rolling or Crawling Titles
- Saving Titles
- Editing with DSK Titles and Graphics
- Other Title Tool Enhancements
By default all titles are now created with the Avid Composer system’s downstream key (DSK) capabilities. Graphics files imported with an alpha channel are also created as DSK clips.

Downstream keying allows you to add uncompressed titles or graphics over multiple streams of compressed media and continue to play the sequence in real time. The benefits include:

- **High-quality lossless images.** Because the DSK title or graphic is uncompressed, the image retains its full quality.

- **Real-time adjustment of key frames and title parameters.** When you adjust key frames or effect parameters for the DSK title effect, the title continues to play back in real time.

- **Layering of titles over real-time or rendered effects.** You can apply a DSK title over a rendered effect or a real-time effect such as a transition, and all effects continue to play back in real time.

- **Smooth motion.** Downstream keying uses subpixel placement for smooth motion in rolling or crawling titles. Subpixels are units smaller than pixels.

To learn more about editing with DSK titles, see “Restrictions of DSK Titles” on page 161.
Creating Rolling or Crawling Titles

You can create text or graphics that move across the screen. You create the title in the Title Tool and refine the motion during editing.

Rolling titles scroll vertically, moving from top to bottom or bottom to top, as shown in the following example.

Crawling titles scroll horizontally, moving from left to right or right to left, as shown in the following example.
Page Count Limits for Rolling or Crawling Titles

Rolling or crawling titles form pages in the Title Tool that are similar to the pages you create in a word processor. A page in a rolling or crawling title is a unit the size of a National Television Standards Committee (NTSC) or Phase Alternating Line (PAL) frame.

Table 6-1 shows the maximum number of pages you can create for rolling or crawling titles.

Table 6-1 Title Object Size

<table>
<thead>
<tr>
<th>Width (in Pages)</th>
<th>Width (in Pixels)</th>
<th>Height (in Pages)</th>
<th>Height (in Pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic objects</td>
<td>6 NTSC 5 PAL</td>
<td>4 K</td>
<td>17 NTSC 14 PAL</td>
</tr>
<tr>
<td>Text objects</td>
<td>12 NTSC 11 PAL</td>
<td>8 K</td>
<td>67 NTSC 57 PAL</td>
</tr>
</tbody>
</table>

Page limitations are based on the overall size of the text object. Typing more text, increasing the size of the font, or adjusting kerning and leading all affect the number of pages in the object.

- If you reach the end of the page limitation during typing of text, the object stops getting bigger and text entry stops.
- If you attempt to make changes to the text formatting that cause the text to exceed the page limit, an alert box appears stating that the operation will exceed the limit. Click OK to stop the operation.
Using Auto Size Mode

Auto Size mode causes the Title Tool to add or remove pages automatically as you add, delete, or reformat the text. You can disable Auto Size mode if you want to add extra pages before or after the text to make room for additional title elements, for example.

Auto Size mode is active by default in rolling or crawling modes. To toggle Auto Size mode off or on, choose Auto Size Mode from the Object menu. A check mark indicates that Auto Size mode is enabled.

Setting Up Text Formatting for Rolling Titles

Before creating a rolling title, consider setting up the text formatting defaults for things such as font, point size, leading, and kerning.

As you type text for a rolling title, lines of text wrap appropriately within the safe title area; the title scrolls down as you type, providing a realistic sense of positioning, word wrap, and page count limitations.

Workflow Options for Creating Crawling Titles

Unlike rolling titles, which scroll in the direction of the roll as you type the text, crawling titles do not scroll horizontally in the direction of the crawl during typing. To facilitate the creation of crawling text, consider the following workflow options:

- You can begin typing with a small font size, such as 12 point, to view as much of the text in the window as possible before you change the font size and horizontally resize the text box.

- You can type the text first as a rolling title. This allows you to view the text as it scrolls during typing, and provides you with a scroll bar for moving quickly through the text. You can then click the C button in the tool bar to convert it to a crawling title before resizing, reformatting, and saving the title.
Typing the Rolling or Crawling Text

To type rolling or crawling text:

1. Choose New Title from the Clip menu.
   The Title Tool appears.

2. Select the Text Tool.

3. To make a rolling title, click the R button; to make a crawling title, click the C button. You cannot select both.

   The button turns green, and a page number display appears in the bottom right corner of the Title Tool. The Video background button is automatically enabled (you cannot create rolling or crawling titles over a color background).

4. Type the title text. The text wraps automatically as you type.

5. When you finish, click the Selection Tool in the Title Tool tool bar to select the new text object.
Resizing a Rolling or Crawling Title

To resize a rolling or crawling title:

1. Select the title object with the Selection Tool.
2. Click an object selection handle and drag to resize the width of the title until it appears as you wish.

Word wrapping for the text adjusts according to the resized space.

- You can resize only the width of a text object. The height of a text object is automatically determined by the amount of text.
- Unlike still titles, a rolling or crawling title object can be sized to extend beyond the boundaries of the screen in the direction of the roll or crawl.

Scrolling Through a Title

When you create a rolling or crawling title, scroll bars appear:

- In rolling titles, a scroll bar appears along the right side of the Title Tool window for moving vertically through the title.
- In crawling titles, a scroll bar appears along the bottom of the window for moving horizontally through the title.

Use standard Macintosh techniques for scrolling, such as clicking the arrow icons, dragging the scroll box, or clicking in the gray areas between the scroll box and the arrows. You can also do the following:

- Press the Page Up or Page Down keys on the keyboard to move through the title one page at a time.
- Press the Home or End keys to go to the beginning or end of the title.
- Press the up and down arrow keys to move the cursor through the title one line at a time.
**Going to a Page**

The page number display reflects your current position in the title.

To go to a different page:

1. Click in the page number display.

2. Enter a page number for a specific page, or use the up and down arrow keys to cycle through the page numbers.

3. Press Enter or Return.

**Adding Pages**

You can add pages to a rolling or crawling title to create space for adding new elements.

To add pages:

1. Choose Auto Size Mode from the Object menu to disable it (the check mark should no longer appear in the menu).

   *The Add Page command is not available when Auto Size mode is enabled.*

2. Choose Add Page from the Object menu to add a page. You can choose Add Page repeatedly to continue adding pages up to the maximum page count.

   *For more information on maximum page counts, see “Page Count Limits for Rolling or Crawling Titles” on page 151.*

155
3. Select text or graphic objects within the title and position them within the range of available pages, or create new elements anywhere within the range of pages.

Deleting Additional Pages

You cannot select individual pages to delete during the creation of a rolling or crawling title. However, if you add pages to the title with Auto Size mode disabled, once you complete the title you can remove excess pages after the title elements.

To delete additional pages, choose Auto Size Mode from the Object menu. Excess pages at the end of the title are removed.

Formatting Rolling or Crawling Titles

You can modify the text attributes of a rolling or crawling title by using the same methods as used to format still text elements:

- Change the font, point size, style, justification, kerning and leading.
- Create borders surrounding the text.
- Adjust color and transparency.
- Add a drop or depth shadow.

For more information, see the *Avid Media Composer and Film Composer Effects Guide*. 
**Saving Titles**

The guidelines and procedures for saving newly created DSK titles have changed slightly. In addition, a new Fast Save option saves time when you create a series of complex DSK titles in a Title Tool session.

The two basic ways to save your work are:

- Save the title and exit the Title Tool.
- Save the title and continue creating additional titles based on the first title.

**Matching Resolutions**

When you save a new title, you must choose an AVR for the title that is compatible with the project, based on the following:

- Even though DSK titles are saved in uncompressed form, the rules regarding single-field, two-field, and multicamera AVRs apply. In other words, you cannot mix single-field AVR titles with two-field AVR media in a sequence, and you cannot mix either single-field or two-field with \( m \) resolutions (multicamera resolution).

For more information on available AVRs and mixing resolutions in a project, see the Avid Media Composer Products Reference.

- Your Avid Composer system uses the resolution information to compute the dimensions of the title.
- If you decide during editing that you need to render the title to create a layered effect, the title renders with the AVR you select when you first save the title.
Using the Fast Save Option

You can use the Fast Save option to work more quickly when creating and saving multiple titles in a Title Tool session. Fast Save skips the steps that create anti-aliased images from title objects. Instead, just the raw title objects (text and graphics) are saved in the bin, with the prefix “unrendered.” Fast Save is ideal for working with multipage rolling or crawling titles with complex styles and shading.

A title with the “unrendered” prefix cannot be displayed in the Source or Record monitors or edited into a sequence and will not be automatically loaded into a pop-up monitor when you exit the Title Tool.

To use the Fast Save option, select the option Fast Save (unrendered) in the Save Title To Bin dialog box when saving the title.

Fast Save remains in effect until you either deselect it, load a title that was saved without Fast Save selected, or exit the Title Tool.

To render a fast-saved title:

1. Press the Control key and double-click the title in the bin to load it into the Title Tool.
2. Choose Save Title As from the File menu.
3. Choose an AVR, target bin, and target disk for the title.
4. Deselect Fast Save and click OK.
Saving a Title and Exiting the Title Tool

To save the title and exit the Title Tool:

1. Choose Close from the File menu.
   A dialog box appears asking if you want to save the existing title.

2. Click Save. The Save Title To Bin dialog box appears.

3. Enter a title name to identify the title in the bin; then choose a bin, target disk, and AVR from the pop-up menus.

4. Select or deselect Fast Save, depending on your needs. For more information, see “Using the Fast Save Option” on page 158.

5. Click OK.
   The Title Tool window closes and the new title is loaded into the Source monitor. A two-minute Title Effect clip that corresponds to the new title appears in the bin.
Saving Multiple Titles in a Session

To save multiple titles:

1. Choose Save Title from the File menu. The Save Title To Bin dialog box appears.

2. Enter a title name to identify the title in the bin; then choose a bin, target disk, and AVR from the pop-up menus.

3. Select or deselect the Fast Save option, depending on your needs. See “Using the Fast Save Option” on page 158.

4. Click OK.

The new Title Effect clip appears in the bin.

5. Create another title.

6. Choose Save Title As from the File menu and repeat step 2 for each subsequent title you create.

When you close the Title Tool, the last title created is loaded into the Source monitor.

If you keep the same name for the title when you choose “Save Title As” the system retains the first clip and creates a new one with the same name plus a two-digit extension that adds incremental numbering for each revised title.
Editing with DSK Titles and Graphics

Editing with titles involves placing title clips in a sequence and then adjusting effect parameters or revising the title in the Title Tool. The following section provides guidelines for editing with title media.

Restrictions of DSK Titles

The following are a few restrictions to keep in mind with DSK titles:

• Rolling or crawling titles are always DSK titles, unless you render them. However, you can convert a still DSK title to a non-DSK title. See “Converting DSK Titles” on page 162.

• You can play in real time only one DSK title at a time in a nested effect. The DSK title must be on the top layer of the nested tracks.

• Titles promoted to 3D are no longer DSK. Keep a copy of the original title if you want to continue using the DSK version.

• You cannot promote a rolling or crawling title to 3D.

• DSK titles become non-DSK titles when you replace the fill track. For more information, see “Replacing Fill Tracks” on page 179.

• All DSK titles must be created within (or cropped to within) the safe title area to guarantee real-time playback.

• Rolling or crawling titles might jitter slightly at certain speeds. You can adjust the duration slightly to fix the problem. See “Trimming the Duration of Rolling and Crawling Titles” on page 166.

If you experience an underrun error with a DSK title, do one or more of the following:

• Render the DSK or underlying effects.

• Slow the roll or crawl by extending the duration of the clip.

• Add filler to separate DSK clips in the sequence.

• Store title and video media on separate disks, or use faster disks.
Converting DSK Titles

All newly created titles and graphics imported with alpha channel are DSK clips by default. You can convert static DSK titles and graphics to non-DSK titles and matte key effects.

You might want to convert a DSK title to a non-DSK title in situations like the following:

- If you want to replace the fill track with a graphic or video
- If you want to play two titles simultaneously. The top title can remain DSK, but the bottom title or titles must be non-DSK.
- If you want to resize a 2D Title effect.
- If you want to play a title that causes a “DSK image too large” error message.

You cannot convert a rolling or crawling title to non-DSK. You can render a rolling or crawling title.

To convert a DSK title to a non-DSK title:

1. Place the blue position indicator on the DSK title or graphic in the Timeline.
2. Click the Effect Mode button to open the Effect Editor.
3. Deselect the Downstream Key button.

The Downstream Key button changes from pink to gray, and the effect is now a non-downstream key effect.

4. To reenable the downstream key capabilities, open the Effect Editor and click the Downstream Key button again.

If you replace the fill track of a non-DSK title, you cannot restore the DSK capabilities.
Restrictions of Non-DSK Titles

DSK titles and non-DSK titles have different real-time playback capabilities during editing and adjustment of key frame parameters. For more information, see “Playback Capabilities of DSK and Non-DSK Titles” on page 164.

Depending on the complexity of the title and the video it is keyed over, not all non-DSK titles can be played in real time. When you attempt to play a complex title, the following conditions might occur:

- Background video might jitter.
- Title might flash.
- Title might display a gray slide.
- Video might shift left or right.
- Video might display a gray slide.
- Vista missed frame advance error might occur.
- Video underrun error might occur.
- Audio underrun error might occur.

If you encounter any of these conditions, try one or more of the following:

- Render the title or underlying effects.
- Simplify the title by removing text or drop shadows or by selecting different colors.

It is possible that a title with background video can be so complex that you can neither play it in real time nor render it.

It is also possible that you cannot play rendered titles because the resulting frames are too complex. You can control the complexity of titles by using the project’s Render settings.
Playback Capabilities of DSK and Non-DSK Titles

DSK titles and non-DSK titles behave differently in terms of real-time playback during editing and adjustment of effect parameters. Table 6-2 lists the different playback capabilities in different circumstances.

<table>
<thead>
<tr>
<th>Operation</th>
<th>DSK Title Playback</th>
<th>Non-DSK Title Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust foreground level parameter</td>
<td>Real-time</td>
<td>Real-time</td>
</tr>
<tr>
<td>Adjust scale parameters</td>
<td>Not available</td>
<td>Non-real-time</td>
</tr>
<tr>
<td>Adjust position (vertical, horizontal)</td>
<td>Real-time</td>
<td>Non-real-time</td>
</tr>
<tr>
<td>Adjust scroll position</td>
<td>Real-time</td>
<td>Not available</td>
</tr>
<tr>
<td>(rolling and crawling titles only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjust cropping</td>
<td>Real-time</td>
<td>Not available</td>
</tr>
<tr>
<td>Adjust top, bottom softness</td>
<td>Real-time (two-field AVR only)</td>
<td>Not available</td>
</tr>
<tr>
<td>(rolling titles only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace the alpha track</td>
<td>Not available</td>
<td>Real-time</td>
</tr>
<tr>
<td>Apply to a layer above a non-DSK title</td>
<td>Real-time</td>
<td>Non-real-time</td>
</tr>
<tr>
<td>Apply to a layer below a DSK title</td>
<td>Non-real-time</td>
<td>Real-time</td>
</tr>
<tr>
<td>Key over extremely complex images</td>
<td>Real-time</td>
<td>Non-real-time</td>
</tr>
</tbody>
</table>

All DSK titles must be cropped to within the safe title area to guarantee real-time playback. If you create a title that extends to the edges of the screen, real-time playback cannot be guaranteed.
Downstream Key Error Messages

When you edit with DSK titles or graphics, you might experience either an underrun or a “image too large” error message. Table 6-3 describes causes and possible solutions for these problems.

Table 6-3  Downstream Key Error Messages

<table>
<thead>
<tr>
<th>Error</th>
<th>Problem</th>
<th>Possible Cause</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| DSK underrun error | The graphic key could not be loaded in time. | Insufficient disk speed, or the title is rolling or crawling too fast or a series of DSK graphics are too close together. | Render the DSK clip and underlying video.  
Slow down the rolling or crawling title.  
Store the DSK clip media on a drive other than the drive containing the underlying media.  
Add filler between sequential DSK clips.  
(Crawl only) Decrease the visible graphic height by cropping or by revising the title in the Title Tool.  
Use faster drives. |
| DSK image too large | A moving title does not play correctly. | The system has limitations that restrict the size of the graphic to the safe title region of the screen. | Crop the title to fall within the safe title region.  
Soften the top and bottom of a rolling title to fall within the safe title region.  
Revise the title in the Title Tool to fall within the safe title region.  
If appropriate, eliminate the motion of the title.  
Reduce the Record monitor video size by using the magnify/reduce button.  
Render the title. |
About Setting Marks in Rolling and Crawling Titles

By default, a rolling or crawling title clip begins with the visible title just off screen. The clip ends just after the last element disappears off screen.

You can set IN and OUT marks in the Source monitor to change the start and finish points; that is, you might want the title to begin with a screen full of text rather than start off screen.

You can play and mark a title clip in the Source monitor by using standard procedures. For more information, see the user’s guide.

If you want to use the complete roll or crawl in the sequence, do not set marks. For information about adjusting the duration of the roll or crawl, see “Trimming the Duration of Rolling and Crawling Titles” on page 166.

If no IN mark is present, the system uses the position indicator as the IN point of a rolling or crawling title.

Trimming the Duration of Rolling and Crawling Titles

When you edit the title clip into a marked segment of a sequence, the clip plays back from the IN to OUT marks specified in the Source monitor regardless of the duration of the segment. In other words, the entire roll or crawl shrinks to fit within the duration of the marked segment in the sequence.

Once the clip is edited into the sequence, you can trim the duration of the segment at any time, and the rolling or crawling title adjusts to fit the new duration.

Unlike trimming other segments, trimming a rolling or crawling title does not remove any part of the title contents. As a result, the duration
of the title determines how fast it plays. For example, the shorter you trim the title, the faster it rolls or crawls.

To trim the duration of a rolling or crawling title:
1. Enable the track containing the title and disable all other tracks by using the Track Selector panel.
2. Click the Trim Mode button to enter Trim mode.
3. Select either the head or the tail of the title segment for trimming.
4. Trim the title segment to the duration you want by using standard trim procedures.
   The entire roll or crawl plays back within the new duration.

If you trim your rolling or crawling title very short, it scrolls very fast and can’t display in real time; it must be rendered. The maximum speed it can scroll is one screen per second.

To adjust the begin and end progression of the scroll, adjust the scroll position parameter in the Effect Editor.

**Fading a Title**

You can use the Fade Effect button to fade a title quickly and easily. A dialog box appears that allows you to enter the number of frames to fade up and fade down.

The Fade Effect feature automatically creates key frames for the title segment. You can access the key frames in the Effect Editor.

To fade a title:
1. Load the sequence if you haven’t already done so.
2. To fade a single title, place the blue position indicator in the title segment.
To fade multiple titles in a sequence, click either the yellow Extract/Splice-in button or red Lift/Overwrite button at the bottom of the Timeline window to enter Segment mode, press the Shift key, and click the desired title segments in the Timeline.

3. Click the Fade Effect button.

You can map the Fade Effect button to the Record monitor or the user tear-off palette. For more information on mapping buttons, see either the Avid Media Composer User’s Guide or the Avid Film Composer User’s Guide.

4. In the dialog box that appears, enter the number of frames to fade up and fade down, and click OK.

This fades the selected title or titles. You can immediately view the Fade effect by playing the title segment.
Adjusting Title Effect Parameters

After editing a title into a sequence, you can open the Effect Editor and refine the title with full keyframe control over effect parameters such as position, scale, crop, and softening for rolling and crawling titles.

DSK titles and non-DSK titles have different playback capabilities when you adjust effect parameters. For more information, see “Playback Capabilities of DSK and Non-DSK Titles” on page 164.

Accessing Effect Parameters for Title Effects

To access the effect parameters for a title effect:

1. Click the Effect Mode button.
   The Effect Editor appears.
2. Click the title in the sequence to select it.
   The Effect Editor displays the parameter controls for the type of title effect you selected. The following illustration displays the parameter controls for a rolling title.
Using Title Key Frames

A key frame is a point in the title’s Timeline (or the Timeline of any effect) at which you can set parameters. You can use multiple key frames to gradually change the parameter settings over time. Key frame indicators appear as triangles in the title’s Timeline under the Record monitor.

Adjusting the Effect Profile

The Profile window in the Effect Editor is a graphical representation of the current foreground level and acceleration parameter settings applied to the key frames in the effect:

See the Avid Media Composer Products Reference for details about how many key frames you can set with your system configuration.
Foreground level affects the opacity of the title effect. You can use the Profile graph to adjust level by selecting the appropriate key frame in the effect’s Timeline, then clicking on the Profile key frame and dragging it up or down to decrease or increase the transparency. You can also use the Foreground Level slider. For more information, see “Adjusting Foreground Level” on page 171.

Acceleration affects the rate of movement into and out of key frames. The greater the acceleration, the more rounded the line appears in the Profile window. You adjust acceleration with the Acceleration slider. For more information, see “Adjusting Acceleration” on page 171.

The Profile window is also described in “The Profile Parameter” on page 115.

### Adjusting Foreground Level

Foreground level determines the opacity of the title at the selected key frame or key frames. If the overall transparency you determined when you created the title needs adjustment, you can change it here without revising the title itself. You can also change the transparency over time by adjusting level for individual key frames.

Move the Foreground slider to change the transparency of the title.

- The 0 setting is completely transparent.
- The 100 setting gives you fully opaque characters.

### Adjusting Acceleration

Acceleration changes the speed of movement into and out of key frames. This is also known as *ease in* and *ease out*. Zero on the slider is no acceleration; 100 is fast.
Acceleration applies to every key frame in the same way. The last time you change this parameter determines the acceleration for all key frames in the sequence.

Acceleration is not recommended for rolls or other DSK titles with vertical motion, due to anti-aliasing effects which cause flicker.

**Adjusting Position**

The horizontal position (H Pos) and vertical (V Pos) position sliders allow you to change the position of the title on screen. Rolling and crawling titles have additional scroll position (Scroll Position H or Scroll Position V) parameters.

If the position you determined when you created the title needs adjustment, you can change it here without revising the title itself:

- Move the V Pos or H Pos slider to adjust the position of the title on the screen.
- For rolling and crawling titles, you can also move the Scroll position slider to adjust your location in the title.
- For rolling and crawling titles, you can change the scrolling direction with the Reverse button. Unlike clips of footage, title clips do not play smoothly when you press the J key or click the Play Reverse button. Click Reverse to change scrolling direction.

If you select all key frames when changing the scroll position, all key frames will be set to that position and the title will no longer roll or crawl. Make sure you select the appropriate key frames.
Cropping Titles

Move the following Crop sliders to adjust the cropping of your title:

- T – Top
- B – Bottom
- L – Left
- R – Right

For rolling and crawling titles, cropping produces two different effects depending whether you crop parallel or perpendicular to the motion of the title. These two types of crops are referred to as source and destination crops:

- Source cropping a rolling or crawling title trims the title itself, regardless of where the title appears on the screen. This is similar to cropping a still title.

Source cropping does not move the location of the title. Cropping titles parallel to the scroll direction is a source crop. For example, if you set the left Crop slider of a rolling title to 30, you trim the left boundary of the title toward the center by 30 points.

Parallel to the scrolling direction
Because the title comes out of the Title Tool already cropped in size fairly close to the text, using a source crop might begin to cut the title itself.

- Destination cropping changes the size of the window the title appears in. Destination cropping occurs when you crop perpendicular to the direction of the motion (across the scroll direction). For example, if you set the top Crop slider of a rolling title to 30, you shorten the size of the window the title rolls through by 30 points at the top.

Rolling and crawling titles have opposite destination and source crop effects, as Table 6-4 shows. Keep in mind that destination cropping takes place across the scroll direction.
Softening Edges on Rolling Titles

You can soften the top and bottom edges of rolling titles so that the title does not enter and leave the screen abruptly from the very edges of the screen, but appears out of regions of gradual transparency. This feature is only available for two-field resolutions (AVR 70 to AVR 75 and AVR 12.)

- Move the Soft slider to adjust the level of softness.

  The numbers represent the number of lines of pixels to fade in and out at the top and bottom of the rolling title. An unsoftened title is represented by 0. The maximum number of lines of pixels you can soften a title with is 255.

  Softening applies equally to both the top and bottom of the rolling title.

You cannot apply softening to crawling titles.

Softening is available only for two-field resolutions.

<table>
<thead>
<tr>
<th>Title Type</th>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rolling</td>
<td>Source</td>
<td>Source</td>
<td>Destination</td>
<td>Destination</td>
</tr>
<tr>
<td>Crawling</td>
<td>Destination</td>
<td>Destination</td>
<td>Source</td>
<td>Source</td>
</tr>
</tbody>
</table>
Revising Titles

You can reopen an existing title in the Title Tool and revise it at any time. There are two basic ways of revising a title: revising a title effect in a bin or revising a title that’s been edited into a sequence.

⚠️ If you already edited a title into a sequence, or made adjustments to the effect parameters for that title, you must revise the title in the sequence (not the title clip in the bin), otherwise you must again edit the title clip into the sequence and readjust the parameters.

Revising a Title in a Sequence

If you want to revise a title after you have edited it into a sequence and adjusted parameters with the Effect Editor, you can reopen the title in the Title Tool directly from the sequence.

⚠️ If you already edited a title into a sequence, or made adjustments to the effect parameters for that title, you must revise the title in the sequence (not the Title Effect clip in the bin).

To change a title in a sequence:

1. Click the Effect Mode button.
   The Effect Editor appears.
2. Select the Title effect in the sequence.
3. Click the Other Options button in the Effect Editor.

The Title Tool appears.
4. Edit the title.

5. Save the title using one of the following options:
   
   - **Save Title**: To save the title with the same name (numbered incrementally) and media parameters (AVR, target bin, and target disk):
     
     a. Choose Save Title from the File menu.

     A dialog box appears.
     
     ![Save Title dialog box]

     b. Click Save.

     The Title Tool closes, and the revised Title Effect clip replaces the previous clip in the sequence. The new clip also appears in the bin and the Source monitor, with the name of the previous clip plus a two-digit extension that adds incremental numbering for each revised title. The previous Title Effect clip is preserved in the bin.

   - **Save Title As**: To rename the title or change any of the media parameters (AVR, target bin, and target disk):
     
     a. Choose Save Title As from the File menu.

     The Save Title To Bin dialog box appears.
     
     b. Rename the title or choose other options from the Bin, Target Disk, and Resolution pop-up menus.
You cannot select Fast Save when revising a title in a sequence.

c. Click OK to save the title and exit the Title Tool.

The Title Tool closes, and the revised Title Effect clip replaces the previous clip in the sequence. The new clip name also appears in the bin and the Source monitor. The previous Title Effect clip is preserved in the bin.

Revising a Title in a Bin

If you want to revise a title that has not yet been edited into a sequence, reopen the title in the Title Tool directly from the bin.

To revise a Title effect in a bin:

1. Press the Control key and double-click the Title Effect icon in the bin. The title opens in the Title Tool.

If the Title Tool is already open, you can drag a Title Effect clip from the bin directly into the Title Tool window.

2. Edit the title.

3. Save the edited title using one of the following options.

   • **Save Title**: To save the title with the same name and media parameters (AVR, target bin, and target disk), choose Save Title from the File menu.

     The revised Title Effect clip replaces the previous clip in the bin. The clip also appears in the Source monitor.

     The Title Tool remains open. You can continue making additional titles, or choose Close from the File menu.
• **Save Title As:** To rename the title or change any of the media parameters (AVR, target bin, and target disk):
  
  a. Choose Save Title As from the File menu.
  
  The Save Title To Bin dialog box appears.
  
  b. Rename the title or choose other options from the Bin, Target Disk, and Resolution pop-up menus.

  *If you keep the same name for the title, the system retains the original Title Effect clip in the bin and creates a new clip with the same name plus a two-digit extension that adds incremental numbering for each revision.*

  c. Select or deselect the Fast Save option, depending on your needs. See “Using the Fast Save Option” on page 158.
  
  d. Click OK to save the title and exit the Title Tool.

### Replacing Fill Tracks

All newly created titles and graphics imported with alpha channel are DSK clips by default. When you replace the fill track with a graphic or video, the title is converted automatically to a non-DSK title.

For example, you can replace the fill track of a title with video. This allows you to fill the text with moving video.

*After replacing the fill track, you cannot restore the DSK capabilities of a title. You cannot replace the fill track on a rolling or crawling title.*

To replace the fill track:

1. Click the Step In button to step into the effect.
2. Load the video you would like to use as replacement filler into the Source monitor.
3. Using standard editing methods, edit the video from the Source monitor onto the fill track.

   An alert dialog box display a warning that the DSK capabilities of the title will be disabled.

4. Click OK to replace the fill track, converting the title to a non-DSK title; or click Cancel to cancel the operation and retain the DSK capabilities of the title.

**Other Title Tool Enhancements**

The Title Tool includes additional enhancements to previewing anti-aliased titles, selecting a video background, and viewing titles full frame.

**Previewing Titles**

Titles are always saved in anti-aliased format.

Text and objects in titles are created anti-aliased with an 8-bit alpha channel. Anti-aliasing ensures that text, lines, and object edges appear smooth, regardless of size. You can preview a title to see the title drawn with anti-aliasing, just as it will be saved.

To display anti-aliased titles, choose Preview from the Object menu or press `Alt`-shift-P.

As you continue to edit the title, the anti-aliased preview disappears. Choose Preview (or press `Alt`-shift-P) again each time you want to view the title with anti-aliasing.
Selecting a Background

Use the Video Background button to toggle between a video background or an opaque color background.

Updating the Video Background

You can update the video background at any time while creating titles within the Title Tool.

To update the background video:

1. Click the V button in the Title Tool to activate video background if you have not already done so.
2. Activate the Composer window with the sequence loaded into the Record monitor.
3. Move the position bar in the Timeline or Record monitor to display the new frame.
4. Click again in the Title Tool to activate its window.

The background is updated to reflect the current contents of the Record monitor.
Viewing Titles Full Frame

If you work on an Avid Composer system with a monitor resolution of 640 x 480 pixels, you can use the Full Frame command in the Object menu to get a better view of your title against the video or color background.

If your monitor is set to a higher resolution, such as 1024 x 768, the Full Frame command does not appear in the Object menu.

To view a title full frame in a 640 x 480 display:

- Choose Full Frame from the Object menu to hide the tool bar and view the title full frame.
- Choose Full Frame again to return to normal view.
CHAPTER 7

New Audio Features

This chapter describes the following new audio features:

- Enhancements for Two-Channel Audio Boards
- Audio Effect Manipulation
- Audio EQ Templates
- Adjusting EQ While Playing an Audio Effect
- Audio Gain Automation
- Changes to the Audio Mix Tool
- Adjusting Volume While Playing an Audio Effect
- Digidesign AudioSuite Plug-Ins

The following audio features are also new for Release 7.0 and are described in Chapter 3:

- AIFF Audio Support
- Audio Tool Enhancements
- Eight-Channel Audio Input and Output
Enhancements for Two-Channel Audio Boards

Release 7.0 supports the following changes for two-channel audio boards:

- You can monitor eight channels of audio on a two-channel board.
- You can select 44.1 kHz and 48 kHz audio rate settings

Two-channel audio boards are used in Media Composer 1000 and Avid Xpress for Macintosh systems.

Monitoring Eight Channels on Two-Channel Audio Boards

Starting at Release 7.0, you can monitor eight channels of audio on two-channel audio boards. Previously you could only monitor four channels with a two-channel board.

You select tracks to monitor by clicking the monitor column of either the source- or record-side tracks to activate or deactivate the monitor icons. For more information, see the “Using the Timeline” chapter of the user’s guide.

Source track monitors
Source tracks
Track lock indicators
Record tracks
Record track monitors
Timecode track
44.1 kHz and 48 kHz Audio Rate Settings

Two-channel audio boards now support both 44100 Hz (44.1 kHz) and 48000 Hz (48 kHz) audio rate settings. 48 kHz is the broadcast standard of most high-end video postproduction houses. The sound quality of the two rates is very similar, so you should select the rate based on the requirements of your facility.

On a two-channel board, select the rate by choosing a value from the Sample Rate menu in the Audio Settings dialog box. You access the dialog box from the Settings scroll list in the Project window.

Audio Effect Manipulation

You can now access the following tools from the same window:

- Audio Mix (for adjusting pan and volume)
- Audio EQ
- Audio Gain Automation
- Digidesign AudioSuite Plug-Ins

To access one of the audio effect tools:

1. Choose one of the tools from the Tools menu.
2. To switch to another tool, choose the name from the Tool Name menu.
To keep more than one tool open at the same time, choose the tool from the Tools menu or hold the Option key while choosing a new tool from the Tool Name menu. To prevent confusion, the Avid Composer system allows only one copy of a given audio effect tool to be open at any given time.

**Audio EQ Templates**

The following features are new for Release 7.0:

- A set of predefined audio EQ templates. These templates address a number of common audio problems such as removing tape hiss or boosting the low frequency on a music track. The templates are accessible from a new Fast menu on the Audio EQ Tool.

- The ability to add your own custom EQ templates to the Fast menu list.
The Fast menu on the Audio EQ Tool provides access to a number of predefined EQ templates as shown in the following illustration.

The EQ templates are designed to fix problems that are often encountered with audio clips. For example, Tape Hiss Filter rolls off frequencies above 4 kHz. NTSC Hum Buster cuts the bass on frequencies that often cause hum on NTSC systems.
Applying an EQ Template

To apply an EQ template from the Audio EQ Tool Fast menu:

1. Place the blue position indicator on the audio clip in the Timeline.
2. Choose the template from the Audio EQ Tool Fast menu.

The Avid Composer system places the EQ effect on the audio clip.

The following illustration shows the contents of the EQ window when you select the Female Voice with Presence template in the Timeline. As explained in the window, you cannot change the parameters of a pre-defined EQ template.

To see the parameter values of one of the EQ templates, view the Console window after you apply the effect. To open the Console window, choose Console from the Tools menu.
Creating Your Own Templates

Creating a template is not a new feature for Release 7.0. If you create an EQ effect that you want to use again in another sequence or on another track, simply drag the Effect icon to a bin. The system creates an effect in the bin called EQ Effect. Rename the template by clicking the text and typing a new name.

Starting with Release 7.0, you can add your own EQ templates to the EQ Fast menu. You do this by storing your EQ template in the same bin as the predefined templates.

The Avid Composer system stores the predefined EQ templates in a special bin named Site_EQs_Bin. This bin resides in a new Site_Effects folder in the Supporting Files folder. The following illustration shows the bin’s location.

The IN button in the EQ window allows you to turn off the particular EQ effect. The button is yellow when the effect is on (inline) and gray when the EQ effect is off. The Ignore EQ checkbox turns off all EQ effects for the sequence.
To add an EQ template to Site_EQs_Bin:

1. Choose Open Bin from the File menu.
   A dialog box appears.

2. Open the bin named Site_EQs_Bin as follows:
   a. Open the Media Composer folder.
   b. Open the Supporting Files folder.
   c. Open the Site_Effects folder.
   d. Double-click the Site_EQs_Bin file.

3. Drag one of your own templates to Site_EQs_Bin.

4. If you have not already done so, name the template by clicking the text and typing a name.
5. Close the bin.

The Avid Composer system does not save the effect to the bin until you close the bin.

6. Select the Audio EQ Tool Fast menu and look for your new template.

For more information on using the Audio EQ Tool, see the “Working with Audio” chapter of the user’s guide and see “Audio EQ Tool” in the online help index.

**Adjusting EQ While Playing an Audio Effect**

You can use the Play Loop button to create or change an EQ effect while a clip is playing.

To adjust EQ while playing an effect:

1. Choose an existing EQ effect or identify an area of the clip with IN and OUT marks.

2. Click the Play Loop button. The Avid Composer system repeatedly loops through the audio effect.

3. Adjust the EQ as necessary.

4. Click the Play Loop button to stop. The Avid Composer system automatically saves your changes as part of an EQ effect.
Limitations

If an EQ effect does not exist on the clip before you start, you will not hear any changes until you click the Play Loop button to stop and replay the effect.

As you are adjusting the EQ values on an existing EQ effect, you might not hear the results immediately. It takes a few seconds for the changes to be applied to the clip. To improve the response time, you can:

- Monitor as few audio tracks as possible.
- Deselect the video track if practical.
- Use IN and OUT marks to choose a narrow interval to adjust.

Audio Gain Automation

The following features are new for Release 7.0:

- Audio Gain Automation Recording instructs the Avid Composer system to record real-time changes in the volume levels and save the changes as part of a pan volume effect.

- Control volume changes from sliders on the new Automation Gain window or from an optional external fader box.

AudioGainAutomation allows you to change the volume of a segment by adding and manipulating audio key frames in the Timeline. The following illustration shows an expanded audio track containing gain information.
To display the gain values in the Timeline, choose Volume from the Audio Data submenu of the Timeline Fast menu and expand the tracks, using $\text{F}_1 \text{–} \text{L}$, until the values appear.

The Avid Composer system uses a linear ramp to change the volume from one key frame to the next. The previous illustration shows four ramps.

This section assumes that you are familiar with the Automation Gain feature. For details, see the user’s guide. Note that the previous documentation refers to the audio key frames as break points.

**Connecting a Fader to Your Avid Composer System**

You can record audio gain information using the Automation Gain window directly. You can also use an optional external fader box.

Release 7.0 supports the JL Cooper FaderMaster Professional fader. You connect the fader to your printer port or modem port by using a standard Macintosh serial cable. The FaderMaster sends and receives...
MIDI data, so you need to attach a MIDI translator to convert the MIDI signals to a format that can travel over a serial line.

To initialize the fader:

1. Attach the cables as described in the *Avid Media Composer Products Connecting Audio and Video Equipment* manual.
2. Turn on the fader.
3. In the Composer application, choose Serial Ports from the Tools menu. The Serial Ports Tool appears.
4. Choose Printer Port from the Audio Faders menu and close the tool.
   
   If your printer port is already in use, attach the cable to the modem port and choose Modem port.

To test the fader:

2. Option-click the hardware toggle (HW) button in the Automation Gain window. The box turns blue.
3. Check the color of the position indicator lights. If the external fader is not connected, the lights are off (gray). If the fader is connected, at least one of the lights is on (blue).
4. Move the sliders on the fader. The corresponding slider should move in the Automation Gain window.

*The external fader position lights are off (gray) if the box is not connected.*

*The fader is optional. It is not required to perform Audio Gain Automation Recording.*
Ganging Sliders on the FaderMaster Fader

You can use software features available on the FaderMaster Professional to gang sliders. When the sliders for two tracks are ganged, the fader sends identical volume messages for both tracks when you move one slider. This can be useful when you have stereo tracks.

Note that the ganged sliders do not move together physically. For information on ganging the sliders, see the FaderMaster user’s manual. For example, if you have two stereo tracks and want to gang faders 1 and 2 to respond to movement on fader 1:

1. On the FaderMaster, press the PROG button to light the Fader LED.
2. Hold down the Group button and move fader 2 until "1" is displayed.
3. Press the PROG button to turn off the Fader LED.

Now when you move slider 1, the Avid Composer system will receive identical volume information for slider 2.

To turn off the group feature, repeat steps 1 through 3 but assign fader 1 to 0.

Adding Audio Gain Information

In previous releases you could only add key frames manually and then adjust them to achieve the appropriate volume ramps. Starting at Release 7.0, you can instruct the Avid Composer system to record your actions as you move sliders to adjust the volume. The system creates the corresponding key frames and saves them as part of a pan volume audio effect. After you finish the recording, you can move, add, and delete key frames to achieve the results you desire.

The following illustration shows the Automation Gain window.
Some portions of the Automation Gain window are identical to the Audio Mix and Audio Punch In Tools. For example, the following record features are identical to the Audio Punch In Tool:

- The Record button starts and stops the recording.
- The Cancel button stops a recording without saving the recorded data.
- The Recording status light is black when there is no activity, green during a preroll, red during recording, and blue during a postroll.
- The PreRoll text box allows you to provide a visual cue before the recording begins. The Avid Composer system backs up the blue
position indicator for the prescribed number of seconds. During the preroll, the Recording status light is green.

- The PostRoll text box gives the same kind of visual cue at the end of the recording. During the postroll, the Recording status light is blue.

The remainder of the features described in this section are specific to the Automation Gain window.

The Hardware Toggle button switches control between the external fader sliders and the sliders on the Automation Gain window.

**Table 7-1**

<table>
<thead>
<tr>
<th>Button Color</th>
<th>To Enter the Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray (default)</td>
<td>Click the button.</td>
<td>The sliders in the Automation Gain window control volume. The system ignores the external fader.</td>
</tr>
<tr>
<td>Purple</td>
<td>Click the button.</td>
<td>The fader sliders control volume. The sliders in the Automation Gain window do not allow user input.</td>
</tr>
<tr>
<td>Blue</td>
<td>Option-click the button.</td>
<td>The Automation Gain window slider positions reflect the hardware. This is for display purposes only. You cannot control volume in this mode.</td>
</tr>
</tbody>
</table>

When the HW button is blue, the external fader controls the volume sliders in the tool window. When you move the external fader sliders, the software sliders move also. This has the following benefits:

- It allows you to view the decibel values as you move the slider for each track. (The FaderMaster does not have numbers along its sliders.)
• It is a good test of whether the fader is working correctly.

The Track Solo button (speaker icon) lets you mute and solo individual audio tracks during audio gain automation recording.

**Table 7-2**

<table>
<thead>
<tr>
<th>Button Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>The audio track is muted.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The track is soloed. You can solo more than one track at a time.</td>
</tr>
<tr>
<td>Green (default)</td>
<td>The audio track is on.</td>
</tr>
</tbody>
</table>

Click or press the number keys 1 to 8 to toggle between solo and on. The number keys (at the top of the keyboard) let you quickly select a track.

To toggle between on and mute, use Option-click or Option-number key.

When you turn off solo, the button returns to its previous state (mute or on). To change the previous state of a button, Option-click the button.

*While the Automation Gain window is active, the Avid Composer system overrides any other mappings of the number keys 1 to 8 at the top of the keyboard. Number keys on the right side of the keyboard are not affected.*

The position indicator lights provide information about the current location of the sliders on the external fader.
The position indicator lights are useful because it is important to position the fader sliders close to the track volume before you start recording. Otherwise you might create an unwanted jump in the volume when you move the sliders during a recording.

Note that the Avid Composer system does not record values from a fader slider until you move the slider. Then it reads the current position of the slider and adjusts the volume accordingly.

Also note that in many cases it is not possible to exactly match the Timeline value.

### Automation Gain Fast Menu

The following figure shows the Automation Gain Fast menu when an In/Out area is marked. This menu is grayed out unless the gang lights are enabled on the appropriate tracks.

<table>
<thead>
<tr>
<th>Colors</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both lights blue</td>
<td>The fader slider matches the current Timeline volume.</td>
</tr>
<tr>
<td>Only top light blue</td>
<td>The slider is higher than the Timeline volume.</td>
</tr>
<tr>
<td>Only bottom light blue</td>
<td>The slider is lower than the Timeline volume.</td>
</tr>
</tbody>
</table>
| Both lights gray        | Either there is no fader attached to the system or the Avid Composer system does not recognize the fader. If the system does not recognize the fader, check the connection and restart the system as described in “Connecting a Fader to Your Avid Composer System” on page 193.
When no area is marked, the words In/Out are replaced by the words Global. This allows you to perform the operation on the entire clip rather than just the marked region. The Automation Gain Fast menu is grayed out unless the gang lights are enabled on the appropriate tracks.

The Automation Gain Fast menu is similar to the Audio Mix Fast menu with the addition of the following items:

- **Filter Automation Gain In/Out** removes approximately 10 percent of the key frames in the marked region. The Avid Composer system tries to save major gestures while removing redundant points and points on a linear ramp. This is useful for deleting extra key frames after a recording. See the examples later in this section for more information.

  When there are no In/Out marks on the track, the menu item is Filter Automation Gain Global. This option allows you to remove key frames from the entire track.

- **Remove Automation Gain In/Out** removes all of the audio key frames within the marked region.

  When there are no In/Out marks on the track, the menu item is Filter Automation Gain Global. This option allows you to remove all of the audio key frames on the track.

To make the Automation Gain Fast menu active for a given track, click the Gang button for that track.
Using the Automation Gain Window Sliders

To record audio gain information by using the Automation Gain window sliders:

1. Select an audio track for adjusting volume.
2. Choose Volume from the Audio Data submenu of the Timeline Fast menu.
3. (Option) Expand the audio track by pressing ⌘-L, or by pressing the Option key and dragging the top or bottom of the Track Selector panel.
4. Move the blue position indicator to the section of audio that you want to adjust and mark IN and OUT points.
5. Click the Record button to start recording your actions.
6. Listen to the audio and adjust the volume sliders on the Automation Gain window as necessary.
   The Avid Composer system adds volume key frames to the audio in the Timeline. Because it records every movement of the sliders, there are usually more key frames than you need.
7. To decrease the number of key frames:
   a. Click the Gang button for the track to enable to Fast menu.
   b. Choose Filter Automation Gain Control In/Out from the Automation Gain Fast menu.
   The system removes approximately 10 percent of the key frames while maintaining the overall shape of the curves.
8. Repeat step 7 until you have decreased the number of key frames to an acceptable level.

You should remove as many excess key frames as possible while still maintaining the desired volume changes.

You can move, add, and delete key frames individually or as groups to further adjust the volume. See the “Working with Audio” chapter of the user’s guide or see “Audio gain automation” in the online help index for details on how to adjust the key frames.

**Keyboard Shortcut**

Click the Gang button on a track to turn it green. Then you can use the Fast Forward and Rewind buttons to jump to the next or previous audio key frame. You can map these keys to your keyboard to speed your editing of audio key frames.

**Using the Fader to Record Audio Gain Information**

To record audio gain information by using the fader box:

1. Attach the fader box to your system (see “Connecting a Fader to Your Avid Composer System” on page 193).

2. Move the blue position indicator to the section of audio that you want to adjust and mark IN and OUT points.

3. Note the color of the position indicator lights for the track you want to adjust. Move the fader box slider until both lights are blue. If you can’t adjust it to the exact position where both are blue, get it as close as you can.

4. Set PreRoll and PostRoll values if necessary.

5. Click the Record button to start recording your actions.

6. Listen to the audio and adjust the volume sliders on the fader box as necessary.

7. Play the clip to test your results.
8. To decrease the number of key frames, choose Filter Automation Gain Control In/Out from the Automation Gain Fast menu.

9. Repeat step 8 until you have decreased the number of key frames to an acceptable level.
   
   You should remove as many excess key frames as possible while still maintaining the desired volume changes.

**Using Audio Gain Automation and the Audio Mix Window**

This section describes the interactions between the Audio Mix window and the Automation Gain window.

When you add the first audio key frame to a track, the Avid Composer system adds the point at the level currently set for that track in the Audio Mix Tool.

Values set by the volume sliders in the Audio Mix window are referred to as system clip gain values. Audio gain key frames are not additive to the system clip gain values. When you move a key frame point up or down, it cancels the system clip gain for that point in the sequence.

You can add key frames to some tracks and use the Audio Mix window to control the volume on other tracks. The Avid Composer system provides visual clues to let you keep track of which type of audio effect is on a given track.

The following illustrations show the Audio Mix window and the Automation Gain window with Audio data on two tracks. In this example, audio gain automation information is on track A1 and a system clip gain setting is on track A2.
When you have audio gain automation on a track, the slider for the track does not appear in the Audio Mix window. The system displays the word Auto in the track volume text box to indicate that audio gain automation is associated with the track.

Likewise, when you use the Audio Mix window to change volume for a track, the slider for the track disappears from the Automation Gain window. The word Clip appears in the track volume text box.

To add audio gain automation to a track that contains system clip gain information, you simply need to add an audio key frame. To use the
Audio Mix sliders on a track containing audio gain automation, you must first remove all of the audio key frames from the track. Use the Remove Automation Gain Global command from the Automation Gain Fast menu. You need to remove any IN and OUT points on the track before the menu item changes from In/Out to Global.

**Changes to the Audio Mix Tool**

The following features are new for Release 7.0:

- The Audio Effects Tool Selection menu allows you to change to other audio effects tools (see “Audio Effect Manipulation” on page 185).
- The Audio Mix Tool has several new buttons, as shown in the following illustration:
For more information on the Audio Mix Tool, see the “Working with Audio” chapter of the user’s guide and see “Audio Mix Tool” in the online help index.

**Adjusting Volume While Playing an Audio Effect**

You can use the Play Loop button to create or change the volume on an Audio Mix effect while you play the clip.

To adjust Volume while playing an effect:

1. Choose an existing Audio Mix effect or identify an area of the clip with IN and OUT marks.
2. Click the Play Loop button. The Avid Composer system repeatedly loops through the audio effect.
3. Adjust the volume as necessary.
4. Click the Play Loop button to stop. The Avid Composer system automatically saves your changes as part of an Audio Mix effect.

**Limitations**

If an existing Audio Mix effect is not present on the clip before you start, you will not hear any changes until you click the Play Loop button to stop and replay the effect.

As you adjust the volume values on an existing Audio Mix effect, you might not hear the results immediately. It takes a few moments for the Avid Composer system to apply the changes to the clip. The response
time for this feature is considerably longer than for adding EQ effects while using Play Loop. You might need to click Play Loop to complete the edit and then play the effect in order to hear the result.

To improve the response time, you can do the following:

- Monitor as few audio tracks as possible.
- Deselect the video track if practical.
- Use IN and OUT marks to choose a narrow interval to adjust.

Refer to “Adding Audio Gain Information” on page 195 for additional ways to change the volume while playing an audio effect.

**Digidesign AudioSuite Plug-Ins**

Release 7.0 supports AudioSuite, Digidesign’s new host-based, file-based Plug-In specification. You now have access to audio processing plug-ins developed by Digidesign and by Digidesign’s third-party developers including Waves, Arboretum, DUY, S.A., Steinberg, and others. For example, plug-ins are available to perform pitch processing, artifact removal, reversing of audio, and many other processes.

Information on Digidesign and third-party plug-ins is available in the AudioSuite Plug-In catalog from Digidesign. Contact Digidesign at 800-333-2137.

For a list of plug-ins that are not supported by the Avid Composer system, see “Limitations of AudioSuite Plug-Ins” on page 214.
Installing AudioSuite Plug-Ins

The Avid Composer system installation software automatically creates a folder in your System Folder named DAE Folder (DAE stands for Digidesign Audio Engine). The DAE application manages the AudioSuite Plug-Ins.

The DAE Folder contains the following files and folders:

- The DAE application program.
- A Plug-In Settings folder. The plug-in vendor might install settings in this folder.
- A Plug-Ins folder containing the following:
  - A set of basic plug-ins from Digidesign.
  - A file named Avid Application PlugIn. The Avid Composer system requires this file; do not delete it.

The following basic plug-ins are installed automatically. For a complete description of each, see “A Description of the AudioSuite Plug-Ins” on page 217.

- Invert: Inverts the polarity (phase of the audio file).
- Duplicate: This plug-in does not work on Avid Composer system audio files.
- Normalize: Finds the peak value in the source audio file and scales the entire file proportionally to that maximum value.
• Gain: Same as normalize, but allows positive or negative gain adjustment.

• Reverse: “Flips the tape over,” making audio signals run backward.

• DC Offset Removal: Removes an audio artifact that is common in digital audio files. A DC offset is caused by poorly calibrated analog to digital (A/D) converters, and can produce clicks and pops on clip edit transitions if the artifact is not removed.

• Pitch Shift supports time compression/expansion (changing the length of a clip without changing its pitch) and pitch shifting (changing the pitch of a clip without changing its length).

Do not use the pitch shift plug-in to change the length of an audio clip. See “Limitations of AudioSuite Plug-Ins” on page 214.

When you purchase additional plug-ins, the third-party vendor will provide instructions on how to load the plug-ins. Some might require you to drag the plug-in to the Plug-Ins folder. Others might perform the task automatically for you through an installation program.

Starting and Quitting the DAE Application

When you open the Digidesign AudioSuite window (see “Using the AudioSuite Plug-Ins” on page 210), the Avid Composer system automatically launches the DAE application. The application continues running even after you close the window. To quit the DAE application while the window is open, ⌘-click the status display in the AudioSuite window.
The DAE application uses between 9 and 16 MB of memory, depending on how many plug-ins are loaded. If you plan to use other applications while the Avid Composer system is running, you might find it useful to quit the DAE application to free up memory for the other application.

Setting Playback Buffer Size

While the DAE application is running, you can choose Set Playback Buffer Size from the DAE application’s File menu. However, this command has no effect on the Avid Composer system performance. For an example of how to use this command, see “Memory Allocation Problems” on page 214.

Using the AudioSuite Plug-Ins

The following illustration shows the AudioSuite window.
To apply an AudioSuite plug-in:

1. Open the AudioSuite window and do one of the following:
   - Choose AudioSuite from the Tools menu.
   - If an audio tool is already open, choose AudioSuite from the Tool Selection menu.

2. Select the track to modify in the AudioSuite window. You can work on only one track at a time.

3. Choose a plug-in from the Plug-In Selection menu.
   The Avid Composer system automatically applies the plug-in effect to the track in the Timeline.

4. Click the Plug-In button to open the dialog box associated with the current plug-in.

5. Make any necessary adjustments and click the Play Loop button to preview the effect. See “Using a Plug-In Dialog Box” for more information.

6. To save the effect, click OK. To close the dialog box without saving the effect, click Cancel.
Using a Plug-In Dialog Box

The contents of the plug-in dialog boxes vary, but the top six buttons will always be visible. If a particular button is not available, it is dimmed. The following illustration shows the Digidesign Gain plug-in as an example.

- **OK** saves the effect and closes the dialog box.
- **Cancel** closes the dialog box and does not save the effect.
- **Render** renders the effect and creates a new audio media file.
- **Preview** plays back a portion or all of the currently selected audio clip with processing.
  
  Some plug-ins can preview in real time and some cannot. If the plug-in cannot preview in real time, the Avid Composer system plays back the processed audio in 2-second intervals. The Avid Composer system processes 2 seconds of audio, plays it, processes the next 2 seconds, plays it, and so on.
- **Bypass** plays the selected audio without processing. This is useful for comparing the audio with and without processing applied.
- **Optional** performs an analysis pass on the audio data.

Some plug-ins require an analysis pass on the audio data before they can process the information. If so, they perform the first pass automatically. Other plug-ins do not require a first pass but can achieve more accurate results if you allow them to perform a first pass. If the plug-in
supports the optional pass, this button will be available. Otherwise it will be dimmed.

Rendering Plug-In Effects

Some plug-ins can process a file in real time and some cannot, due to the complexity of the effect. Even if a plug-in can run in real time, it must be rendered before it can be added to the following:

- An audio mixdown
- An EQ effect

If you do not render the effect manually, the Avid Composer system automatically renders the effect before it creates an audio mixdown or audio dissolve containing the effect.

See “Troubleshooting AudioSuite Plug-Ins” on page 214 for more information.
Limitations of AudioSuite Plug-Ins

The list of compatible plug-ins has a few important exceptions. The following plug-ins do not work with the Avid Composer system:

- Third-party plug-ins that process audio in stereo pairs, such as stereo sound field expanders. These plug-ins receive input only on the first channel.
- Plug-ins that perform analysis passes, using playlist information to cache analysis data.
- Plug-in options that perform time compression/expansion. For example, some Pitch Shift plug-ins have an option for changing the length of the audio file. You can use the plug-in as long as you don’t choose that option.

Also note that you can work on only one track at a time. This means that you should use the mono AudioSuite Plug-Ins where applicable.

Troubleshooting AudioSuite Plug-Ins

This section describes problems you might encounter using the AudioSuite Plug-Ins.

Memory Allocation Problems

The DAE application requires between 9 and 16 MB of RAM, depending on how many plug-ins are loaded. When the application launches, it attempts to allocate enough memory for all the plug-ins in the Plug-Ins folder in the DAE Folder. If you have many plug-ins (for example, more than 10), the application might not be able to allocate enough memory for all of them.

If you get memory allocation errors or if the screen does not redraw correctly when you use the AudioSuite Plug-Ins for the first time, you should do the following:
1. Quit the Avid Composer application.

2. Locate the DAE Folder in your System Folder, and click the DAE application icon within the DAE Folder.

3. Press ⌘-I to display the Get Info dialog box.

4. Change the Preferred Size value to a large number, such as 30000 (30 MB), to change the memory allocation.

5. Close the Get Info dialog box.

6. Double-click the DAE icon to launch the DAE application.
   
   The DAE application automatically checks the available plug-ins and allocates enough memory to run all of the plug-ins.

7. Choose Set Playback Buffer Size and set the buffer size to 0.

   The Set Playback Buffer Size setting has no effect on Avid Composer performance.

8. Quit the DAE application.

9. Display the Get Info dialog box again, and change the Preferred memory size back to the Suggested Size.

10. Restart the Avid Composer system.

If you still receive memory errors when you use the AudioSuite Plug-Ins, you might have too many plug-ins in the Plug-Ins folder in the DAE Folder. Move some plug-ins out of the folder and try running the AudioSuite Plug-Ins again. For example, you could create a Plug-Ins Disabled folder for storing plug-ins that are not in use.
Starting and Stopping the DAE Application

By default, the DAE application is always running while the AudioSuite window is open. You can stop the DAE application to free up memory for other applications.

To stop the DAE application while the AudioSuite window is open, press the status display in the AudioSuite window.

Option-click the status display to restart the DAE application.

Canceling a Render Operation

You can press the status display to cancel a render operation. However, be careful not to press the status display multiple times. If you press the command after the render operation has been stopped (from a previous status display), the Avid Composer system closes the window after it cancels the render operation.

Error Messages When Rendering a Plug-in Effect

If the DAE application is not running when you start to render a plug-in effect, the system displays an error message stating that the DAE connection does not exist. The dialog box gives you choices:

- **Cancel** stops the rendering process. This allows you to launch the DAE application and then start rendering again.
- **Bypass** continues rendering but doesn’t render the plug-in effect.

In most cases, you should select Cancel and restart the DAE application. Either open the AudioSuite Plug-In window or, if the window is already open, Option-click the status display in the AudioSuite window.

If the plug-in is not installed when you go to render a plug-in effect, the system displays an error message and tells you which plug-in is not installed. At that time, you can cancel or bypass as previously described.
Using Digidesign Pro Tools

If you plan to use Digidesign Pro Tools on the same system with the Digidesign AudioSuite Plug-Ins, you must install Pro Tools Version 4.1.1 or greater. This version has the matching version of the DAE application.

A Description of the AudioSuite Plug-Ins

The following sections give a brief overview of each plug-in, and where appropriate, describe how to use the plug-in.

Invert

The Invert Plug-In reverses the polarity of the selected audio. All positive sample amplitude values are made negative, and all negative amplitudes are made positive. This process is useful for permanently altering the phase (polarity) relationship of tracks. Inverting can be useful when mixing because it alters frequency response between source tracks recorded with multiple microphones, and also allows you to correct for audio that was recorded out of phase.

Normalize

In cases where a sound file has been recorded with too little amplitude, or where volume is inconsistent throughout the duration of a sound file (as in a poorly recorded narration), the Normalize function will ensure that the inherent dynamics of the performance remain unchanged while the overall volume level of the passage is raised.

In addition to the standard AudioSuite parameters (described earlier in this chapter), the Max Peak At controls lets you specify how close to maximum level (the clipping threshold) the peak level of your selection/file will be boosted. You can enter this in three ways:
By entering a numeric decibel value below the clipping threshold
By entering a percentage of the threshold
By adjusting the on-screen slider

Editing any of these controls automatically calculates the equivalent value in the others.

To configure the Normalize parameters:
1. Enter the amount of boost you want applied during the Normalize process.
2. To set a specific decibel amount below maximum, double-click and enter that value in the Max Peak at: (dB) field.
3. To set the amount of normalization as a percentage of maximum, enter the desired percentage in the Max Peak at: (%) field. To manually set the amount, click and adjust the Max Peak slider (hold down the Command key to fine-adjust).

**Gain**

Gain allows you to boost or lower amplitudes in a file or selection by a specified amount. The Change Gain command is ideal for smoothing out undesirable peaks and other dynamic inconsistencies.

To configure the Gain parameters:
- Enter the new level as a decibel amount (dB) or percentage (%) by double-clicking on the respective field and entering a new value.
- Or, use the slider to adjust the Gain manually (hold down the Command key while dragging the slider to fine-adjust).

**Reverse**

Reversed sounds are useful effects in many music and film/video projects. The Reverse Plug-In lets you perform this type of processing very easily.
DC Offset

The DC Offset Plug-In removes DC offset from your audio files. The term “DC Offset” describes a very specific type of audio artifact which infrequently appears in digital audio signals.

DC Offset can be identified in a waveform overview because they appear to have a near-vertical fade in with a constant or “steady-state” offset from zero, when the file is actually “silent” (it contains no audible audio). The DC Offset Plug-In can help remove (or at least reduce) the DC Offset from your source audio files.

Pitch Shift

The AudioSuite Pitch Shift Plug-In allows you to adjust the pitch of any source audio file with or without a change in its duration. This is a very powerful function which essentially allows sounds to be transposed a full octave up or down in pitch with or without altering playback speed.
Edit the Pitch Shift parameters by double-clicking and typing into any Destination field (tempo, bar:beats:ticks, or time sig), or by clicking and dragging the coarse, fine or ratio sliders. All Pitch Shift Plug-In controls are linked so that changing one changes the others. Clicking the time correction check box gives you the option of enabling or disabling time correction. If time correction is disabled (the box is unchecked), playback speed will increase proportionally as the sound file is transposed up in pitch and decrease proportionally as it is transposed down in pitch just like a tape recorder that is varispeeding.
Gain

The gain controls set the input level, in 10ths of a dB. This should be set so that the Plug-In can adequately handle amplitude peaks in the selection. Dragging the slider to the right increases gain, dragging to the left decreases gain.

Coarse and fine

Adjust the pitch by dragging either of the two faders, or by typing values in the boxes below them. The Coarse slider transposes in semitones (half steps); the Fine slider transposes in cents (hundredths of a semitone).

Time Correction

This box must be checked for Avid Composer systems.

You cannot use plug-in options that perform time compression/expansion because the output would have a different sample duration than the original file.

Ratio

The Ratio slider lets you set the amount of transposition (pitch change). Moving the slider to the right raises the pitch of the processed file, while moving the slider to the left decreases its pitch. Hold down the Command key while moving the clicking and dragging the slider to fine-adjust.

Crossfade

This slider allows you to manually adjust the crossfade length in milliseconds to optimize performance of the Pitch Shift Plug-In according to the type of audio material you are processing. The Pitch Shift Plug-In achieves pitch transposition by processing very small portions of the selected audio material and very quickly crossfading between these alterations in the waveform of the audio material.
Crossfade length essentially affects the amount of “smoothing” performed on audio material to prevent audio artifacts such as clicks when the audio is looped to generate the desired pitch shift. In general, small narrow-range pitch changes require longer crossfades while larger transpositions require smaller crossfades. The disadvantage to long crossfade times is that they smooth the signal, including any transients. While this can be desirable for audio material such as vocals, it is not appropriate for material with sharp transients such as drums or percussion.

The default setting for this parameter is Auto (full left), in which crossfade times are set automatically, according to the settings of the coarse and fine controls. This setting should be sufficient for most applications. However, by using this slider, you can manually adjust and optimize crossfade times if necessary. For audio material with sharper attack transients, use smaller crossfade times. For audio material with softer attack transients, use longer crossfade times.

**Min Pitch**

The Min Pitch slider lets you select the minimum, or lowest, pitch that will be used in the Plug-In’s calculations during the Time Compression/Expansion process. The slider has a range of 40 Hz to 400 Hz. By being able to control the minimum pitch, you can focus the Time Compression/Expansion process for maximum efficiency — it all depends on the audio’s spectral shape. This slider should be set lower when processing bass guitar or other instruments with a similarly low range.

Set the min pitch higher when processing other instruments such as snare drums, violins, and other higher range instruments/sounds. After reading the following sections, begin experimenting with combinations of the other fine-tune controls in relation to the min pitch slider.
**Accuracy**

Use the accuracy slider to prioritize the processing resources allocated to audio quality (sound) or timing (rhythm). Moving the slider towards sound generally results in better sonic quality and fewer audio artifacts. Moving the slider towards rhythm puts the emphasis on keeping the tempo consistent. When working with loops, listen carefully until you find the setting which keeps timing solid within the region. Start and end times will be precise, but the perception of beats may be “shuffled” if the accuracy slider’s rhythm setting is too low.

**Reference Pitch**

Generates a sine wave tone that you can adjust to match a selected portion of audio material, then use as an audible reference when pitch-shifting other audio material in your session.

To use the Reference Pitch feature:

1. Select the audio material you wish to use as a pitch reference. Click the preview button to begin playback of the selected audio.
2. Click the Reference Pitch button to activate the reference sine wave tone.
3. Adjust the note and detune settings to match the reference tone to the pitch of the audio playback. Adjust the level setting to change the relative volume of the reference tone. It may also be helpful to toggle the reference pitch on and off to compare pitch.
4. Select the audio material to be pitch shifted.
5. Adjust the coarse and fine Pitch Shift controls to match the pitch of the audio playback to the reference pitch.
CHAPTER 8

Film Features

This chapter describes new and changed features for film projects.

- Using the AutoSequence Command
- Film Effects Grid
- Dupe Handle Length Support
- Three-Perforation Film Format Support
Using the AutoSequence Command

AutoSequence is used with film projects in which picture and sound are captured separately. AutoSequence allows you to add audio to the original videotape.

You can use the AutoSync command to create synchronized subclips of the video and audio. You can then use AutoSequence to build a sequence with timecode that matches your original videotape.

For information and procedures about the Autosync command, see the user’s guide.

To establish syncing with the original videotape, filler is added where gaps in audio exist in the sequence. After you finish editing the audio, use the Digital Cut command to output only the audio onto the original videotape. The videotape now has synchronized audio and video for viewing.

If you do not use AutoSync and the video clip timecode does not match the audio clip timecode, you should only select video clips when you use AutoSequence. You can then add audio to the sequence and sync the audio with the video by using Splice-in and Overwrite.

Use the following guidelines when creating a synchronized sequence:

- Your original videotape must have continuous timecode.
- Only use master clips, subclips, AutoSync subclips, and/or group clips to create the synchronized sequence.
- If you select two unrelated clips with overlapping timecodes, an alert box indicates you cannot do this operation. If the clips are related (for example, one clip is a subclip of the other master clip), then one of the clips is chosen automatically.
- Any mark points in the clips are removed and ignored. An alert box provides you with a choice to either continue and remove the mark points, or to cancel the operation.
Synchronized sequences are named from the tapename column.

To add audio to your original videotape:

1. Create synchronized subclips from the videotape’s master clips and your audio clips by using the AutoSync command.
2. Open the bins that contain the AutoSync subclips.
3. Select the subclips that you want to include in the sequence.
4. Choose AutoSequence from the Bin menu.
   A synchronized sequence is created that contains the clips you selected.
   The new sequence appears in the Record monitor and in the Timeline. The sequence is also placed in the bin with the same name as the videotape.
5. Edit the audio tracks.
6. Record a digital cut of the audio directly onto the original videotape when you finish editing the sequence.

Make sure the video tracks are not selected when you begin recording a digital cut.

You can build a sequence without filler by holding down the Option key while you select AutoSequence from the Bin menu.
Film Effects Grid

Release 7.0 supports an effects grid coordinate system that allows editors to place elements, using greater accuracy, and to previsualize effects. Figure 8-1 shows a 12-field grid displayed in a film project.

Figure 8-1  Effects Grid in a Film Project

Following are some uses for the effects grid:

- A snap-to-grid feature makes lining up effects easy.
- You can display coordinate information on any location in the Record monitor.
- When a grid effect is applied to a clip, you can determine specific positions in a frame and display the position coordinates in a cut list. This has the following benefits:
  - View the results of a specific blowup, resize, or reposition.
  - Interpret the path of an object over a series of frames using key frames. For example, you can track the movement of a matte moving through a scene and provide the coordinates to an optical house.

The cut list information is based on the current grid settings used for the project. Grids can be customized from 8 to 32 fields (including industry-standard 10-, 12-, and 16-field grids for both wide- and nonwide-screen aspect ratios), with image resolution information in the thousands of pixels.

**Dupe Handle Length Support**

Enhancements to the Dupe Detection feature in Release 7.0 allow you to change handle length information for display of dupes in the Timeline.

**About Dupe Handle Lengths and Film Editing**

In 35mm film editing (using the single-strand method), one extra frame, known as the safety frame, provides tabs for the negative cutter to use when cutting two segments of film together. However, this frame is always lost during the negative conform.
In 16mm film editing (using the multiple-strand method), labs sometimes use the zero-frame cutting method in order to avoid seeing each splice in a 35mm blowup print. In this method, the negative is conformed along with the handles so that the cuts appear as soft frame handles rather than a jump in the resulting 35mm blowup. Different labs have different standards depending upon the equipment used; usually a minimum of four frame handles is needed.

Adding specific handle lengths to dupes (as they appear both in the sequence and in film lists) has the following advantages:
• **In 35mm single-strand conforming:** Editors can better track duplicate frames and provide the negative cutter with more than one safety frame to avoid losing specific frames.

• **In 16mm multiple-strand conforming:** For labs using the zero-frame cutting method, editors can track the number of handles during editing according to the specific standards of a particular lab.

**Adjusting the Handle Lengths**

To adjust handle lengths in Dupe Detection:

1. Double-click Timeline in the Settings scroll list of the Project window.

   The Timeline Settings dialog box appears.

2. Choose the number of handle frames from the Dupe Detection Handles pop-up menu. The default is zero. The normal 35mm safety frame setting is 0.5 frames (amounting to 1 frame total with both sides of a cut).
When you enable Dupe Detection during editing, the handles are added onto the colored dupe indicators that appear in the Timeline.

**Matching Dupe Detection Handles in a Dupe List**

When setting up dupe list options in the Cut List Tool, enter the same number you chose for Dupe Detection in the Timeline into the Tolerance field of the Cut List Tool options.

*For more information on dupe list options, see “Film:List, options for” in the online help index.*
Three-Perforation Film Format Support

Release 7.0 of Film Composer and Media Composer with film options supports cut lists and change lists for the three-perforation (3-perf) film format often used in television productions that shoot on film stock.

Three-perforation film projects do not support mixed film stock because all list information is converted to 3-perf numbering regardless of the source.

To create a 3-perf film project:

1. Click New Project in the Project Selection dialog box.

   The New Project dialog box appears.

2. Type a name for the project if desired.

3. Choose NTSC or PAL based on the source film-to-tape transfer.

4. Click Film Options or Matchback Options as appropriate.
5. Choose 35mm, 3 perf from the Format pop-up menu.

6. Click OK to create the project.

During editing, 35mm, 3-perf numbering appears in the bins and in film lists you generate for sequences. You can send the list out for frame-accurate conforming of the 3-perf prints or negative.
CHAPTER 9

Importing and Exporting

Changes and new features for importing, exporting, and exchanging material in Release 7.0 of the Media Composer products are described in the following sections:

- Importing Files
- Exporting Files
- Exchanging Files with Other Systems
- Import and Export Specifications

Importing Files

When you import source shot logs, graphics, animation, audio, QuickTime®, or Open Media Framework® Interchange (OMFI) files, the system converts them into objects in a bin. You can manipulate and edit these objects as you would any other clip or sequence. Any corresponding media files are stored on a target drive that you specify.

The following sections describe the new file types, procedures, and specifications for importing files successfully into Media Composer products. For a complete list of file types, see the Avid Media Composer Products Reference.
Before You Begin

Before you begin the import process, make sure the system and the files are ready for import as follows:

- For issues and tips regarding mixed-resolution projects, see “Importing in Mixed-Resolution Projects” on page 235.
- Before importing complex graphics and animation, check Render settings to determine the correct softening parameters that can affect import of large files. For more information, see “Render Settings, changing” in the online help index.
- For graphics file import, prepare the files in advance according to specifications described in “Import and Export Specifications” on page 301.
- For QuickTime import, prepare the files in advance according to specifications described in “QuickTime Specifications” on page 313.
- For OMF file import, prepare the files in advance according to specifications described in “OMF File Specifications” on page 314.
- For a complete description of all options in the Import Settings dialog box, see “Import Settings” on page 243.

Importing in Mixed-Resolution Projects

Beginning with Release 6.0 and later of the Media Composer products, you can work with mixed resolutions in the same sequence. This feature allows you to import your graphics at the highest resolution you will be using.

For example, assume that you want to use a low resolution such as AVR 12 for your initial work and then redigitize your media at AVR 77 for the final version. In this case, you should import the graphics at AVR 77. Then when you redigitize your material, you will not have to reimport the graphics.
If you plan to redigitize your media at a higher AVR, the lower AVR must be from the same family (single-field or two-field). For example, if you plan to finish at AVR 77, you could start the project at AVR 12, but not 6s.

If you are batch-importing OMF files at multiple resolutions and you have the OMFI Resolution: Ask Me option selected in the Import Settings dialog box, a warning appears. The warning states that the AVR of the source file does not match the current AVR setting in the Select Files to Import dialog box. To continue, choose either the AVR of the source file or the current AVR setting.

**Using Global Import Settings**

You can establish a set of global import parameters in the Import Settings dialog box, prior to beginning the import process. These parameters remain the default settings for all imported files, unless you change them during import. This is especially useful when you batch import a number of files in one procedure.

To adjust options in the Import Settings dialog box, double-click Import in the Settings scroll list of the Project window.
Performing the Import

You can access files for import from any folder or drive source mounted on the desktop, such as a 3.5-inch diskette, fixed drive, removable magnetic (RMAG) drive, or network server. You can import more than one file at a time, including files of multiple types.

To import a file:

1. Open the bin in which you want to store the imported file. Click anywhere in the bin to select it.
2. Choose Import from the File menu.

   The Select Files to Import dialog box appears.
3. Choose an import file type from the File Type pop-up menu:

- Choose Shot Log to import ASCII text or Avid Log Exchange (ALE) files containing clip information into a bin. For more information about Avid Log Exchange specifications, see the Avid Media Composer Products Reference.

- Choose Graphic/Audio to import one of more than 30 supported graphics and audio file types. For more information on the various file types and their import specifications, see “Import and Export Specifications” on page 301.
Choose OMFI to import files that have been saved in the OMF file format, such as sequences transferred from an effects or digital audio workstation.

Choose Editcam to import master clips captured in the field with an Ikegami Editcam. You can also import a sequence playlist. For more information, see “Editcam File Specifications” on page 316.

By default, the system displays file types that belong to the chosen category only in the source file list on the left side of the dialog box.

4. Click the Options button to open a dialog box for adjusting the import settings.

The Import Settings dialog box contains an appropriate subset of the import options according to the selected file type.

For a complete description of all import options, see “Import Settings” on page 243.
5. Select the appropriate options. Click OK to close the Import Settings dialog box and return to the Select Files to Import dialog box.

6. Choose a destination disk for the imported file from the Media Disk pop-up menu.

7. For graphics and video files, choose a resolution for the imported media from the Resolution pop-up menu.

   For optimum speed when importing an OMF file, set the resolution to match the resolution of the OMF file you are importing. If you are using mixed resolutions, choose the highest AVR that you will be using for the final version of the sequence. See “Importing in Mixed-Resolution Projects” on page 235.

8. Use the Directory pop-up menu to locate the folder containing the source files.

9. Add files to or remove files from the import file list on the right by using the following methods:
   - To add a single file, select a file name in the source file list and click the Add button, or double-click the file name.
   - To add all the files in the source file list, click the Add All button.
   - To remove a single file from the import file list, select a file name and click the Remove button.
   - To remove all the files from the import file list, click the Remove All button.

   If you are importing a sequential series of image files, add only the first file in the series (from the source file list) to the import file list.

10. Click Done.

   If you batch import OMF files at multiple resolutions with the OMFI Resolution: Ask Me option selected in the Import Settings dialog box, a warning appears when the AVR of the source files does not match the current AVR setting in the Select Files to
Import dialog box. Choose either the AVR of the source file or the current AVR setting to continue.

When the system finishes importing the files, the clips appear in the selected bin.

If you import an OMF file with a stereo sound track, the Avid Composer system creates a new master clip that contains the right channel of the sound track. The original master clip contains the left channel. Both clips appear in the bin you select.

**Importing Shot Log Files**

To import shot log files into a bin:

1. Open a bin. Click anywhere in an open bin to select it, or create a new bin for the shot log import.

2. Choose Import from the File menu.

   The Select Files to Import dialog box appears.
3. Choose Shot Log from the File Type pop-up menu. By default, the system displays file types that belong to the chosen category only in the source file list on the left side of the dialog box.

4. (Option) Select Show All Files (in the lower left corner of the Select Files to Import dialog box) to display all files in a chosen folder, regardless of the file type. Use this option if you want to batch-import multiple file types.

When batch-importing multiple files and file types, establish global import settings in advance.

5. Click the Options button to open a dialog box if you want to select options for combining events on import for the import settings.

6. After selecting the appropriate options, click OK to close the Import Settings dialog box and return to the Select Files to Import dialog box.
7. Use the Directory pop-up menu to locate the folder containing the source file.

8. Select the file name in the source file list and click the Add button, or double-click the file name to add it to the import file list on the right.

9. Click Done

When the system finishes importing the file, the clips appear in the selected bin.

**Import Settings**

Table 9-1 lists the options in the Import Settings dialog box.
### Table 9-1 Import Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect Ratio</td>
<td>Maintain Aspect</td>
<td>The Avid Composer system uses the existing pixel aspect ratio for the imported frames. In most cases, for example a graphics application, use this option for an image created in square-pixel terms. The square pixel aspect ratio is translated by the Avid Composer system’s non-square-pixel environment, maintaining the original aspect ratio. If the height or width of the images in pixel terms exceeds the dimensions of the Avid Composer system, the longest dimension is scaled to fit the screen size and, if necessary, missing pixels in the shorter dimension are filled with black. If the height and width of the images are smaller than the dimensions of the Avid Composer system, the original aspect ratio is maintained and the image is surrounded by black. For best resolution of full-screen import of files created in a square-pixel environment, use 648 x 486 NTSC, 1024 x 768 PAL. To create a single resolution for both NTSC and PAL, use 720 x 540.</td>
</tr>
<tr>
<td></td>
<td>Ratio</td>
<td>Do not use this option if you import images in the 720 x 486 NTSC (720 x 576 PAL) non-square-pixel dimensions used by the Avid Composer system.</td>
</tr>
</tbody>
</table>
The system converts the existing pixel dimensions, if necessary, so that the entire image fills the screen.

If the aspect ratio of the frames, in non-square-pixel terms, does not match the 3:4 aspect ratio used by the Avid Composer system, the imported frames might be distorted.

For best resolution of full-screen importing of files created in a square-pixel environment, use 648 x 486 NTSC, 1024 x 768 PAL. To create a single resolution for both NTSC and PAL, use 720 x 540.

Choose this option if you are importing images with the 720 x 486 NTSC (720 x 576 PAL) non-square-pixel dimensions used by the Avid Composer system. You must use this option to maintain field data when importing two-field media.

File has RGB Graphics levels
Choose RGB Graphics levels for most computer-generated graphics. RGB color values are remapped to CCIR 601 video color values appropriate for the Avid Composer system.

CCIR Video levels
Choose CCIR Video levels for graphics created with professional video levels based on the CCIR 601 standard. This includes Avid color bars (available on the Avid drive in Media Composer:Supported Files:Test Patterns and Film Composer:Supported Files:Test Patterns) or images that include superblack (zero black) for keying purposes.

Import Sequential Files
Select this option to import a sequenced series of image files. You can import sequential files for any of the supported still-image formats. For information on preparing a sequence of image files, see “Animation File Specifications” on page 311.
The system imports an image that contains alpha channel transparency information as an opaque graphic.

If an image contains an embedded alpha channel but the system does not support alpha channel import for the file type, select this option to import the image successfully. For information on alpha channel support, see "Graphics File Specifications" on page 305.

Invert Existing Alpha
Reverses the black and white elements of the alpha channel if they differ from the matte-key requirements of the system: a white background, a black foreground, and a gray transparency blend between the two.

Table 9-1  Import Settings (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Existing Alpha</td>
<td></td>
<td>The system imports an image that contains alpha channel transparency information as an opaque graphic.</td>
</tr>
<tr>
<td>Invert Existing Alpha</td>
<td></td>
<td>Reverses the black and white elements of the alpha channel if they differ from the matte-key requirements of the system: a white background, a black foreground, and a gray transparency blend between the two.</td>
</tr>
<tr>
<td>Single Frame Import</td>
<td>Format: Media File</td>
<td>Applies to importing source images without alpha channel. Creates digital media for the file similar to the media created when you digitize footage. You can also designate the duration of the media. This method ensures that you can play the clip in real time, even at a high resolution such as AVR 75 or 77. The import process takes close to real time. For example, if you choose a duration of 25 seconds for the file, the system takes approximately 25 seconds to complete the import.</td>
</tr>
</tbody>
</table>
|                               | Format: As a Slide | Always applies when importing source images with alpha channel. You can also choose this option for images without alpha channel.

When importing an image with alpha channel, the system automatically creates a matte-key effect in the bin as a slide with no associated media file.

Importing as a slide takes less time and requires less storage. A slide is more limited in terms of real-time playback capabilities, particularly at high AVRs. This is because the system handles a slide by loading the frame into memory and transferring it through the compression technology of the system in real time, rather than playing back from disk. |
### Table 9-1  Import Settings (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Determines the duration of the master clip created from the import. The default is 10 seconds. This option does not apply when importing sequential image files because each file represents one frame of the clip; therefore, the total number of files determines the total duration.</td>
<td></td>
</tr>
<tr>
<td>Shot Log</td>
<td>Combine events based on scene and automatically create subclips.</td>
<td>Combines all events for a scene into a single master clip and then links the master clip to subclips that represent the original events for that scene. To use this option, you must have scene numbers logged in a scene column in the bin.</td>
</tr>
<tr>
<td></td>
<td>Combine events based on camera roll and automatically create subclips.</td>
<td>Combines all the events from a camera roll into a single master clip and then links the master clip to subclips that represent the original events for that camera roll. To use this option, you must have camera roll numbers logged in a camera roll column in the bin for a film project.</td>
</tr>
<tr>
<td></td>
<td>Merge events with known sources and automatically create subclips.</td>
<td>Automatically creates subclips for those events that are merged or relinked to their source clips upon import. Use this option if you have already entered master clips in a bin for each camera roll or master scene, and subsequently logged all the events related to those clips for import. You must select the clips you want to merge before choosing this option.</td>
</tr>
<tr>
<td></td>
<td>Merge events with known master clips.</td>
<td>Automatically creates subclips for those events that are merged, or relinked to a selected master clip based upon matching tape name. Use this option if you have already logged (or digitized) master clips in a bin for each tape. You must select the clips you want to merge before choosing this option.</td>
</tr>
</tbody>
</table>
The Avid Composer system prompts you to choose the AVR on a file-by-file basis when the AVR of an imported OMFI file differs from the current AVR setting in the Select File to Import dialog box.

Choosing a resolution other than the source file resolution will slow the import process.

The Avid Composer disregards the AVR of the source OMFI files during import and automatically uses the current AVR setting in the Select Files to Import dialog box.

Importing OMFI files that have resolutions different from the source file resolution will slow the import process.

The Avid Composer system disregards the current AVR settings in the Select Files to Import dialog box and automatically uses the AVR of the source OMFI files during import.

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMFI Resolution</td>
<td>Ask Me</td>
<td>The Avid Composer system prompts you to choose the AVR on a file-by-file basis when the AVR of an imported OMFI file differs from the current AVR setting in the Select File to Import dialog box. Choosing a resolution other than the source file resolution will slow the import process.</td>
</tr>
<tr>
<td>Use Current</td>
<td></td>
<td>The Avid Composer disregards the AVR of the source OMFI files during import and automatically uses the current AVR setting in the Select Files to Import dialog box. Importing OMFI files that have resolutions different from the source file resolution will slow the import process.</td>
</tr>
<tr>
<td>Use Source</td>
<td></td>
<td>The Avid Composer system disregards the current AVR settings in the Select Files to Import dialog box and automatically uses the AVR of the source OMFI files during import.</td>
</tr>
</tbody>
</table>
Exporting Files

You can export material directly from a Media Composer product to any one of more than 25 supported file types. You can export an individual frame, a selected region of footage, or an entire clip or sequence.

*For information on a specific file format, see “Supported File Types” on page 301.*

There are several reasons why you might want to export video, audio, or both from the Avid Composer system:

- You can export audio files for audio sweetening in compatible applications.
- You can export picture files for touching up or creating special effects in third-party applications.
- You can export files compatible with CD-ROM for use in multimedia projects.
- You can use the export process to convert audio media files between the two supported formats (AIFC and Sound Designer II).

*If you are planning to transfer the exported files to another Avid Composer system or third-party application, see “Exchanging Files with Other Systems” on page 270 for recommended steps and advice.*

The following sections describe general procedures for preparing a sequence and performing an export.
Preparing to Export a Sequence

If you are exporting part or all of a sequence — to QuickTime, ERIMovie, Sequenced PICT, or OMFI file types, for example — you can speed the export process by preparing the sequence in advance as follows:

- Make sure all media for the sequence is online. For more information, see “Offline items, selecting in a bin” in the online help index.
- If you want to archive the source sequence before making any alterations, duplicate the sequence, place the duplicate in another bin, and prepare the duplicate for export. The original sequence will be unaffected.
- Consider rendering all effects in advance. Although any unrendered effects are rendered on export (except for an OMFI export), rendering effects in advance saves you time. For more information, see “Rendering” in the online help index.
- If your sequence contains numerous video tracks, consider mixing down the tracks in advance for faster export, unless you need to preserve the multiple track information. For more information, see “Video:mixdown, performing” in the online help index.
- If your sequence contains numerous audio tracks with various audio effects and level adjustments, consider mixing down the tracks for faster export, unless you need to preserve the information. For more information, see “Audio:mixdown, performing” in the online help index.

Using Global Export Settings

You can establish a set of global export parameters in the Export Settings dialog box prior to beginning the export process. These parameters remain the default settings for all exported files, unless you change them during export. This is especially useful when you batch export a number of files directly from a bin in one procedure.
Performing the Export

To export frames, clips, or sequences:

1. Select the material you want to export by using one of the following procedures:
   - To export specific tracks in a clip or sequence, enable those tracks in the Track Selector panel, and disable all others.
   - To export a single frame, do either of the following:
     - Mark an IN point to export the marked frame from a bin or a monitor.
     - Park the position indicator on the frame you want to export from a clip in the monitor.
   - To export part of a clip or sequence, mark IN and OUT points to export the marked range from a bin or a monitor. If you mark an IN point and no OUT point, the system exports from the IN mark to the end of the clip or sequence.
   - To export the entire clip or sequence, deselect the options Use Enabled Tracks and Use Marks in the Export Settings dialog box. Make sure that you monitor the highest video track and

!! When selecting specific tracks for export, you must select the option Use Enabled Tracks in the Export Settings dialog box. If no tracks are enabled and you want to export all tracks in the clip or sequence, you must deselect Use Enabled Tracks. For more information, see “Export Settings” on page 259.

!! When placing IN or OUT marks to determine a frame or range for export, you must select the option Use Marks in the Export Settings dialog box. See “Export Settings” on page 259.

To adjust options in the Export Settings dialog box, double-click Export in the Settings scroll list of the Project window.
select the proper tracks for export. The system exports whatever you see when you play the sequence.

When exporting to an OMF file, you do not need to select both the sequence and its source clips. Select just the sequence to export all the necessary information including reference clips.

2. Choose Export from the File menu.

The Export File Type dialog box appears.

3. Select the appropriate file type and options based on the descriptions in Table 9-2.
<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid Log Exchange</td>
<td></td>
<td>Exports the selected bin as a shot log file that complies with Avid Log Exchange (ALE) specifications. For more information, see “Avid Log Exchange” in the online help index.</td>
</tr>
<tr>
<td>Tab Delimited</td>
<td></td>
<td>Exports the selected bin as a shot log file in the form of a tab-delimited ASCII text file.</td>
</tr>
<tr>
<td>OMFI Composition (first pop-up menu)</td>
<td>Standard - AIFC</td>
<td>Choose this option to export a standard OMFI composition for transfer to a third-party workstation that supports OMFI. The export is Composition only, unless you select the With Media option.</td>
</tr>
<tr>
<td></td>
<td>AudioVision</td>
<td>Choose this option specifically for export to AudioVision.  appropriate options for OMFI1.0 and With Media are automatically chosen for this type of export. If you choose Video ano from the second pop-up menu, the video media is embedded in the OMFI Composition file. Audio media is external to the OMFI file. If necessary, the system translates AIFC audio to the SD2 format.</td>
</tr>
<tr>
<td></td>
<td>SD2</td>
<td>Choose this option specifically for export to Pro Tools or another product that supports the SD2 (Sound Designer II) audio format. The With Media option is automatically selected. Audio media is external to the OMF file. If necessary, the system translates AIFC audio to the SD2 format.</td>
</tr>
<tr>
<td></td>
<td>TIFF Video</td>
<td>Choose this option to export video tracks to a third-party OMFI-compatible application that does not support video media for Release 7.0 of the Media Composer products. If the third-party application is compatible with 7.0 video media, choose Standard-AIFC instead.</td>
</tr>
<tr>
<td>OMFI Composition (second pop-up menu)</td>
<td>Video and Audio</td>
<td>Choose this option if you use both video and audio tracks of a clip or sequence in an OMFI-compatible editing or graphics enhancement system.</td>
</tr>
<tr>
<td>Option</td>
<td>Suboption</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Video Only</td>
<td></td>
<td>Choose this option if you do not need audio tracks; for example, when adding video or film effects in an OMFI-compatible application.</td>
</tr>
<tr>
<td>Audio Only</td>
<td></td>
<td>Choose this option if you do not need video tracks, and you are using or enhancing audio in an OMFI-compatible application such as a digital audio workstation. You must choose this option if you are transferring to Pro Tools.</td>
</tr>
<tr>
<td>OMFI Composition:</td>
<td>OMFI 1.0</td>
<td>Choose this option if the application to which you are exporting does not support OMFI Version 2.0.</td>
</tr>
<tr>
<td>Version</td>
<td>OMFI 2.0</td>
<td>Choose this option if the application to which you are exporting supports OMFI Version 2.0. If you are not sure, choose 1.0.</td>
</tr>
<tr>
<td></td>
<td>With Media</td>
<td>Select this option to transfer the audio media files along with the OMFI Composition for use in a third-party application that supports the types of media files used in the exported OMFI composition. Audio media is external to the OMF file.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>Video and Audio</td>
<td>Choose this option if, for example, you are using an entire clip or sequence in a multimedia project.</td>
</tr>
<tr>
<td></td>
<td>Video Only</td>
<td>Choose this option if, for example, you are adding effects in a third-party application or using only the video in a multimedia project.</td>
</tr>
<tr>
<td></td>
<td>Audio Only</td>
<td>Select this option if, for example, you are using or enhancing audio in a third-party application or using only the audio in a multimedia project.</td>
</tr>
<tr>
<td>Sound</td>
<td>SD2</td>
<td>Exports audio tracks in the Sound Designer II format that are compatible with Pro Tools and other third-party applications. You can use this option to convert AIFF audio media to Sound Designer II media on export.</td>
</tr>
</tbody>
</table>
4. If the additional options listed need correction, click the Options button. (The following screen shows an example of a sequence selected for export as a QuickTime file.)

An appropriate subset of export options appears based on the selected file type. The following screen shows an example of options for a graphics file export.
5. Adjust the additional export settings, and click OK to return to the Export File Type dialog box.

For a complete description of all options in the Export Settings dialog box, see “Export Settings” on page 259.

6. When all options are listed correctly, click OK.

A destination dialog box opens with a default file name in the Export As text box. The name is based on the file type.

7. (Option) Change the file name.
If you are transferring the files for use in a third-party application, keep the default extension to avoid conflicts. Also, avoid names that include spaces or special characters.

8. Select the destination folder for the file and click Save.

For most file types, the file is exported and appears at the chosen destination.

For OMFI export, if the sequence contains effects that are not supported by OMFI 2.0 a dialog box appears. You can choose to cancel or continue exporting a composition that will not include the unsupported effects.

9. If an additional dialog box of export parameters appears, select the appropriate options for the chosen file type. If you are exporting one of the following file types, use Table 9-5 on page 267 to select additional export parameters.

- BMP
- Cineon
- ERIMovie
- JPEG
- Photoshop
- PNG
- SGI
- Targa
- TIFF
- Wavefront
- YUV

10. Click OK to complete the export.

The Macintosh system allows a maximum file size of approximately 2 gigabytes. If you exceed this limit, the file is unusable and the system displays an error message.
If a power failure or mishap occurs during the export process, the entire file is unusable. You must repeat the export process. The only exception is a PICT sequence: all frames up to the point of failure are usable.

Exporting Shot Log Files

You can export a log file from the Avid Composer system in one of two formats for making adjustments in a text processor or for importing into another system.

To export a shot log based on clip information in a bin:

1. Open the bin containing the clips you want to export, and change to Text mode.
2. Choose Export from the File menu. The Export File Type dialog box appears.
3. Select either Avid Log Exchange or Tab Delimited as the file type.
4. Click OK.
   A destination dialog box appears with a default file name in the Export As text box, based on the file type.
5. Change the file name if you want (keep the file extension), select the destination folder for the file, and click Save.
   The file is exported and appears at the chosen destination.
Export Settings

Table 9-3 lists the options in the Export Settings dialog box.

[Image of the Export Settings dialog box]

[Table 9-3]

Export Settings (Current)
- Use Marks
- Use Enabled Tracks
- Use Both Fields

Destination Size (width x height):
- 720 x 486

File has RGB Graphics levels

Sequential Files

Audio Output:
- Stereo

Audio Sample Rate:
- Native Rate

Audio Sample Size:
- 8 bits

Create Movie Preview
- Cross-Platform Movie
- Use Source Compression

Compression Settings
- OK
- Cancel

259
<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks</td>
<td></td>
<td>Instructs the system to use IN and OUT marks currently set in the selected clip or sequence to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option.</td>
</tr>
<tr>
<td>Use Enabled Tracks</td>
<td></td>
<td>Instructs the system to export only the currently enabled tracks for a selected sequence during the export. To export all tracks in the sequence, deselect this option.</td>
</tr>
<tr>
<td>Use Both Fields</td>
<td></td>
<td>Select this option if you are exporting any of the two-field resolutions (AVR 70B to AVR 77, or AVR 12). This option combines both video fields for higher resolution.</td>
</tr>
<tr>
<td>Destination Size</td>
<td>720 x 486 (NTSC)</td>
<td>Full-screen, non-square-pixel dimensions according to CCIR 601 video standards. Use these dimensions, for example, when treating video footage in a third-party application before reimporting into the Avid Composer system.</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 x 540 (NTSC)</td>
<td>Matching square-pixel dimensions for the full-screen, non-square-pixel dimensions used by the Avid Composer system.</td>
</tr>
<tr>
<td></td>
<td>768 x 576 (PAL)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 x 480</td>
<td>Full-screen, half-screen, and quarter-screen square-pixel dimensions based on normal RGB computer display. Use these dimensions, for example, to generate QuickTime movies for a multimedia project.</td>
</tr>
<tr>
<td></td>
<td>320 x 240</td>
<td></td>
</tr>
<tr>
<td></td>
<td>160 x 120</td>
<td></td>
</tr>
<tr>
<td>File has</td>
<td>RGB Graphics levels</td>
<td>Exports the file with levels calibrated for RGB computer environments. Choose this option for most graphics file types if the destination is a third-party computer graphics application.</td>
</tr>
<tr>
<td></td>
<td>CCIR Video levels</td>
<td>Exports the file with video levels calibrated according to the CCIR 601 standard for display in professional video environments. Choose this option, for example, if the file will eventually be displayed on a video monitor or returned to the Avid Composer system after treatment.</td>
</tr>
<tr>
<td>Option</td>
<td>Suboption</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sequential Files</td>
<td>FPS pop-up menu</td>
<td>Determines the number of frames per second (fps) to be saved in the file. You can reduce the size of the export file by selecting fewer frames per second, but motion will be less smooth. Choices are 5, 10, 15, 29.97, or 30 fps.</td>
</tr>
<tr>
<td>Audio Output</td>
<td>Mono</td>
<td>Mixes all tracks down to track 1 on export.</td>
</tr>
<tr>
<td></td>
<td>Stereo</td>
<td>Exports all even-numbered tracks to track 2 and all odd-numbered tracks to track 1.</td>
</tr>
<tr>
<td>Audio Sample Rate</td>
<td>Native Rate</td>
<td>The native rate of the chosen audio media (44.1 kHz or 48 kHz).</td>
</tr>
<tr>
<td></td>
<td>22.254 kHz (Std Macs)</td>
<td>Half the sample rate of 44 kHz media for playback on standard Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>22.050 kHz (AV Macs)</td>
<td>Half the sample rate of 44 kHz media for playback on AV (Audio/Video enabled) Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>11.127 kHz</td>
<td>One-quarter the sample rate of 44 kHz media for playback on standard Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>11.025 kHz</td>
<td>One-quarter the sample rate of 44 kHz media for playback on AV Macintosh models.</td>
</tr>
<tr>
<td>Audio Sample Size</td>
<td>8 bits</td>
<td>Exports an 8-bit audio sample size for use in third-party systems that do not support 16-bit; also used to minimize the data throughput requirements (for example, to improve playback in multimedia projects).</td>
</tr>
<tr>
<td></td>
<td>16 bits</td>
<td>Exports a 16-bit audio sample size (currently the industry standard bit rate for audio).</td>
</tr>
<tr>
<td>Create Movie Preview</td>
<td></td>
<td>Creates a QuickTime poster (a still-image preview frame) for your movie (slows the export process).</td>
</tr>
<tr>
<td>Cross-Platform Movie</td>
<td></td>
<td>Creates a single-fork, cross-platform compatible movie that can be opened on both the Macintosh and the PC for use in cross-platform multimedia development.</td>
</tr>
</tbody>
</table>
Table 9-3  Export Settings (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Source Compression</td>
<td></td>
<td>Uses the current compression settings. When this box is checked, the Compression Settings button becomes disabled.</td>
</tr>
<tr>
<td>Compression Settings</td>
<td></td>
<td>This button appears only when the Use Source Compression box is not selected. Click this button to open the Compression Settings dialog box. For more information, see Table 9-4. Also see the “Use Source Compression” option, as well as the Avid Media Composer Products Reference.</td>
</tr>
</tbody>
</table>
Compression Settings Dialog Box

To open the Compression Settings dialog box, click the Compression Settings button in the Export Settings dialog box.

Table 9-4 lists the options in the Compression Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor</td>
<td>Animation</td>
<td>For high-quality, lossless compression (in which no picture information is lost).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Uses the same compression algorithm for PICT files (run length encoding) and results in files that are 70 to 95 percent the size of the uncompressed file. At the maximum quality, this method is lossless compression.</td>
</tr>
</tbody>
</table>
For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive.

Uses compression algorithm optimized for CD-ROM playback.

Component Video
For high-quality, *lossless* compression (in which no picture information is lost).

Uses the same algorithm as the Animation method but saves the file in YUV RLE format, which separates the luminance from the chrominance. All QuickTime applications can read this format, but only some can write to this format.

Graphics
For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive.

Uses a limited color palette version (16 colors) of Animation compression.

Media Composer
For quickest exchange between compatible applications, maintaining the original AVR of the source media.

Encapsulated media files for quick export of high-resolution files that are readable within QuickTime applications that are also equipped with the codec. See “Using the Media Composer QuickTime Codec” on page 288.

Exporting with the Avid codec does not cause any loss in quality, because the codec maintains the identical media data. However, the quality cannot be better than the original resolution of the digitized media.

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cinepak</td>
<td></td>
<td>For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive. Uses compression algorithm optimized for CD-ROM playback.</td>
</tr>
<tr>
<td>Component Video</td>
<td></td>
<td>For high-quality, <em>lossless</em> compression (in which no picture information is lost). Uses the same algorithm as the Animation method but saves the file in YUV RLE format, which separates the luminance from the chrominance. All QuickTime applications can read this format, but only some can write to this format.</td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
<td>For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive. Uses a limited color palette version (16 colors) of Animation compression.</td>
</tr>
<tr>
<td>Media Composer</td>
<td></td>
<td>For quickest exchange between compatible applications, maintaining the original AVR of the source media. Encapsulated media files for quick export of high-resolution files that are readable within QuickTime applications that are also equipped with the codec. See “Using the Media Composer QuickTime Codec” on page 288. Exporting with the Avid codec does not cause any loss in quality, because the codec maintains the identical media data. However, the quality cannot be better than the original resolution of the digitized media.</td>
</tr>
</tbody>
</table>
Table 9-4  Compression Settings Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion JPEG A</td>
<td>For medium quality, <em>lossy</em> compression (in which some picture information is lost) requiring much storage space and additional hardware support for real-time playback.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Motion JPEG (M-JPEG) is a variant of the ISO JPEG specification for use in digital video. Considered the standard for Motion JPEG, format A is supported by chips from Zoran and C-Cubed.</td>
<td></td>
</tr>
<tr>
<td>Motion JPEG B</td>
<td>For medium quality, <em>lossy</em> compression (in which some picture information is lost) requiring additional hardware support for real-time playback.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Motion JPEG (M-JPEG) is a variant of the ISO JPEG specification for use in digital video. Format B cannot use the markers that ISO JPEG and format A do; supported by chips from LSI.</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>For high-quality, <em>lossless</em> compression (in which no picture information is lost). Does not compress the file; results in very large files.</td>
<td></td>
</tr>
<tr>
<td>Photo-JPEG</td>
<td>For medium quality, <em>lossy</em> compression (in which some picture information is lost) requiring moderate storage space and data throughput on playback.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Uses the Joint Photographic Experts Group (JPEG) algorithm for image compression; results in files that are 20 to 30 percent the size of the uncompressed files. Some data is lost during compression, and the export process takes longer to complete (typically six times longer than the Animation compression, for example).</td>
<td></td>
</tr>
<tr>
<td>Planar RGB</td>
<td>For high-quality, <em>lossless</em> compression (in which no picture information is lost). Results in large files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Uses a run length encoding scheme, similar to the animation codec. Instead of encoding each pixel however, it encodes each image plane separately by using a run length algorithm. Planar RGB is used primarily to support Photoshop files, which in most cases are stored using a planar run length algorithm.</td>
<td></td>
</tr>
</tbody>
</table>
Video: For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive.

Uses the standard Macintosh compression, which takes less time to compress but does not play back as effectively as Cinepak.

Color: No options are available for color in Media Composer export.

Quality: Click the option and drag this slider to adjust the image quality for the exported file.

If you selected the Media Composer codec, a dialog box appears, allowing you to select an AVR.

If you change the AVR, when you click OK to close the Compression Settings dialog box, another dialog box allows you to decide whether to accept the new AVR or maintain the original AVR.

Because the Media Composer codec uses the AVR of your original source files, selecting another AVR requires conversion of the media and slows down the export process considerably. Maintain the AVR of the source media whenever possible.

Motion: Choose the frame rate you want from the pop-up menu.

Choose 30 to maintain full-motion video/animation. A frame rate of 29.97 conforms to NTSC video frame-rate standards.

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td></td>
<td>For export at low resolution for use in contexts where high quality is not an issue, such as presentations or educational uses, or for small-screen size playback from CD-ROM or hard drive. Uses the standard Macintosh compression, which takes less time to compress but does not play back as effectively as Cinepak.</td>
</tr>
<tr>
<td>Color</td>
<td></td>
<td>No options are available for color in Media Composer export.</td>
</tr>
<tr>
<td>Quality</td>
<td></td>
<td>Click the option and drag this slider to adjust the image quality for the exported file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you selected the Media Composer codec, a dialog box appears, allowing you to select an AVR.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you change the AVR, when you click OK to close the Compression Settings dialog box, another dialog box allows you to decide whether to accept the new AVR or maintain the original AVR.</td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td>Choose the frame rate you want from the pop-up menu. Choose 30 to maintain full-motion video/animation. A frame rate of 29.97 conforms to NTSC video frame-rate standards.</td>
</tr>
</tbody>
</table>
Additional Export Parameters

Dialog boxes for setting additional export parameters appear when you export to the file types listed in Table 9-5.

Table 9-5  Additional Export Parameters

<table>
<thead>
<tr>
<th>File Type Dialog Box</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP Parameters</td>
<td>Windows</td>
<td>Creates files that are compatible with systems running the Microsoft Windows® operating system.</td>
</tr>
<tr>
<td></td>
<td>OS/2®</td>
<td>Creates files that are compatible with systems running the IBM OS/2® operating system.</td>
</tr>
<tr>
<td>Cineon™ Parameters</td>
<td>Blackpoint</td>
<td>Allows you to adjust a film exposure value that corresponds to filming of a 2% black card. Values can be between 0 and 1022. The default value of 0 is adequate for most uses.</td>
</tr>
<tr>
<td></td>
<td>Whitepoint</td>
<td>Allows you to adjust a film exposure value that corresponds to filming of a 90% white card. Values can be between 1 and 1023. If the files came from and will be transferred back to a Cineon system, use a whitepoint of 1023. The default value of 685 is appropriate if the final destination is something other than a Cineon system — for example, to a video display.</td>
</tr>
<tr>
<td></td>
<td>Gamma</td>
<td>Specifies an adjustment to correct for any gamma inconsistencies in the output display. Values can be between 0.01 and 100.0. Use a value of 1.0 (the default) for images displayed on a PC monitor. Use a value of 0.39 for a Silicon Graphics® or Macintosh monitor. Use a value of 0.45 for ITU-R 601 (CCIR 601) video.</td>
</tr>
<tr>
<td>ERIMovie Parameters</td>
<td>Pack 24 bits</td>
<td>Controls whether the image data is packed into 24-bit color depth (compressed) or saved as 32-bit (raw).</td>
</tr>
</tbody>
</table>
### Table 9-5 Additional Export Parameters (Continued)

<table>
<thead>
<tr>
<th>File Type Dialog Box</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG Parameters</td>
<td>Quality</td>
<td>Controls the output file size and quality. Higher values produce better images but larger file sizes. Conversely, lower values reduce the image quality but result in smaller file sizes.</td>
</tr>
<tr>
<td></td>
<td>Baseline</td>
<td>Only for applications that require this option for JPEG files. Consult the documentation that came with your JPEG-supported applications to see if this option is required. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>Progressive</td>
<td>Allows you to save progressive JPEG files, which divide the file into a series of increasing quality scans of the image. Each scan progressively improves the recognizability of the image. Progressive JPEG files are recognized only by applications with progressive JPEG support, such as some Web browsers.</td>
</tr>
<tr>
<td>Photoshop Parameters</td>
<td>Compression</td>
<td>Controls the size of the file on disk. Disabling compression creates larger files on disk.</td>
</tr>
<tr>
<td>PNG Parameters</td>
<td>Color Depth</td>
<td>The 8-bits option saves 8-bit data, even if it is not. The 16 bits option saves 16-bit files. The Automatic option saves the image in the same depth as the original loaded image.</td>
</tr>
<tr>
<td></td>
<td>Interlaced</td>
<td>Allows you to save the file for progressive display, similar to progressive JPEG files. As the file is transmitted, the recognizability of the image improves. Interlaced PNG files can be recognized only by applications with interlaced PNG support, such as some Web browsers.</td>
</tr>
<tr>
<td>SGI Parameters</td>
<td>Color Depth</td>
<td>The 8-bits option saves 8-bit files. The 16 bits option saves 16-bit files. The Automatic option saves the image in the same depth as the original loaded image.</td>
</tr>
<tr>
<td>Targa Parameters</td>
<td>Color Depth</td>
<td>Controls how images are saved. The 5-bits option saves data in Targa 16 format. The 8-bits option saves data in Targa 24/32 format.</td>
</tr>
</tbody>
</table>
Compression Controls the size of the file on disk. Disabling compression creates larger files on disk.

TIFF Parameters

Color Depth The 8-bits option saves 8-bit files. The 16-bits option saves 16-bit files. The Automatic option saves the image in the same depth as the original loaded image.

Compression Controls the size of the file on disk. With None, image data is not compressed and can produce large file sizes. RLE (Run Length Encoded) produces relatively small and fairly portable files.

Wavefront Parameters

Format Type Specifies one of two output file formats supported by Wavefront (either RLA or RLB).

Color Depth The 8-bits option saves 8-bit files. The 16-bits option saves 16-bit files. The Automatic option saves the image in the same depth as the original loaded image.

Gamma Specifies an adjustment to correct for gamma differences between Macintosh and Windows PC output display. This option is intended for cross-platform applications that require adjustment.

Consult the documentation that came with your Wavefront application to see if you need to adjust this value. Typically, you can use the default setting.

YUV Parameters

Format Controls the video format of saved images. If set to “NTSC,” NTSC video format (720 x 486) is used. If set to “PAL,” PAL video format (720 x 576) is used. Images are either padded with black or cropped.

Smooth YUV Enhances the fidelity of images saved in YUV color space (if originating in RGB color space).
Exchanging Files with Other Systems

This section provides specific steps and recommendations for exchanging files and media in the following circumstances:

- **Audio sweetening in AudioVision**: To export a sequence with audio tracks for audio sweetening in the AudioVision application, see “Transferring OMF Files from Media Composer to AudioVision” on page 273, or “Transferring OMF Files from Film Composer to AudioVision” on page 279.

- **Audio sweetening in Pro Tools**: To export a sequence with audio tracks for audio sweetening in the Pro Tools application, see “Transferring OMF Files to Pro Tools” on page 283.

- **Audio sweetening in other compatible applications**: To transfer files to other OMFI compatible third-party digital audio applications, see “Transferring OMF Files to Pro Tools” on page 283. Also see the digital audio workstation’s documentation.

- **Visual effects in OMFI-compatible applications**: To export video tracks for touching up or creating special effects in OMFI-compatible effects applications, follow one of the methods described in “Exporting Files” on page 249. Also see the effects workstation’s documentation.

- **Visual effects in QuickTime applications**: To export video tracks for touching up or creating special effects in QuickTime-compatible applications, see “Using the Media Composer QuickTime Codec” on page 288.

- **Transfer of projects to other Media Composer products**: To transfer whole projects between Media Composer products (for example, if your facility uses different system models at different stages of postproduction) see “Transferring a Project to Another Avid Composer Product” on page 296.

To learn more about OMF Interchange, see “About OMF Interchange” on page 271.
OMF Interchange is a platform-independent file format that stores both the digital media (video, audio, graphics, animation) and the recipe describing how the media ingredients are edited together to form a final sequence. This editing information, called a composition, is the OMF representation of the sequence created in the Avid Composer system. The OMF Interchange format is the result of cooperative efforts of many industry and standards partners and Avid Technology, Inc.

Any other program that supports OMFI can read OMF files, even if the program resides on a different computer platform. As a result, with OMFI you can transfer among different applications on different platforms, without worrying about cross-platform translations. This can be very effective for importing animation or audio files created on proprietary platforms.

To avoid errors and incompatibilities when importing and exporting OMF files, observe the recommendations described in “OMF File Specifications” on page 314.

See the Avid Media Composer Products Reference for an appendix that lists applications that currently support OMF Interchange. For the latest information, see the Avid OMFI web site:

http://www.omfi.org

Choosing a Transfer Method

OMF Interchange, as implemented in the Avid Composer system, provides two basic methods for exporting files:

- **Method One: OMF compositions only, without media files:** The Avid Composer system can export an OMF file that contains only the editing information about a selected master clip or sequence. It includes references to the source media files but does not include the media itself. You then need to transfer both the OMF file and
the media files, or redigitize the media on the other system. After you have transferred the media once, you can transfer revised composition-only files (unless you consolidated the media, in which case, you must transport the media files as well. For more information, see “Consolidating:media” in the online help index).

- **Method Two: OMF compositions with encapsulated media files:** The Avid Composer system exports an OMF file that contains all the editing information for the selected master clip or sequence along with references to the audio media files for that master clip or sequence. In the case of AudioVision or Sound Designer II (SD2) export, audio media is converted, if necessary, to the SD2 format.

If you are not sure which audio file format the third-party application supports, export using the more universal Standard - AIFC option for use in other OMFI-compatible applications that may not be able to read the SD2 file format. The OMF Tool can also be used to convert the files back to the Sound Designer II format. You can download the OMF Tool from the Avid OMFI Web site:

http://www.omfi.org

**Preparing Sequences for OMF Export**

If you are exporting part or all of a sequence to an OMF file, you can speed the export process by preparing the sequence in advance:

- Make sure all media for the sequence is online. For more information, see “Offline items, selecting in a bin” in the online help index.
- Duplicate the sequence and place the copy in a new bin. (This preserves the links from your original sequence to the original media disk or disks.)
- If your sequence contains numerous video tracks, consider mixing down the tracks in advance for faster export, unless you need to preserve the multiple track information. For more information, see “Video:mixdown, performing” in the online help index.
Check and adjust all pan and audio levels in advance. All current pan and level settings in the sequence are carried through to the exported media. For more information, see "Audio:mixdown, performing" in the online help index.

Consider rendering all effects in advance to shorten the time required for export. For more information, see "Rendering" in the online help index.

Consider consolidating the sequence to create smaller source clips, thereby saving time and disk space. For more information, see "Consolidating: media" in the online help index. For information on appropriate storage devices for consolidating, see "Recommended Storage Devices" on page 299.

OMF files with very complex sequences can fail during import into some applications, due to memory limitations. Try one of the following solutions:

- Break the sequence into smaller sequences and export the new sequences.
- Allocate more memory to the application.
- Add more physical memory.

To export multiple clips in a single OMF file, create a sequence from them. For example, you can select all the clips and Option-drag them into the Record monitor to create an instant sequence, then export it.

Transferring OMF Files from Media Composer to AudioVision

After editing in Media Composer, you can export and transfer your sequence and media to AudioVision for audio sweetening by using OMF Interchange.
Compatibility Issues Between AudioVision and Media Composer

Observe the following compatibility when you transfer files:

- Video media is not directly compatible between Release 7.0 of the Media Composer products and AudioVision — you cannot move video media files directly to the AudioVision system. However, you can use the AudioVision option in the Export procedure to transfer video. The Composer system converts the video media to the TIFF video format, which is reconverted to AudioVision-compatible media when you import the files to AudioVision.

- AudioVision Release 4.0 and Releases 6.0, 6.1, and 6.5 of the Media Composer are compatible in terms of both video media and audio media. In other words, you can include both video and audio tracks in the export, and you can transfer media files directly between systems.

- Video media in Release 3.6 or earlier of AudioVision is not compatible with Release 6.0 or later of the Media Composer.

- Video media in Release 3.6 or earlier of AudioVision is compatible with Release 5.51 or earlier of the Media Composer. If you would like to include video tracks in the transfer, see the documentation that came with the earlier release.

- In cases where video media is not compatible, you can add video to the transfer as follows:
  - Make a digital cut to tape of the video track only. You don’t have to record the audio tracks to the videotape unless you need a scratch track reference.
  - Be sure to match the timecode on the tape to the sequence timecode. You can do this by striping the videotape with appropriate timecode before the transfer. The digital cut will place the video onto the tape at the proper timecode location.
Before You Begin

To avoid problems, follow these guidelines when exporting from the Media Composer:

- Prepare the sequence as described in “Preparing Sequences for OMF Export” on page 272.

- The audio sampling rate of the sequence must be 44.1 kHz or 48 kHz. All audio clips in the sequence must be the same rate.

- Do not modify the start or end timecodes of master clips, and do not convert the frame rates.

- Make sure that the sequence contains video digitized at a single AVR level. AudioVision does not display video for sequences that contain mixed AVR levels.

- Occasionally, AudioVision stops importing and an “Out-of-memory” error message appears. This is because the OMF Interchange composition is too large. To correct the problem, export from the Media Composer in smaller sections as follows:
  - Divide the sequence into smaller segments by duplicating the sequence (perhaps several times) and deleting different portions of each copy.
  - Export and import each segment individually.
  - After the segments are imported, you can edit them together easily and accurately.

The size of the OMF Interchange composition is determined by its complexity, not by the length of the sequence. For example, a short sequence with many edits and tracks may be larger when exported as an OMF Interchange composition than a long sequence with only a few edits and tracks of audio and video.
Transferring a Video Sequence to AudioVision

To transfer a video sequence to AudioVision:

1. Select the material you want to export by using one of the procedures listed in step 1 in "Performing the Export" on page 251.

2. Choose Export from the File menu.

   The Export File Type dialog box appears.

3. Select OMFI Composition and choose AudioVision from the first pop-up menu.

   The system automatically chooses the correct options for OMFI 1.0 and enables With Media.

4. Choose an appropriate option from the export tracks pop-up menu:
• To include the video tracks with the audio, choose Video and Audio.

• To include the audio tracks only, choose Audio Only.

5. Depending upon how you marked the source material for export, click the Options button and adjust the options based on the following descriptions:

• **Use Marks**: Instructs the system to use IN and OUT marks currently set in the selected media to determine starting and ending frames for the export. Deselect this option to export the entire clip or sequence.

• **Use Enabled Tracks**: Instructs the system to export only the currently enabled tracks for a selected sequence during the export. Deselect this option if you want to export all tracks in the sequence.

6. Click OK to close the Export Settings dialog box and return to the Export File Type dialog box.

7. When all options are listed correctly, click OK.

   A destination dialog box opens with a default file name in the Export As text box based on the file type.

8. (Option) Change the file name.
If you are transferring the files for use in a third-party application, keep the default extension to avoid conflicts. Also, avoid names that include spaces or special characters.

9. Select the destination folder for the file and click Save. The sequence is exported.

The maximum file size that the Macintosh system allows is approximately 2 gigabytes. If you exceed this limit, the file is unusable and the system displays an error.

10. Close the Media Composer application and shut down your system.

11. Remove the drive or diskette containing the OMFI composition and the drive containing the media files; then transport them to the AudioVision system.

For more information on the correct procedures for connecting and disconnecting drives, see the appropriate hardware guide.

For information on transferring media files, see “Methods for Transferring Media Files” on page 298.

12. With the AudioVision system turned off, insert or connect the drives and boot the system.

13. Start the AudioVision application and import the composition. For more information, see the Avid AudioVision User’s Guide.

Occasionally, AudioVision stops importing and an “Out-of-memory” error message appears. This is because the OMF Interchange composition is too large and needs to be exported from the Avid Composer in smaller sections. For more information, see “Before You Begin” on page 275.

14. If you made a digital cut of the video track for the transfer, digitize the tape in AudioVision.
Transferring OMF Files from Film Composer to AudioVision

After editing in Film Composer, you can export and transfer your sequence and media to AudioVision for audio sweetening by using OMF Interchange.

Before You Begin

To avoid problems, follow these guidelines when exporting from Film Composer:

- Prepare the sequence as described in “Preparing Sequences for OMF Export” on page 272.
- Add a head and tail SMPTE (countdown) leader to your Film Composer sequence before exporting it. This gives you some extra material at the head and the tail.
- Make sure there is an obvious sync point (such as a beep) so you will be able to line up picture and sound in AudioVision.
- Set the pulldown switch on the Video Slave Driver to 1.00.
- The audio sampling rate of the sequence must be 44.1 kHz or 48 kHz. All audio clips in the sequence need to be the same sample rate.
- Do not modify the start or end timecodes of master clips, and do not convert the frame rates.
- Make sure that the sequence contains video digitized at a single AVR level. AudioVision does not display video for sequences that contain mixed AVR levels.

AudioVision Release 3.6 or earlier does not display video for sequences exported from Film Composer Release 6.0 or later.

- If you are transferring a PAL sequence from Film Composer, you must bring the sequence into Film Composer using Method Two described in the “Planning a Film Project” appendix of the Avid
Film Composer Getting Started Guide. Method Two is summarized below:

- Transfer the film picture alone to PAL video at a rate of 25 fps. Then use Film Composer to digitize the picture at 25 fps.

- Digitize the sound separately, either directly from the original audiotapes or from DAT transfer tapes, at the rate at which the sound was originally recorded. After digitizing is completed, use Film Composer’s AutoSync command to join each picture master clip with its corresponding sync sound master clip.

- Play and edit the captured picture at 24 fps and the audio at the sync sound rate or the rate at which it was captured.

Transferring a Film Sequence to AudioVision

To transfer a film sequence to AudioVision:

1. Make a digital cut to tape of the edited picture track with the following guidelines:
   - Choose the Film Rate (100%) option in the Digital Cut Tool.
   - Set the pulldown switch on the Video Slave Driver to 1.00.
   - If possible, match the timecode on the tape to the sequence timecode to make synchronization of the audio and video in AudioVision much faster.

   For more information, see “Recording: digital cut” in the online help index.

2. Choose Export from the File menu.

   The Export File Type dialog box appears.
3. Select OMFI Composition, and choose AudioVision from the first pop-up menu.

   The system automatically chooses the correct options for OMFI 1.0 and enables With Media.

4. Choose Audio Only from the second pop-up menu.

5. Depending upon how you marked the source material for export, click the Options button and adjust the export settings based on the following descriptions:

   - **Use Marks**: Instructs the system to use IN and OUT marks currently set in the selected media to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option.

   - **Use Enabled Tracks**: Instructs the system to export only the currently enabled tracks for a selected sequence during the
export. To export all tracks in the sequence, deselect this option.

6. Click OK to close the Export Settings dialog box and return to the Export File Type dialog box.

7. When all options are listed correctly, click OK.

A destination dialog box opens with a default file name in the Export As text box based on the file type.

8. (Option) Change the file name.

If you are transferring the files for use in a third-party application, keep the default extension to avoid conflicts. Also, avoid names that include spaces or special characters.

9. Select the destination folder for the file and click Save.

The sequence is exported.

The maximum file size that the Macintosh system allows is approximately 2 gigabytes. If you exceed this limit, the file is unusable and the system displays an error.

10. Close the Film Composer application and shut down the system.
11. Remove the drive or diskette containing the OMFI composition, and the drive containing the media files; then transport them to the AudioVision system.

For more information on the correct procedures for connecting and disconnecting drives, see the appropriate hardware guide.

For more information on transferring media files, see “Methods for Transferring Media Files” on page 298.

12. With the AudioVision system turned off, insert or connect the drives and boot the system.

13. Start the AudioVision application and import the composition. For more information, see the Avid AudioVision User’s Guide.

Occasionally, AudioVision stops importing and an “Out-of-memory” error message appears. This is because the OMF Interchange composition is too large, and needs to be exported from Avid Composer in smaller sections. For more information, see “Before You Begin” on page 275.


Transferring OMF Files to Pro Tools

You can use OMF Interchange to transfer audio tracks from Media Composer products to Pro Tools for audio sweetening. Considerations and procedures are described in the following sections:

- To decide whether to consolidate the source sequence before export, see “Choosing Whether to Consolidate Your Media Files” on page 284.

- To prepare the sequence for more effective export, see “Preparing Sequences for OMF Export” on page 272.

- To perform the transfer, see “Transferring a Project to Pro Tools” on page 285.
Choosing Whether to Consolidate Your Media Files

Before you export the sequence, you need to decide whether or not to consolidate your media files based on the following scenarios.

**Pro Tools and the Avid Composer System on the Same Computer**

If you are running Pro Tools and the Avid Composer system on the same computer, you do not need to consolidate your files. You can simply:

1. Shut down and reconnect the hard drive (with the audio files) from the Avid SCSI bus to the Macintosh SCSI bus.
2. Start up and open the Pro Tools session. Pro Tools looks for the associated audio files in the Avid Composer system OMFI Media-Files folder.

*Pro Tools will be able to play back audio files only from drives connected to the Macintosh computer’s SCSI bus.*

The advantage of this method is that you do not need to consolidate, convert, or copy media files, thereby saving time and effort. The disadvantage of this method is that you must move the hard drive from one bus to another.

**Pro Tools and the Avid Composer System on Different Computers**

If you are running Pro Tools and the Avid Composer system on different computers, you have two options for handling the media that is referenced in the sequence that you are converting.

- **Consolidate the media files**: Consolidating saves time and disk space by copying only the required media to a designated hard drive. In the process, the system creates smaller media files based on portions of clips used in the sequence.

*For more information on consolidating media files, see “Consolidating media” in the online help index.*
• **Copy or transport the media files manually from one system to another:** Copying media files to another drive or transporting the drives themselves to another system lets you avoid managing duplicate media files in different locations. If you simply move the files, however, either the OMF Tool or Pro Tools may present a Where Is dialog box to locate the media (by file name) after it has been copied. You are responsible for knowing the names of the specific media files.

  *For more information on transporting media files between systems, see “Methods for Transferring Media Files” on page 298.*

**Transferring a Project to Pro Tools**

To transfer a project to Pro Tools:

1. Select the material you want to export by following one of the procedures in step 1 in “Performing the Export” on page 251.

2. Choose Export from the File menu.

   The Export File Type dialog box appears.
3. Select OMFI Composition and choose SD2 from the first pop-up menu.

The system automatically enables the With Media option.

4. Choose Audio Only from the export tracks (second pop-up) menu.

Pro Tools does not support video media exported from the Avid Composer system.

5. Choose an option from the Version pop-up menu:

- Choose OMFI 2.0 if you are transferring to a newer Pro Tools system.
- Choose OMFI 1.0 if you are transferring to an older Pro Tools system that does not support OMFI 2.0.
• Choose OMFI 1.0 if you are not sure which version your system supports.

6. Depending on how you marked the source material for export, click the Options button and adjust the export settings based on the following descriptions:

• **Use Marks**: Instructs the system to use IN and OUT marks currently set in the selected media to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option.

• **Use Enabled Tracks**: Instructs the system to export only the currently enabled tracks for a selected sequence during the export. To export all tracks in the sequence, deselect this option.

7. Click OK to close the Export Settings dialog box and return to the Export File Type dialog box.

8. When all the options are listed correctly, click OK.

   A destination dialog box opens with a default file name in the Export As text box based on the file type.

9. (Option) Change the file name but keep the default file extension.

   *Keep the default extension to avoid conflicts. Also, avoid names that include spaces or special characters.*
10. Select the destination folder for the file and click Save.

   The file is exported and appears at the chosen destination.

11. Copy the OMF file from the Avid Composer system to the Pro Tools system and transfer the media files. For more information, see “Methods for Transferring Media Files” on page 298.

12. Use the OMF Tool to convert the exported OMFI file to a Pro Tools Session.

   For more information on acquiring and using the OMF tool, visit the OMFI Web site at: www.omfi.org

13. Open and save the Pro Tools Session in Pro Tools. For more information, see the Pro Tools documentation.

Using the Media Composer QuickTime Codec

You can speed the process of importing and exporting QuickTime files by using the Media Composer QuickTime codec when you intend to treat the files in a third-party application before reimporting them into Media Composer products. The following sections describe the codec and procedures for using it:

- To learn more about how the codec works, see “About the Media Composer QuickTime Codec” on page 289.
- To prepare a third-party application for working with Media Composer QuickTime files, see “Installing the Codec in QuickTime Applications” on page 290.

288
To review specifications for QuickTime export, see “QuickTime Specifications” on page 313.

To prepare a sequence for QuickTime export, see “Preparing to Export a Sequence” on page 250.

To perform the export, see “Exporting with the Media Composer QuickTime Codec” on page 290.

To perform an export from a third-party application, see “Exporting from a Third-Party QuickTime Application” on page 296.

About the Media Composer QuickTime Codec

This software-based codec creates encapsulated media files for quick export of high-resolution files that are readable within QuickTime applications also equipped with the codec.

Using the QuickTime codec usually involves maintaining the CCIR 601 standard video dimensions of the media (720 x 486 nonsquare pixels for NTSC, 720 x 576 for PAL) as well as large media file sizes. This codec might not be appropriate for some uses. For example, if the destination of your QuickTime-export is a multimedia title, you should use another appropriate codec such as Cinepak.

The codec allows you to maintain AVRs up to AVR 77. It also speeds the QuickTime import and export processes to a rate of approximately four times real time or better (depending on resolution). The codec provides a vast improvement over the standard QuickTime conversion, which can take as long as 300 times real time or more with full-size, high-resolution clips.

Media Composer QuickTime files can be quite large, depending on the AVR, and require adequate storage and transfer capacities.
Installing the Codec in QuickTime Applications

After you install Avid Composer Release 7.0 on your system, the new codec is automatically installed in the Extensions folder inside the System Folder. You can copy this extension and install it at other workstations where you are using QuickTime-compatible applications. Once the Media Composer codec is installed on the workstation, you can export files either from the Avid Composer system or from the third-party application for reimport into the Avid Composer system.

You can install the codec on either a Power Macintosh® or non-Power Macintosh system. To install the Media Composer codec on the system where the third-party application resides:

1. Drag the copy of the extension labeled Avid Codec onto the System Folder and release the mouse button.
   
   A dialog box asks if you would like to install the file in the Extensions folder.

2. Click OK.

3. Restart your system.

   The codec is installed.

If you are having trouble opening or playing the export in a third-party application, increase the memory allocated to the program.

Exporting with the Media Composer QuickTime Codec

To export with the Media Composer QuickTime codec:

1. Select the material you want to export by following one of the procedures in step 1 in “Performing the Export” on page 251.

2. Choose Export from the File menu.

   The Export File Type dialog box appears.
3. Select QuickTime and choose one of the following options from the pop-up menu:

- **Video and Audio**: Choose this option if, for example, you are using an entire clip or sequence in a multimedia project.

- **Video Only**: Choose this option if, for example, you are adding effects in a third-party application.

- **Audio Only**: Choose this option if, for example, you are using or enhancing audio in a third-party application.

After you select export file options, additional current options for the clip or sequence are listed in the lower-third region of the dialog box. The following is an example of a sequence selected for export as a QuickTime file.
4. If the additional options listed need correction, click the Options button in the Export File Type dialog box and select options in Export Settings dialog box based on the descriptions in Table 9-6.

### Table 9-6 Export Settings Options for the QuickTime Codec

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Marks</td>
<td></td>
<td>Instructs the system to use IN and OUT marks currently set in the selected media to determine starting and ending frames for the export. To export the entire clip or sequence, deselect this option.</td>
</tr>
<tr>
<td>Use Enabled Tracks</td>
<td></td>
<td>Instructs the system to export only the currently enabled tracks for a selected sequence during the export. To export all tracks in the sequence, deselect this option.</td>
</tr>
<tr>
<td>Use Both Fields</td>
<td></td>
<td>Select this option if you are exporting any of the two-field resolutions (AVR 70B to AVR 77, or AVR 12). This option exports both video fields for higher resolution.</td>
</tr>
<tr>
<td>Destination Size</td>
<td>720 x 486 (NTSC)</td>
<td>Full-screen, non-square-pixel dimensions according to CCIR 601 video standards. Use these dimensions, for example, when treating video footage in a third-party application before reimporting into Avid Composer.</td>
</tr>
<tr>
<td></td>
<td>720 x 576 (PAL)</td>
<td></td>
</tr>
<tr>
<td>Audio Output</td>
<td>Mono</td>
<td>Pans all tracks to center on export.</td>
</tr>
<tr>
<td></td>
<td>Stereo</td>
<td>Exports all even-numbered tracks to track 1 and all odd-numbered tracks to track 2.</td>
</tr>
</tbody>
</table>
Table 9-6  Export Settings Options for the QuickTime Codec

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Sample Rate</td>
<td>Native Rate</td>
<td>The native rate of the chosen audio media (44.1 kHz or 48 kHz).</td>
</tr>
<tr>
<td></td>
<td>22.254 kHz (Std Macs)</td>
<td>Half the sample rate of 44 kHz media for playback on standard Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>22.050 kHz (AV Macs)</td>
<td>Half the sample rate of 44 kHz media for playback on AV (Audio/Video enabled) Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>11.127 kHz</td>
<td>One-quarter the sample rate of 44 kHz media for playback on standard Macintosh models.</td>
</tr>
<tr>
<td></td>
<td>11.025 kHz</td>
<td>One-quarter the sample rate of 44 kHz media for playback on AV Macintosh models.</td>
</tr>
<tr>
<td>Audio Sample Size</td>
<td>8 bits</td>
<td>Exports an 8-bit audio sample size for use in third-party systems that do not support 16-bit; also used to minimize the data throughput requirements (for example to improve playback in multimedia projects).</td>
</tr>
<tr>
<td></td>
<td>16 bits</td>
<td>Exports a 16-bit audio sample size (currently the industry standard bit rate for digital audio).</td>
</tr>
<tr>
<td>Create Movie Preview</td>
<td></td>
<td>Creates a QuickTime poster (a still-image preview frame) for your movie (slows the export process).</td>
</tr>
<tr>
<td>Cross-Platform Movie</td>
<td></td>
<td>Creates a single-fork, cross-platform compatible movie that can be opened on both the Macintosh and the PC for use in cross-platform multimedia development.</td>
</tr>
<tr>
<td>Use Source Compression</td>
<td></td>
<td>Uses the current compression settings. When this box is checked, the Compression Settings button becomes disabled.</td>
</tr>
<tr>
<td>Compression Settings</td>
<td></td>
<td>Opens the Compression Settings dialog box. For more information, see Table 9-4. Also see the “Use Source Compression” option.</td>
</tr>
</tbody>
</table>
5. Click the Compression Settings button in the Export Settings dialog box and select options in the Compression Settings dialog box based on descriptions given in Table 9-7.

### Table 9-7 Compression Settings Options for the QuickTime Codec

<table>
<thead>
<tr>
<th>Option</th>
<th>Suboption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor</td>
<td>Media Composer</td>
<td>Creates encapsulated media files for quick export of high-resolution files that are readable within QuickTime applications also equipped with the codec. Exporting with the Avid codec does not cause loss in quality, because the codec maintains the identical media data. However, the quality cannot be better than the original resolution of the digitized media.</td>
</tr>
<tr>
<td>Quality</td>
<td></td>
<td>If you selected the Media Composer codec, when you click the quality slider and drag it, a dialog box allows you to select another AVR. If you change the AVR, when you click OK to close the Compression Settings dialog box, another dialog box allows you to decide whether to accept the new AVR or maintain the original AVR.</td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td>Choose 29.97 to maintain NTSC video frame-rate standards.</td>
</tr>
</tbody>
</table>

6. Click OK to close the Compression Settings dialog box and return to the Export Settings dialog box.

7. Click OK to close the Export Settings dialog box and return to the Export File Type dialog box.
8. When all options are listed correctly in the Export File Type dialog box, click OK.

A destination dialog box opens with a default file name in the Export As text box based on the file type.

9. (Option) Change the file name.

If you are transferring the files for use in a third-party application, keep the default extension to avoid conflicts. Also, avoid names that include spaces or special characters.

10. Select the destination folder for the file and click Save.

The file is exported and appears at the chosen destination.

The maximum file size that the Macintosh system allows is approximately 2 gigabytes. If you exceed this limit, the file is unusable and the system displays an error.

If a power failure or mishap occurs during the export process, the entire file is unusable. You need to repeat the export process.
Exporting from a Third-Party QuickTime Application

Exporting from a third-party QuickTime application using the Media Composer QuickTime codec and the default Avid Composer system frame size allows you to speed the process of importing back into the Avid Composer system to approximately three to four times real time (video only).

To export Avid Composer files from a QuickTime-compatible application for import (or reimport) into the Avid Composer system:

1. Make sure the Media Composer codec is installed in the System Folder’s Extensions folder.
2. Conduct the export procedure according to the manual included with the particular software.
3. In the standard QuickTime Create a Movie dialog box, select the Use Source Compression.

If you select another frame size, the Avid Composer system will not import the file quickly using the Media Composer codec.

4. Complete the export process according to procedures used by the particular software.

Transferring a Project to Another Avid Composer Product

This section describes basic steps for transporting files with a removable storage device.
Compatibility Requirements for Transfer

When you transfer a project to another Avid Composer system, make sure that:

- The memory allocation of the Avid Composer system is similar in both systems.
- The AVRs are compatible between systems.
- The release of the Avid Composer system on each system is compatible. See the *Avid Media Composer and Film Composer Release Notes* for a complete description of compatibility issues between releases.

Transferring the Project

The two basic methods for transferring projects between Avid Composer systems are:

- Back up the project files to a 3.5-inch diskette, and transport the media files on a removable storage device.
- Send sequences, clips, or entire projects over a high-speed network by using AvidNet.

For more information on using AvidNet, see the *AvidNet Peer-to-Peer Setup and User’s Guide*. If you would like to purchase AvidNet, contact your Avid sales representative.

To transfer a work in progress and associated media to another Avid Composer system:

1. (Option) Consolidate the media for the project onto an appropriate drive for transfer to the other system.
   - For more information on consolidating, see the user’s guide.
   - For more information on removable storage devices, see “Recommended Storage Devices” on page 299.
Do not rename the folders named OMFI MediaFiles located on the media drive. The target Avid Composer system uses the folder names to locate the media files.

2. Copy the project folder and any settings files you would like to maintain at the new location onto a 3.5-inch diskette. For more information, see "Backing up: project files" in the online help index.

3. Close the Avid Composer application and shut down your system.

4. Remove the drives containing the media, and take these and the 3.5-inch diskette to the new location.

5. With the system turned off at the new location, insert or connect the drives and boot the system.

6. In the Finder, copy the Project folder and any settings to the Avid drive. For more information about moving Avid Composer projects, see the user’s guide.

7. Start the Avid Composer application, open the project, and resume work.

The Avid Composer system will reconstruct the MediaFiles database the first time you launch the application to incorporate the new media into the system’s internal directory.

Methods for Transferring Media Files

The fastest methods for transferring media files between systems involve either transporting removable storage devices or sending your material over a high-speed network by using AvidNet. These methods and others are described in the following sections.
Recommended Storage Devices

The following is a list of storage devices, and related restrictions, to consider for the transfer of media files:

- **Removable hard drive (4 GB and 9 GB):** Both the Avid Composer system and the target system must have compatible RMAG XL or MediaDock chassis. Both systems should be running the same version (latest) of the AVIDdrive Utility.

- **Fixed hard drive (4 GB and 9 GB):** Both the Avid Composer system and the target system must have compatible device drivers. Both systems should be running the same version (latest) of the AVIDdrive Utility.

- **Avid DLT (digital linear tape) device:** Both the Avid Composer system and the target system must have compatible versions of AVID/MEZZO archive software.

If you are transferring media from striped drives (drives on which different parts of a file are stored in different partitions), make sure the other system supports striped drives. Check the Extensions folder for the AVIDstripe extension. See the *AVIDdrive Utility User’s Guide* for more information.

Using AvidNet

If your facility is equipped with AvidNet, you can simplify and speed the exchange of media between workstations by sending your material over a network by using the AvidNet Transfer Tool and the Media Inbox located in the Tools menu.

For more information on AvidNet, see the AvidNet Peer-to-Peer Setup and User’s Guide. If you would like to purchase AvidNet, contact your Avid sales representative.
**Other Network Transfer Methods**

Other methods of file transfer include:

- **AppleShare®**: You can transfer files between Macintosh systems by using Macintosh file sharing or an AppleShare server. See your Macintosh documentation for more information.

  From UNIX® systems to Macintosh systems, you can use programs such as Xinet® K-AShare™ to mount UNIX volumes on a Macintosh desktop.

- **Internet File Transfer Protocol (FTP)**: You can transfer files between networked systems using TCP/IP and FTP, including transfer from UNIX, PC, or other platforms. For transferring from Silicon Graphics systems to Avid Composer systems using Fetch, see the Avid Technical Note, “Using Fetch to Transfer OMF Files,” available through customer service.

**Exchanging Audio Media Files Between Systems**

You can transfer audio media files directly from the OMFI MediaFiles folder for use in any third-party application that supports the AIFF, AIFC, or Sound Designer II formats. See the online help index for more information on the following features.

- To identify the appropriate media files in the OMFI MediaFiles folder from clip in a bin, use the Reveal File feature.

- To convert some or all of the media files on a mixed project to either the Sound Designer II or AIFF format for direct transfer to a third-party application, choose the desired format when exporting the master clips from the bin.

- To copy the selected files quickly onto a target drive, use the Consolidate feature.

- To transfer the files, transport them on a recommended storage device.

- To transfer audio media files back into an Avid Composer product, use the import procedures.
You cannot transfer audio media files that have been altered in a third-party application directly into the OMFI MediaFiles folder on an Avid Composer system.

Import and Export Specifications

The following sections describe file export specifications and options you should observe in order to import any of the supported file types successfully with Media Composer products.

Supported File Types

Release 7.0 of the Media Composer products adds import and export support for 22 new graphics and animation file types, based on Host Independent Image Protocol (HIIP®). HIIP is Avid’s image translation technology that allows applications to be compatible with dozens of imaging standards in professional use.

In addition, Release 7.0 of the Media Composer products continues to support files types that were supported in previous releases, including PICT, Photo CD (import only), Chyron, PICS animation, PICT sequence, Alias, QuickTime, and OMF Interchange.

All file types are now supported for both import and export.

The following sections summarize each of the newly supported file types. For more information on file types that continue to be supported from previous releases, see the Avid Media Composer Products Reference.
Graphics File Types

The following image format file types apply to still graphics and images (see Table 9-8 for file type default extensions):

- **Alias**: Developed by Alias Research, Inc. (now Alias/Wavefront™), for use with their animation and visualization software.
- **BMP**: Developed by Microsoft Corporation as the standard image file format used by Microsoft Windows.
- **Chyron**: Developed by Chyron Corporation for use with video frame buffers of Chyron character generator titles.
- **Cineon**: Developed by Eastman Kodak for use in the Cineon Digital Film System. It is a subset of the SMPTE DPX (Digital Picture Exchange) format.
- **Framestore**: Developed by NewTek Incorporated for use with their Video Toaster™ system.
- **IFF**: Developed by Electronic Arts. IFF (Interchange File Format), or more specifically IFF-ILBM (InterLeaved BitMap), is the standard file format by which applications on the Amiga platform transfer image files.
- **JPEG**: Developed by the Joint Photographic Experts Group (JPEG). This format is highly suited for image storage and transmission purposes because of its ability to dramatically reduce the storage requirements for a file. JFIF files (JPEG File Interchange Format, the standard for constructing JPEG files) can also be imported and exported.
- **PCX**: Developed by Zsoft Corporation for use with their PC PaintBrush™ paint software.
- **Photo CD**: (import only) Developed by Kodak for use with the Kodak Photo CD storage medium.
- **Photoshop**: Developed by Adobe Systems Incorporated for use with their Adobe Photoshop image-editing software.
- **PICT**: Developed by Apple Computer, Inc. as the format for Macintosh QuickDraw® images.
- **Pixar**: Developed by Pixar for stored pictures.
- **PNG**: Developed by the PNG Development Group originally as an alternative to the GIF™ image format. PNG is an acronym for Portable Network Graphics and is pronounced “ping.”
- **QRT**: Used by many ray tracing programs, such as DKB Ray Trace and the QRT ray tracer.
- **Rendition**: Developed by Numerical Design Ltd.
- **SGI**: Developed by Silicon Graphics, Inc. for use as the standard format on their line of workstations.
- **SoftImage**: Developed by Softimage Inc. for use in their Softimage® software.
- **SunRaster**: Developed by Sun Microsystems, Inc. and is supported mainly in Sun® applications.
- **Targa**: Developed by Truevision, Inc. originally intended for support of the Truevision® image-capturing hardware.
- **TIFF**: Developed by Aldus Corporation (now Adobe Systems, Incorporated) and Microsoft Corporation. TIFF is an acronym for Tag Image File Format.
- **Wavefront**: Developed by Wavefront Technologies, Inc. (now Alias/Wavefront) for storing pictures in a machine-independent manner.
- **XWindows**: Developed by the MIT X Consortium, and is supported by many X Window System™ applications on workstations and some personal computers.
- **YUV**: Defined by Abekas Video Systems (now Scitex Digital Video, Inc.), the YUV format is the raw data sent to the Abekas® machines.
Animation File Types

The following file type applies to animation, movies, or sequenced still images:

- **ERIMovie**: This image format saves multiple sequences of images as 24-bit packed or 32-bit raw movie files.

Audio File Types

The following file types apply to audio:

- **Audio Interchange File Format (AIFF) (added for export; previously import only)**: you can now import and export audio tracks in the industry-standard Audio Interchange File Format developed by Apple Computer, Inc.

- **Sound Designer II (SD2) (added for export; previously import only)**: You can now import and export audio tracks in the native format of the Sound Designer II application developed by Digidesign, Inc. (now Avid Digidesign, Inc.).

  *Release 7.0 of the Media Composer products allows you to digitize, render, and edit audio in either AIFC (a variation of AIFF) or Sound Designer II media file formats.*

Clips and Sequences

The following file type applies to clips and sequences:

- **Editcam media (import only)**: You can easily import whole clips and sequences from the Ikegami Editcam for additional editing.
Graphics File Specifications

Use the specifications listed in Table 9-8 on page 307 when creating a graphics file for import into Release 7.0 of Media Composer products.

The following terms are used in Table 9-8 to describe specifications for import:

- **Full-screen image size:** These numbers describe the recommended width and height in pixels for creating a source image that displays full-screen after import. Using these dimensions helps minimize distortion after conversion to the Media Composer native resolution of 720 x 486 nonsquare pixels for NTSC, 720 x 576 for PAL. An image with smaller dimensions will take up less of the screen or will be distorted, while an image that exceeds these dimensions will be cropped or distorted. All images must have a resolution of 72 pixels per inch.

- **Bit depth:** These numbers refer to supported color-depth resolution of the image based on the number of bits per pixel. For example, 2-bit images display in black and white; 8-bit images display in 256 colors; 16-bit images display in thousands of colors; 24-bit images display in millions of colors; and 32-bit images display in millions of colors with an alpha channel.

- **Alpha channel:** This column states whether or not alpha channel import is supported in Release 7.0 of the Media Composer products. An alpha channel determines regions of transparency in the picture when it is keyed over a background.

- **NA:** means “not applicable.”
Preparing Files with a Third-Party Application

You can use third-party image-editing software, such as Adobe Photoshop, to make adjustments to an image file prior to import:

- You can convert most graphics files to the appropriate size, resolution, and bit-depth. You can also crop or color-correct an image.
- You can eliminate jagged edges in an image by using the application’s anti-aliasing or high-quality option.
- You can add transparency to some image file formats by setting the resolution to 32 bits per pixel to add an alpha channel.
- In some cases, you can convert an image file that does not support alpha channel to a format that does in order to add transparency.

You can also import and key the image over video by using key effects within the system or pick a transparent key color when you import the graphic. However, importing an image with an existing alpha channel provides the best results.

See the third-party software’s documentation for specific procedures and supported file types.
<table>
<thead>
<tr>
<th>File Type</th>
<th>Default Extensions</th>
<th>Recommended Full-Screen Size (Pixels)</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>.als</td>
<td>648 x 486 NTSC 1024x 768 PAL</td>
<td>24-bit color, 8-bit grayscale</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>BMP</td>
<td>.bmp</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>1-, 4-, 8-, and 24-bit</td>
<td>No</td>
<td>Dots-per-inch (DPI) information is preserved. Four-bit BMP files saved with RLE compression are not supported. Photoshop does not support four-channel BMP files.</td>
</tr>
<tr>
<td>Chyron</td>
<td>.chr</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>32 bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Cineon</td>
<td>.cin</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>10-bit (logarithmic)</td>
<td>NA</td>
<td>Dots-per-inch (DPI) information is preserved.</td>
</tr>
<tr>
<td>Framestore</td>
<td>.fs</td>
<td>Output from Video Toaster: 720 x 486 NTSC 720 x 576 PAL Otherwise, use recommended: 648 x 486 NTSC 1024 x 768 PAL</td>
<td>24-bit</td>
<td>No</td>
<td>Pixel aspect information is saved with image data. When importing files generated from Video Toaster, choose the option Force to Fit Screen. For more information, see “Import Settings” on page 243.</td>
</tr>
<tr>
<td>IFF</td>
<td>.iff</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>1-bit through 24-bit color; 1-bit through 8-bit grayscale; 64 color EHB; 4096 color HAM; 262,144 color HAM8; SHAM; A-HAM; A-RES</td>
<td>1-bit alpha only</td>
<td>Dots-per-inch (DPI) information is preserved. Pixel aspect information is saved with image data.</td>
</tr>
<tr>
<td>File Type</td>
<td>Default Extensions</td>
<td>Recommended Full-Screen Size (Pixels)</td>
<td>Bit Depth Support</td>
<td>Alpha Channel Support</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------</td>
<td>-------------------------------------</td>
<td>------------------</td>
<td>----------------------</td>
<td>-------</td>
</tr>
<tr>
<td>JPEG</td>
<td>.jpg</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>24-bit color, 8-bit grayscale</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>PCX</td>
<td>.pcx</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>Color-mapped and 24-bit color</td>
<td>NA</td>
<td>Dots-per-inch (DPI) information is preserved. PCX files with 1-bit color depth or odd-numbered pixel widths are not supported.</td>
</tr>
<tr>
<td>Photo CD</td>
<td></td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td></td>
<td>NA</td>
<td>If you are importing Photo CD files, you must install QuickTime software and a compatible QuickTime Photo CD driver. Most photo CD files are high resolution, and if the photo has a portrait orientation, the image will be automatically rotated upon import. Use a paint or image processing program to crop or resize the image before importing.</td>
</tr>
<tr>
<td>Photoshop</td>
<td>.psd</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>Grayscale, indexed color, RGB, and duotone variations</td>
<td>No</td>
<td>Duotone files are loaded as grayscale. Multichannel (greater than four channels) files are not supported.</td>
</tr>
</tbody>
</table>

*You must select the Single Frame Import As a Slide option in the Import Settings dialog box. See “Import Settings” on page 243.*

308
<table>
<thead>
<tr>
<th>File Type</th>
<th>Default Extensions</th>
<th>Recommended Full-Screen Size (Pixels)</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PICT</td>
<td>.pic</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>2-, 4-, 8-, 16-, and 32-bit</td>
<td>Yes</td>
<td>Dots-per-inch (DPI) information is preserved. If no DPI has been specified, 72 DPI is used.</td>
</tr>
<tr>
<td>Pixar</td>
<td>.pxr</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>24-bit, 36-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>.png</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>1-bit through 32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>QRT</td>
<td>.dbw</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>24-bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Rendition</td>
<td>.6rn</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>SGI</td>
<td>.rgb</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>8-bit or 16-bit grayscale; 8-bit grayscale plus 8-bit alpha channel; 24- and 48-bit color; 24-bit color plus 8-bit alpha channel; 64-bit (16 bits per component)</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
### Table 9-8 Graphics File Import Specifications (Continued)

<table>
<thead>
<tr>
<th>File Type</th>
<th>Default Extensions</th>
<th>Recommended Full-Screen Size (Pixels)</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SoftImage</td>
<td>.pic</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>24-bit plus 8-bit alpha</td>
<td>Yes</td>
<td>Pixel aspect information is saved with the image.</td>
</tr>
<tr>
<td>SunRaster</td>
<td>.sun</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>1-, 8-, or 24-bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Targa</td>
<td>.tga</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>8-, 15-, 16-, or 24-bit; 32-bit</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>.tif</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>8-bit color-mapped; 8-bit or 16-bit grayscale; 24- and 48-bit color; 24-bit color plus 8-bit alpha; 36-bit color plus 12-bit alpha; 42 bit color plus 14-bit alpha; 48-bit color plus 16-bit alpha</td>
<td>Yes</td>
<td>Dots-per-inch (DPI) information is preserved. The following types of files are not supported: Multichannel (greater than four channels) files; Group 3-compressed (fax) files; CMYK files with extra channels; and JPEG-compressed files. Four-channel files created from Avid Matador are imported as three-channel files.</td>
</tr>
<tr>
<td>Wavefront</td>
<td>.rla</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>32-bit and 64-bit</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Animation File Specifications

Use the specifications described in Table 9-9 for import into and export from Media Composer products.

*Media Composer assumes a 30-fps frame rate (25 fps for PAL). Film Composer assumes a 24-fps rate. Therefore, set the appropriate frame rate for the project (30 fps for NTSC, 25 fps for PAL, 24 fps for film) when you export from the third-party application.*

---

### Table 9-8 Graphics File Import Specifications (Continued)

<table>
<thead>
<tr>
<th>File Type</th>
<th>Default Extensions</th>
<th>Recommended Full-Screen Size (Pixels)</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>XWindows</td>
<td>.xwd</td>
<td>648 x 486 NTSC 1024 x 768 PAL</td>
<td>1-, 2-, 4-, 8-, 16, 24-, and 32-bit</td>
<td>No</td>
<td>Pixel aspect information (based on the video format) is saved with image data. When importing, choose the option Force to Fit Screen. For more information, see “Import Settings” on page 243.</td>
</tr>
<tr>
<td>YUV</td>
<td>.yuv</td>
<td>720 x 486 NTSC 720 x 576 PAL</td>
<td>24-bit</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

---

311
<table>
<thead>
<tr>
<th>File Type</th>
<th>Default Extension</th>
<th>Bit Depth Support</th>
<th>Alpha Channel Support</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERIMovie</td>
<td>.mov</td>
<td>24-bit packed and 32-bit raw movie files</td>
<td>Yes</td>
<td><strong>On the Windows platform, the default extension is the same as that used for QuickTime for Windows files. Double-clicking an ERIMovie file will launch the application associated with QuickTime files, which cannot handle ERIMovie files. Avoid double-clicking ERIMovie files to view them.</strong></td>
</tr>
<tr>
<td>PICS Animation</td>
<td>.pcs</td>
<td>2-, 4-, 8-, 16-, and 32-bit</td>
<td>Yes</td>
<td>Name each file in the sequence NameN.ext, with Name identifying the animation, N indicating the file order, and .ext indicating the file type (for example, Image1.PIC, Image2.PIC, Image3.PIC). The numbering can start at any number except zero or use any numbering format (for example, Image010.PIC, Image012.PIC, or Imagef28.PIC, Imagef29.PIC).</td>
</tr>
<tr>
<td>Sequenced image files</td>
<td>Various</td>
<td>Yes</td>
<td>Name each file in the sequence NameN.ext, with Name identifying the animation, N indicating the file order, and .ext indicating the file type (for example, Image1.PIC, Image2.PIC, Image3.PIC). The numbering can start at any number except zero or use any numbering format (for example, Image010.PIC, Image012.PIC, or Imagef28.PIC, Imagef29.PIC).</td>
<td></td>
</tr>
</tbody>
</table>
QuickTime Specifications

Specifications in Table 9-10 apply when using QuickTime files with Media Composer products.

<table>
<thead>
<tr>
<th>QuickTime File Import Specifications</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime files</td>
<td>For QuickTime import and export, you must install QuickTime software, Version 1.5 or later. Avid recommends Version 2.0 or later.</td>
</tr>
<tr>
<td>Media Composer QuickTime files</td>
<td>The Media Composer QuickTime codec can import and export QuickTime files at a rate of three to four times real time. To use the codec in a third-party application, install the codec in the System Folder’s Extensions folder. See “Using the Media Composer QuickTime Codec” on page 288.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Use Export settings to determine the Avid Video Resolution of a QuickTime export. For more information, see “Export Settings” on page 259. The AVR of a QuickTime import is determined when you export from a third-party QuickTime application equipped with the Media Composer QuickTime codec. For more information, see “Using the Media Composer QuickTime Codec” on page 288.</td>
</tr>
<tr>
<td>Image Size</td>
<td>To take advantage of the Media Composer QuickTime codec speed, you must export the files from the QuickTime application at one of the following frame sizes: Release 5.6 of Media Composer products and earlier: - 640 x 480 pixels for NTSC images (square pixels) - 640 x 576 pixels for PAL images (square pixels) Release 6.0 of Media Composer products and later: - 720 x 486 pixels for NTSC images (nonsquare pixels) - 720 x 576 pixels for PAL images (nonsquare pixels)</td>
</tr>
<tr>
<td>File extension</td>
<td>After you import a QuickTime file, the file maintains the .mov extension, which is visible in a bin. This is also the default extension on export.</td>
</tr>
</tbody>
</table>
OMF File Specifications

Check the documentation for the application you are importing from for specific information on preparing OMF files.

Use the specifications in Table 9-11 when creating an OMF file for import into Media Composer products.

Table 9-11  OMF Interchange File Specifications

<table>
<thead>
<tr>
<th>OMF File Import Specifications</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVR</td>
<td>For fastest import of AVR media, set the resolution in the Import Settings dialog box to the AVR that is in the OMF file, so that the Avid Composer system does not try to convert the media. Simple OMF tools that report the AVR of an OMF file are available on the OMFI Web site (<a href="http://www.omfi.org">http://www.omfi.org</a>). To optimize your import speed and quality, export from the source application at the AVR that your Avid Composer project is expecting.</td>
</tr>
<tr>
<td>Edit rate</td>
<td>You must import sequences and clips to projects that have the same edit rate (30 fps for NTSC, 25 fps for PAL, 24 fps for film). If the edit rates do not match, you will get an error message.</td>
</tr>
</tbody>
</table>
Release 6.5 and later of Media Composer products supports both OMFI 1.0 (composition and media) and OMFI 2.0 (composition) files. Media Composer products now supports the following OMF 2.0 effects:

- Video effects: dissolves, wipes, freeze-frame, film pulldown, slow motion, fade to black
- Audio effects: pan and volume, audio dissolves

The Avid Composer system automatically recognizes if a file is formatted as OMFI 1.0 or 2.0 and imports it appropriately.

Additional effects will be supported in future releases. See the release notes for your Media Composer product for current details.

<table>
<thead>
<tr>
<th>OMF File Import Specifications</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| OMFI version                  | Release 6.5 and later of Media Composer products supports both OMFI 1.0 (composition and media) and OMFI 2.0 (composition) files. Media Composer products now supports the following OMF 2.0 effects:  
- Video effects: dissolves, wipes, freeze-frame, film pulldown, slow motion, fade to black  
- Audio effects: pan and volume, audio dissolves  

The Avid Composer system automatically recognizes if a file is formatted as OMFI 1.0 or 2.0 and imports it appropriately. Additional effects will be supported in future releases. See the release notes for your Media Composer product for current details. |
| Film pulldown                 | To import audio media into the Avid Composer system, you must have the pulldown switch set to 1.0. |
| Audio sample rate             | Audio media is imported at the sample rate that is set on the Avid Composer system. |
| MCXpress for Windows NT files | If you are importing OMF compositions from MCXpress for Windows NT, you may get an error if the sequence includes video or audio effects. If so, create a cuts-only version of the sequence in MCXpress and export it again. You cannot import video media from MCXpress for Windows NT; if you import a composition, you must redigitize the media. |
| Avid Media Fusion             | OMF compositions and audio import correctly from Avid Media Fusion, but OMF 2.0 video media (RGBA or CDCI) currently does not. |
| File transfer                 | If you are transferring an OMF file over a network, transfer it as a binary file. |
| Reimporting Media Composer media files | If you import OMF files that contain media you exported from the same Media Composer system, you need to delete the original media. Otherwise, the new media will not overwrite the original media. |
## Editcam File Specifications

The specifications in Table 9-12 apply to transfer and import of media captured with an Ikegami Editcam. The Editcam is a Digital News Gathering (DNG) camera that uses Avid CamCutter technology.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported resolutions</td>
<td>AVR 70B, AVR 75B. When you select AVR 70 (or AVR 75) and then digitize, the files will be digitized, as well as listed in the bin, as AVR 70B (or AVR 75B).</td>
</tr>
<tr>
<td>Editcam file structure</td>
<td>Editcam bins store only master clips. Editcam sequences are stored in separate files called sequence playlists. Editcam media files are comparable to media files in Media Composer products.</td>
</tr>
<tr>
<td>Access to the files</td>
<td>Load an Avid FieldPak containing the Editcam media into an Avid Desktop FieldPak Adapter that is connected to the system or available over a network. For information about setting up and using the Avid Desktop FieldPak Adapter, see the Avid Desktop FieldPak Adapter Setup and User’s Guide.</td>
</tr>
<tr>
<td>FieldPak restrictions</td>
<td>You cannot rename, delete, or overwrite the clips on the FieldPak with the Avid Composer system and adapter.</td>
</tr>
<tr>
<td>Import conversion</td>
<td>When you import an Editcam sequence playlist, the Avid Composer system converts the sequence to a Composer sequence and puts it in the target bin.</td>
</tr>
<tr>
<td>Conversion of unsupported events</td>
<td>A sequence playlist can contain events, such as live events, that are not supported by Avid Composer products. When you import a sequence playlist that contains one of these events, the Avid Composer system replaces the event with black filler and a locator, when possible. If an unsupported event is located at the end of a sequence, the system drops the event and does not add filler because the Composer software does not allow filler at the end of a sequence.</td>
</tr>
</tbody>
</table>
CHAPTER 10
Intraframe Editing

This chapter describes the Intraframe™ Editing option. This option includes the Paint effect and the AniMatte™ effect. The Paint effect and the AniMatte effect share many of the same concepts, which are introduced in the following sections.

- **Editing with Intraframe Capability**
- **Using an Optional Pen Tool**
- **Using Single-Field Step**
- **Rendering Intraframe Effects**
- **Applying the Paint Effect to a Sequence**
- **Applying an AniMatte Effect to a Sequence**
- **Working with the Intraframe Editing Interface**
- **Using Effect Templates with the Intraframe Effects**
- **Working with Intraframe Editing Parameters**
- **Working with Vector-Based Objects**
- **Using the Paint Tools**
- **Moving and Manipulating Painted Objects and Mattes**

Using the Paint and AniMatte effects is described in Chapter 11.
Editing with Intraframe Capability

While many of the tools and parameters are the same for the Paint effect and the AniMatte effect, the result of applying each effect is different. The Paint effect enables you to paint an object directly on an individual frame or series of frames (a segment of a sequence or subsequence). The AniMatte effect enables you to draw a matte on one or more frames to create multilayer matte keys and single-layer organic matte wipes.

With Intraframe editing, you can remove and edit defects, such as dropouts and scratches, that appeared on the original source videotape or film footage. Intraframe editing frees you from having to export images from the Avid Composer system, edit them in third-party applications, and import them back into the system.

Intraframe editing offers many creative possibilities. On individual frames, you can draw various shapes, paint brushstrokes, and create freehand objects or mattes, which you can reshape, rescale, move, and adjust the color values of to meet your needs.

When you use the Intraframe Editing tools, the Avid Composer system draws vector-based objects on the screen. Vector-based objects are composed of mathematically described lines and Bezier curves. You can edit the lines, curves, and other attributes of vector-based graphics with greater control and efficiency than you can with bitmapped objects, which are drawn on the screen as a pattern of dots, or pixels.

Additionally, any changes you make to a Paint or AniMatte effect is not limited to an individual frame. Instead, any object you paint and any changes you make to it appear for the duration of the entire segment or clip. In most cases, you can change the parameters of the effect between key frames.
Using an Optional Pen Tool

The Avid Composer system supports the addition of a pen tool and graphics tablet for use with the Intraframe Editing option. For installation and configuration instructions, see the documentation that ships with your pen tool and tablet.

Using Single-Field Step

Single-field step allows you to view field 1 and field 2 of each frame of video. This feature is especially useful for locating a defect on a specific field and using an effect to correct it. Any effect edits you make affect both fields of each frame.

When you enter Effect mode, the tracking display above the Effect Preview monitor indicates the currently displayed field by adding “.01” to the tracking number for the first field, or “.02” for the second field.

To step through the footage one field at a time, press the Option key and click either the Step Forward button or the Step Backward button. As you step, the tracking number updates to reflect the currently displayed field.

Rendering Intraframe Effects

When you paint an object or draw a matte on a single frame in a sequence, the Avid Composer system applies the effect to the entire segment. While working in Effect mode, you can see the object as you step through each frame in the segment. To view the painted object in Source/Record mode, enable Render-On-The-Fly in the Special menu.

You also can use the Play Preview function to see an off-speed preview of a Paint effect while you are working in Effect mode. For more infor-
mation, see “Effect Editor Buttons” in the Media Composer and Film Composer Effects Guide.

Intraframe effects are not real-time effects. When you have finished painting or drawing a matte on a segment, you must render the effect to play it in real time. Regardless of how many objects you add to an individual segment, the Avid Composer system plays back the effect as a single stream of video.

**Rendering Paint Effects**

Painted objects are rendered to the screen starting with the bottom layer (closest to the video background). Keep this concept in mind as you use different paint modes in combination and layer painted objects to generate new effects in a sequence. You also can combine the Paint effect with AniMatte effect to create custom effects.

**Rendering AniMatte Effects**

A multitrack AniMatte effect is rendered to the screen starting with the top video track (farthest from the video background and appearing closest to you in three-dimensional space). For example, if the video background is on V1, and the AniMatte effect is applied to V2, the system renders the effect starting with the image on V2.

However, if you draw multiple mattes in the same segment, these mattes are all objects that appear in the same foreground space; they interact with each other much like multiple painted objects do in the same segment. For more information, see “Layering Objects and Matte Keys” on page 375.

Keep these concepts in mind as you use different key modes in combination and layer them to generate new effects in a sequence. You also can combine the AniMatte effect with the Paint effect to create custom effects.
Applying the Paint Effect to a Sequence

A Paint effect is a segment effect only. You cannot apply a Paint effect to a transition in a sequence.

You access the Paint effect by clicking the Paint Effect icon from the Image category in the Effect Palette and dragging it to a segment in a sequence.

To apply a Paint effect to a sequence:

1. Load a sequence into the Record monitor.
2. Open the Effect Palette by choosing Effect Palette from the Tools menu.
3. Click the Image category.
4. Click the Paint Effect icon and drag it to a segment in the sequence, and release the mouse button.
5. Enter Effect mode by clicking the Effect Mode button.
   The Effect Editor appears with the default Paint effect settings.

Applying an AniMatte Effect to a Sequence

You can apply an AniMatte effect to segments and transitions in a sequence. Which method you choose depends on the effect you are trying to create.

When you are working with multiple tracks of video, you can apply the AniMatte effect as a segment effect to key in or key out selected areas of an image or to build an organic matte wipe. You also can apply the AniMatte effect to a transition to create a wipe between two adjacent shots in the same video track (single stream of video).

The AniMatte effect is accessible through the Key category in the Effect Palette.
To apply an AniMatte effect to a sequence:

1. Load a sequence into the Record monitor.

2. Open the Effect Palette by choosing Effect Palette from the Tools menu.

3. Click the Key category.

4. Click the AniMatte Effect icon and drag it to a segment or transition in the sequence, and release the mouse button.

5. Enter Effect mode by clicking the Effect Mode button.

   The Effect Editor appears with the default AniMatte effect settings.

**Working with the Intraframe Editing Interface**

Most of the functions that you need to create and apply finishing touches to the Intraframe effects appear in the Effect Editor. Menu options also provide another method of accessing some of these functions. For more information on working with the Effect Editor, see “Using the Effect Editor” in the Media Composer and Film Composer Effects Guide.

When you apply a Paint or AniMatte effect to a segment and enter Effect mode, the Effect Editor appears. The cursor is an arrow when you select tools and options from the Effect Editor. When you select a paint or editing tool and position the cursor over the Record monitor, the cursor becomes a crosshair. The crosshair indicates that you can begin to paint or draw a matte on the frame.

> After you use the Rectangle, Oval, Polygon, and Curve Tools, the Avid Composer system reverts to the Selection Tool, and the cursor becomes an arrow. After you use the Brush Tool, it remains the active tool, and the cursor remains a crosshair.
The painting and editing tools enable you to paint shapes or draw mattes, quick masks, and other vector-based objects on frames in a sequence. When you apply an Intraframe effect to a segment, the object or matte appears for the duration of the entire segment, not just for an individual frame.

The Effect Editor also includes tools for manipulating painted objects and mattes, playback buttons, and collapsible panes. Each collapsible pane contains a category of parameters you can use to modify the appearance of an Intraframe effect. To open an effect category, click the triangle next to the category name or double-click the category name.
Using the Effect Editor with the Paint Effect

The following illustration identifies the different sections of the Effect Editor that are available when you apply a Paint effect to a segment and enter Effect mode.
Table 10-1 briefly describes the functions of the Effect Editor for the Paint effect.

**Table 10-1  Intraframe Editing Elements**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect parameter categories</td>
<td>Enable you to change the parameters of an effect.</td>
</tr>
<tr>
<td>Brush Template buttons</td>
<td>Change the shape of the brush.</td>
</tr>
<tr>
<td>Brush Preview window</td>
<td>Displays the brush head with the parameters you have selected, such as color, softness, and shape. You also can use the window to reshape the brush head by dragging its control points.</td>
</tr>
<tr>
<td>Grid parameter category</td>
<td>In film projects only, provides localized control of the Grid Effect parameters and access to the Grid dialog box.</td>
</tr>
<tr>
<td>Add Key Frame button</td>
<td>Adds a key frame to an effect at the location of the position indicator in the effect’s Timeline.</td>
</tr>
<tr>
<td>Play Preview button</td>
<td>Plays back a preview of an unrendered effect in the Record monitor.</td>
</tr>
<tr>
<td>Render Effect button</td>
<td>Renders effects on selected tracks at the location of the position indicator in the effect’s Timeline.</td>
</tr>
<tr>
<td>Outline/Path button</td>
<td>Displays wire-frame representations of effects in a sequence. Illustrates the movement of an effect from the first key frame through the last key frame.</td>
</tr>
<tr>
<td>Grid button</td>
<td>Displays a grid for precise placement of effects in the image and for the snap-to-grid function.</td>
</tr>
<tr>
<td>Transition Effect Alignment</td>
<td>Enables you to choose whether a transition effect starts, ends, or is centered on a cut; not applicable to the Paint effect.</td>
</tr>
<tr>
<td>Transition Effect Duration</td>
<td>Enables you to enter the length of a transition in seconds and frames; not applicable to the Paint effect.</td>
</tr>
<tr>
<td>Painting and Editing Tools</td>
<td>Enable you to paint shapes or draw mattes on frames in a sequence with freehand capability or with preset shapes.</td>
</tr>
</tbody>
</table>
The following illustration shows the Effect Editor as it appears when you apply an AniMatte effect to a segment in a video project and enter Effect mode.

### Table 10-1  Intraframe Editing Elements (Continued)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previsualization Marker Tool</td>
<td>In film projects only, enables you to add markers that track the path of an effect based on the coordinates provided when you activate the Grid.</td>
</tr>
<tr>
<td>Bring Forward and Send Backward buttons</td>
<td>Brings a painted object <em>one</em> layer forward on the screen or sends an object <em>one</em> layer backward on the screen. With the Option key pressed, brings a painted object to the front or sends an object to the back.</td>
</tr>
<tr>
<td>Reshape Tool button</td>
<td>Reshapes objects by manipulating anchor points at locations where new curves begin or straight lines intersect. Inserts additional control points.</td>
</tr>
<tr>
<td>Z-Rotation Tool button</td>
<td>Rotates an object around the Z axis.</td>
</tr>
<tr>
<td>Selection Tool button</td>
<td>Selects an object so you can change its parameters, move it, or delete it. With the Shift key pressed, selects multiple objects.</td>
</tr>
<tr>
<td>Reduce and Enlarge buttons</td>
<td>Reduces or enlarges the screen.</td>
</tr>
<tr>
<td>Dual Split button</td>
<td>Splits the screen in half to show the image with and without effects applied to it.</td>
</tr>
<tr>
<td>Play Loop button</td>
<td>Plays back a transition or a segment effect in Effect mode.</td>
</tr>
</tbody>
</table>
When you are working with an AniMatte effect, the categories that are available in the Effect Editor are the same as those for the Paint effect with the following exceptions:

- The Reverse option in the Foreground category enables you to swap the foreground and background video images for matte keys composed of multiple video tracks. When you are building a single-track wipe, the Reverse button enables you to swap the incoming and outgoing segments in the sequence.

- With the AniMatte effect, you use Magic Mask to choose a key color when you create a matte. (With the Paint effect, you use Magic Mask or the Color category to make color selections.)
Using Effect Templates with the Intraframe Effects

As you can do with many other effects, you can save a template of a Paint or AniMatte effect and apply it to other video segments in a sequence at a later time. For more information on saving and applying an effect template, see “Using an Effect Template” in the Media Composer and Film Composer Effects Guide.

Working with Intraframe Editing Parameters

The outcome of applying a Paint effect to a sequence is different from the result of applying an AniMatte effect to a sequence. However, many of the parameters available to both effects function similarly. The following sections describe how to work with the parameters that are common to both the Paint effect and the AniMatte effect.

For information on these parameters, see Chapter 11.

Using the Selection Tool

The Selection Tool is one of the most frequently used tools. You use this tool to select a painted object or matte on the screen when you want to make changes to it. After you select an object, you can move it in the frame, rescale it, and change its parameters.

To select an object, choose the Selection Tool and click an object. Selection handles appear around the object.
To select multiple objects, Shift-click the additional objects with the Selection Tool, or click and drag the cursor to draw a lasso around the objects. When you select multiple objects, one set of selection handles appears around all the objects, which enables you to move, rescale, or otherwise change the parameters of all the selected objects simultaneously.

Global and Key-Frame Parameters

The Paint effect is divided into two logical groups:

- Global parameters that apply to all key frames
- Key-frame parameters that can change on an individual key-frame basis
Global Parameters

Global parameters cannot change between key frames. When you change one of these parameters, the Avid Composer system automatically sets the value for all key frames in the segment. The following global parameters cannot change between key frames:

- Acceleration
- Paint Modes
- Layering
- Lock and Unlock
- Group and Ungroup

Key-Frame Parameters

All the effects in this category can change between key frames. This category includes the remainder of the Paint effect parameters, including:

- Opacity (in Mode category)
- Feathering (all parameters in category)
- Magic Mask (all parameters in category)
- Color (all parameters in category)
- Brush (all parameters in category)
- Z-Rotation
- Scaling (size)
- Shape of the object
- Position of the effect in the frame or relative to the frame
Opacity

Opacity, which appears in the Mode category, refers to the transparency level of:

- A painted object created with the Paint effect
- The image within the border of a matte or wipe created with the AniMatte effect

You can adjust the level of opacity for individual key frames in a segment. When you establish different values of opacity for adjacent key frames, the opacity level is interpolated from the first key frame to the next key frame in the segment.

For the Paint effect, a level of 0 makes a painted object completely transparent; a level of 50 makes an object 50 percent transparent; and a level of 100 makes an object opaque.

For the AniMatte effect, a level of 0 makes a keyed image completely transparent; a level of 50 makes a keyed image 50 percent transparent; and a level of 100 makes a keyed image opaque.

For example, if you create a matte that keys out a rectangular portion of a segment on V2, the image on V1 defaults to 100 percent opacity (opaque) and appears in the matte key without any traces of the image on V2. If you adjusted the opacity to 50, the image on V1 would be blended with the image on V2. Adjusting the opacity to 0 would make the image on V1 completely transparent and show only the image from V2 within the borders of the matte.

To adjust opacity, do one of the following:

- Drag the Opac. slider to attain the desired value.
- Click the Opac. slider, and use the keyboard to enter a value from 0 to 100.
Object Visibility

The Object Visible button in the Mode parameter pane enables you to add a key frame to a segment or transition and have a painted object or matte suddenly “pop” onto the screen at the position marked by the key frame. You must have at least three key frames for an Intraframe effect to create this effect.

To pop a painted object or matte key onto the screen:

1. Paint an object with the Paint effect or draw a matte with the AniMatte effect on a segment or transition.
2. Select the object with the Selection Tool.
3. Drag the position indicator to the position in the effect’s Timeline where you want the object to pop onto the screen, and click the Add Key Frame button.
   
   There must be at least one more key frame in the segment or transition following the one you created in step 3.
4. Click the Object Visible button if it is not selected already.
5. Click the previous key frame to select that key frame, and then
deselect the Object Visible button.

6. Repeat steps 1 to 5 for each object you want to pop onto the screen.

You can perform this procedure on different objects, or mattes in a segment or transition, to create an effect in which the objects or mattes pop onto the screen at the intervals and positions you determine.

**Feathering**

Feathering adds soft edges to a painted object or a matte key. Adding a soft edge can make a compositing object look more natural against the background. Feathering softens edges by diffusing the border of the object by the pixel width you want.

To adjust the feathering:

1. Select an object or matte with the Selection Tool.
   If you do not select an object, the feathering values will be applied to the next object you create.

2. Click the triangle next to Feathering if the Feathering category is not open.

3. Adjust the Bias, Anti-alias, and Horizontal and Vertical parameters as described in the following sections.
Bias

The Bias slider in the Feathering category increases control over the dissipation of pixels around the edges of a painted object or matte. When you are applying a Paint effect, adjusting bias is especially effective when you trace an element on the screen.

A Bias setting of 0 feathers pixels starting at the outside edge; a setting of 50 starts feathering at the center portion of the edge; and a setting of 100 starts feathering at the inner portion of the edge. The default setting for Bias is 50.

To adjust the Bias, do one of the following:

- Drag the Bias slider to attain the desired value.
- Click the Bias slider, and use the keyboard to enter a number from 0 to 100.

Horizontal and Vertical Parameters

The Horiz and Vert sliders enable you to choose the dominant direction in which feathering of an object or matte appears.

Increasing the Horizontal parameter extends feathering in both the positive and negative directions along the X axis (right to left and left to right on the screen). The minimum horizontal value is 0 pixels; maximum horizontal feathering is achieved by choosing a value of 255 pixels.

Increasing the Vertical parameter extends feathering in both the positive and negative directions along the Y axis (upward and downward on the screen). The minimum vertical value is 0 pixels; maximum feathering is achieved by choosing a value of 255 pixels.
To adjust the Horiz or Vert sliders:

- Drag either the Horiz or Vert slider to attain the desired value.
- Click either the Horiz or Vert slider, and use the keyboard to enter a number from 0 to 255.

**Fixed Aspect**

The Fixed Aspect parameter gangs the Horiz and Vert sliders together. When you drag one of the sliders, the other slider moves in unison with the first slider. The Fixed Aspect button toggles the option on or off.

*When you enable the Fixed Aspect option, horizontal is the dominant value.*

**Anti-Aliasing**

You also can select Anti-alias in the Feathering category, which decreases the jagged appearance of an object’s borders. Anti-aliasing smooths the object’s edges and can improve its image quality. You can use anti-aliasing in combination with feathering. The Anti-alias button toggles the option on or off.

**Acceleration**

Acceleration adjusts the effect’s speed over time by having the effect ease in and ease out. This gives the effect a more natural appearance. The Acceleration parameter applies to the entire effect, not to specific key frames. For more information on adjusting the Acceleration, see “Adjusting the Acceleration” in the *Media Composer and Film Composer Effects Guide.*
**Brush**

The Brush parameters enable you to define the shape, size, and softness of the brush for creating brushstrokes on an image. Additionally, you can customize the shape and rotate the head of the Brush Tool to create a variety of new effects.

The parameters in the Brush category apply only to the Brush Tool.

The Brush category includes Path, Soft, and Size sliders, a Spin slider for adjusting the rotation of the brush head, templates for preset brush head shapes, and a Preview window for previewing the custom brush head you create. You can apply the parameters described in this section in any order you like.

**Path**

The Path slider controls the percentage of paint or the matte that is visible from the initial point of pressure to the completion of the brushstroke. Path values range from 0 (no paint visible) to 100 (opaque).

As you paint on a segment, the object always appears opaque. Unlike the other Paint Effect parameters, you adjust Path after you have finished painting the object.
Using Path to Create a Signature Effect

The Path parameter is useful for creating a “signature” effect with the Paint effect, in which a signature gradually appears on the screen as if written with an invisible pen.

To create the signature effect:

1. Apply the Paint effect to a segment.
2. Click the Brush Tool button if the brush is not already active.
3. Choose Solid from the Mode Fast menu.
4. Click and drag the cursor on the Record monitor to paint a signature or other string of text.
5. Release the mouse button when you are satisfied with the appearance of the text.
6. Click the first key frame in the segment to select it.
7. Select the painted object if it is not selected already.
8. Click the Path slider, enter 0 by using the keyboard, and click Return.
9. Click the last key frame in the segment to select it.
10. Click the Path slider, enter 100 by using the keyboard, and click Return.

Alternatively, you can add key frames at different locations in the effect’s Timeline and change the percentage of the Path parameter at each key frame to modify how the effect appears over the course of the segment.

11. Render the Paint effect to play it back in real time.
Soft

The Soft slider adjusts the softness of the brush head. Softness ranges from a value of 0 (hard center) to 100 (softest overall head).

To adjust the softness:

1. Click the Brush Tool button if the brush is not already active.
2. Do one of the following:
   - Drag the Soft slider to attain the desired value.
   - Click the Soft slider, and use the keyboard to enter a value from 0 to 100.

Size

You can use the Size slider to adjust the size of the brush head. Size is measured in terms of pixel width. The widths range from 0 to 100 pixels.

To adjust the brush head size:

1. Click the Brush Tool button if the brush is not already active.
2. Do one of the following:
   - Drag the Size slider to attain the desired value.
   - Click the Size slider, and use the keyboard to enter a value from 0 to 100.

   The new size of the brush head is reflected in the Brush Preview window.

Shape

The Brush templates enable you to choose from a variety of preset shapes. Clicking one of the buttons changes the brush head to the new shape.
To adjust the shape of the brush head:

1. Click the Brush Tool if the brush is not already active.
2. Click the desired template.
   The shape is reflected in the brush head in the Brush Preview window.

**Creating a Custom Brush Head from a Template**

You can change the brush head to a custom shape by modifying the brush head in the Brush Preview window.

To create a custom brush head:

1. Click the Brush Tool if the brush is not already active.
2. Click a template that will provide the basis for your custom brush head.
   The template is displayed as the brush head in the Brush Preview window.
3. Click the brush head in the Brush Preview window.
   Anchor points appear on the brush head where curves merge or straight lines intersect.
4. Click an anchor point and drag it to change the shape of the brush head.
5. Repeat step 4 with other anchor points as needed.
For brush shapes with rounded edges and curves, such as the oval, the ellipse, and the circle, clicking an anchor point creates direction bars and handles that enable you to edit the Bezier curve. For information on working with Bezier curves, see “Working with Vector-Based Objects” on page 342. You can use the direction bars and handles to edit the template’s curves, and you can drag the object’s control points. However, you cannot use the variations that can be activated with the modifier keys on the keyboard.

Spin

The Spin slider enables you to rotate the brush head 360 degrees in the clockwise and counterclockwise directions. The range of clockwise rotation is from 0 to −360 degrees, and the range of counterclockwise rotation is from 0 to 360 degrees. The default position for the brush head in the Brush Preview window is 0.

To rotate the brush head:

1. Click the Brush Tool if the brush is not already active.
2. Click the button for the template as needed. The shape is reflected in the brush head in the Brush Preview window.
3. Do one of the following:
   - Drag the Spin slider to the right (clockwise rotation) or to the left (counterclockwise rotation) to rotate the brush head.
   - Click the Spin slider, and use the keyboard to enter a value from −360 to 360.
**Saving a Brush Template**

You can save a template of a custom brush to a bin so that you can reuse the parameters of the brush with a Paint or AniMatte effect at a later time.

To save the brush template:

1. Click the Brush Template icon in the Brush category and drag it to a bin.

   ![Brush Template icon](image)

   A brush template appears in the bin, and the name of the template defaults to Brush.

2. Click the name of the template in the bin, enter a unique name for the template, and click Return.

3. To use the template at a later time, click the template in the bin, drag it onto the Brush Preview window, and release the mouse button.

4. The brush in the Brush Preview window assumes the same parameters as the brush template you saved to the bin.
Working with Vector-Based Objects

Before you begin working with the paint and editing tools included in the Paint and AniMatte effects, you must understand the basics of working with vector-based objects and Bezier curves. The vector-based graphics technology of the Intraframe Editing option enables you to create and edit objects and mattes with a precision that you cannot achieve when you work with bitmapped objects. Vector-based objects are not subject to problems such as artifacting when you rescale them.

The Elements of Vector-Based Objects

The objects you paint, the matte keys you draw, and the brush templates that appear in the Brush Preview window include a control point at the midpoint of each line or curve, also known as a join. The portion of the line or curve on each side of the control point is called a segment. The control point controls the direction of each segment as it passes through the join.

Control points for a painted object are visible when you select an object with the Selection Tool and then click the Reshape Tool button. Also, when you click a brush template in the Effect Editor, the brush head displays visible control points in the Brush Preview window.
A painted object can have three types of joins that describe its shape:

- The straight-edge join
- The smooth join
- The corner join

A control point associated with a smooth join or a corner join describes a Bezier curve. Clicking a control point makes it the active join. Tangents called direction bars appear on each side of the control point associated with a Bezier curve. At the end of each direction bar is a direction handle. Dragging a direction handle changes the way the segments pass through the control point to define the curve.

When you drag a direction handle, you change the height and angle of the curve. The curve responds as if you were gently tugging it like a piece of string. The segments remain anchored to the control points on either side of the active join.
In contrast, straight-edge joins do not display direction bars and handles when you click them. To reshape an object composed of one or more straight edges:

- Select the object with the Selection Tool, click the Reshape Tool, and then drag one or more control points. For information on manipulating control points, see “Moving a Control Point” on page 352.
- Convert straight-edged joins to Bezier curves, and manipulate the curves as described in the following sections.

Getting Started with Bezier Curves

If you have never worked with Bezier curves, learning how to work with them requires a willingness to experiment. As you practice working with Bezier curves, you will gain greater control over painted objects and mattes, and the process will become more intuitive. The following sections describe how to paint a rectangular object with the Paint effect and use the Reshape Tool to convert corners into Bezier curves. You then will modify the curves to change the shape of the object.

Transforming a Rectangle into a Circle

To create a rectangle and transform it into a circle with Bezier curves:

1. Apply the Paint effect to a segment in a sequence and enter Effect mode.

2. Click the Rectangle Tool button in the Effect Editor.

3. Choose Solid from the Fast menu in the Mode category.

4. Click and drag in the Record monitor to paint a rectangular object. Do not worry about picking a color or other parameters for this exercise.
5. Click the Selection Tool button and select the object you just painted.

6. Click the Reshape Tool button or double-click the object.
   Notice that each corner of the rectangle displays a control point.

7. Control-click the control point at the top left corner of the rectangle.
   Notice that the straight-edge join becomes a smooth join with direction bars and handles.

8. Working in a counterclockwise direction, Control-click each control point until they have all been transformed into smooth joins.
   The resulting shape is a circle. The control point at the top right of the circle is the active join and displays direction bars and handles.
Experimenting with Direction Handles

To experiment with the direction handles:

1. Click the bottom direction handle and drag away from the control point to increase the length of the direction bar.

   Notice how the curve changes. Also, the direction bar and segment on the opposite side of the control point move in unison with the direction bar you are dragging. The control points adjacent to the active join serve as anchor points for the segments that compose the curve.

2. Drag the direction handle toward the control point to shorten the direction bar.
Notice how the curve changes as you shorten the direction bar.

3. Control-click the direction handle and drag it away from the control point.

Notice that the length of the direction bar on the opposite side of the control point does not change; this prevents the height of its associated segment from changing. However, the opposite direction bar does move in unison with the direction handle you are dragging, thereby changing the angle of the segment in unison.

4. Control-click the direction handle to revert the direction bars to their previous functionality.
5. Click the bottom direction handle and drag it in a counterclockwise direction.
Notice how the curve changes as you drag the direction bar.

![Diagram of a curve being manipulated](image)

6. When you have finished experimenting, adjust the direction bar so that the object again resembles a circle.

**Creating a Corner Join**

The painting tools do not create corner joins by default; you can change an existing smooth join into a corner join as described in this section. Also, if you want to transform a straight-edge join into a corner join, you must transform the straight-edge join into a smooth join first.

To transform a smooth join into a corner join:

1. Option-click the bottom direction handle.

   Although you might not notice it immediately, the smooth join is transformed into a corner join.
2. Drag the direction handle *away* from the control point.

Notice how the active segment behaves as you lengthen the direction bar. The direction bar and segment on the opposite side of the control point do not move in unison with this direction handle. Also, notice that the active segment remains anchored to the adjacent control point.

3. Drag the direction handle in a counterclockwise direction.

Notice how the segment changes as you drag the direction bar.

4. When you are finished experimenting, Option-click the direction handle.

The control point reverts to a smooth join.
Modifying Lines and Curves Summarized

Table 10-2 summarizes how you can modify lines and Bezier curves (smooth joins or corner joins) by using the mouse and the modifier keys on the keyboard.

### Table 10-2  Methods of Modifying Lines and Curves

<table>
<thead>
<tr>
<th>Illustration</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Straight-edge join" /></td>
<td>Transform a straight-edge join into a smooth join.</td>
<td>Control-click the control point. To change it back to a straight-edge join, Control-click the smooth join.</td>
</tr>
<tr>
<td><img src="image" alt="Smooth join" /></td>
<td>Smooth join: Drag one direction handle so that the direction bar on the opposite side of the control point moves and changes length in unison.</td>
<td>You do not have to press any of the modifier keys. Click and drag one of the direction handles.</td>
</tr>
<tr>
<td><img src="image" alt="Direction handle" /></td>
<td>Smooth join: Drag one direction handle so that the direction bar on the opposite side of the control point moves in unison but does not change in length.</td>
<td>Control-click a direction handle. To change it back, Control-click the direction handle.</td>
</tr>
</tbody>
</table>
When you paint a freehand object to mask, colorize, or otherwise modify an image in a frame, you can achieve extraordinary precision when you know how to control Bezier curves. Being able to visualize curves and where you need to place their associated control points before you begin painting can make the process of tracing shapes easier.

The following tools paint new objects that are composed of Bezier curves:

- Oval Tool
- Polygon Tool
- Curve Tool
For information on how to use these tools to paint new objects with Bezier curves, see the description for each tool in the section “Using the Paint Tools” on page 355. Keep in mind that you are not limited to using these tools to create curved objects because you can transform the straight-edge joins in any painted object into Bezier curves. See “Modifying Lines and Curves Summarized” on page 350.

Moving a Control Point

If a control point is not in the desired location, you can move it. Table 10-3 describes how you can change the shape of an object by moving its control points.

Table 10-3  Methods of Moving a Control Point

<table>
<thead>
<tr>
<th>To move</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>A control point freely</td>
<td>Drag the control point to its new location. The control point’s direction bars do not change orientation.</td>
</tr>
<tr>
<td>Multiple control points</td>
<td>Click one control point, and then Shift-click or lasso additional control points that you want to move. (Press ⌘-A to select all control points.) Drag one of the selected control points. All other selected control points move in unison.</td>
</tr>
</tbody>
</table>

Adding a Control Point

Placing more control points on an object enables the object to trace more detailed images. For example, if a segment of an object does not follow a curved section on a frame as well as you would like, and adjusting the control points and direction bars do not help, you can add a new control point.
To add a control point:

1. Select the object with the Selection Tool button.
2. Click the Reshape Tool button or double-click the object.
3. Click the selected object where you want to add a new control point.

A new control point appears and is calculated so that the original object, as you drew it, does not change dramatically in shape. The new control point appears as part of the object for all key frames in the segment.

Any changes you make to a control point, such as moving it or changing the angle of the associated curve, affects the key frames you have selected in the segment. If you change a control point at a selected key frame or add a key frame to make changes, the changes are interpolated between the selected key frame and adjacent key frames.

Moving to Adjacent Control Points

You can move from a control point to an adjacent control point without having to click the mouse. To use this feature, you must map the Fast Forward and Rewind buttons to your keyboard or a user-selectable button palette.

To move to an adjacent control point:

1. Select a control point.
2. Click Fast Forward to move in a clockwise fashion to the next control point, or click Rewind to move in a counterclockwise fashion to the next control point.
Moving Control Points and Objects in Small Increments

You can “nudge” one or more control points or an entire object in small increments by pressing and holding the Option key as you press one of the four arrow keys on your keyboard. You can use this feature to move any object or control point that is currently selected.

The Effect Preview monitor must be the active window for this feature to work. Additionally, if you have changed the default behavior of the arrow keys on your keyboard by remapping these buttons, this feature might not function properly.

Removing a Control Point

Avid recommends that you remove a control point from an object if the object does not need the control point to adequately define its shape. It is better to have fewer control points and to manipulate the direction bars to gain the same effect because more control points mean more work if you need to modify an object later.

To remove a control point, click the control point and press Delete. You also can Shift-click multiple control points and then delete them.
The Avid Composer system attempts to reconstruct the object so that it does not change when you remove a control point. The results you see might vary because of the internal mechanics and geometry of Bezier curve technology. However, adding and then removing the same control point should not dramatically change the curve of that section of an object.

**Using the Paint Tools**

The Paint effect and the AniMatte effect include the following six paint tools:

- Brush Tool
- Rectangle Tool
- Oval Tool
- Polygon Tool
- Curve Tool
- Previsualization Marker Tool for film projects

You can use these tools for creating preset shapes or for painting with freehand capability to create vector-based objects and mattes with editable lines and Bezier curves. Additionally, the Selection Tool enables you to select painted objects and mattes to move them, rescale them, and change their parameters.

**Brush Tool**

With the Brush Tool, you can use the mouse or a pen tool with a tablet to paint objects or mattes with precision directly on the images in a sequence. You also can change and customize the brush shape, as well as determine the opacity of the paint or matte, adjust the outline feathering and softness values, and, for the Paint effect, define the color.
For the Paint effect, the Brush Tool includes twenty-one styles called *modes* that offer many creative and corrective possibilities. Available modes include solid (for traditional brushstrokes), erase, clone, colorize, emboss, and more.

The AniMatte effect provides the Key In and Key Out modes. These modes enable you to key in or key out an image in a sequence.

For more information on the characteristics of each paint mode, see “Paint Modes” on page 387. For more information on the Key In and Key Out modes, see “Key Modes” on page 405.

To paint an object with the Brush Tool:

1. Click the Brush Tool button in the Effect Editor.
2. Select a paint mode or key mode and parameters in the Effect Editor.
3. Position the cursor where you want to begin painting in the frame.
4. Press and hold the mouse button to begin painting.
5. Release the mouse button to complete the painted object.
6. Adjust the object’s parameters if needed.

For information on the shortcut method of selecting a color for the Brush Tool, see “Shortcut for Selecting a Color with the Brush Tool” on page 390.

**Rectangle Tool**

With the Rectangle Tool, you can paint rectangular shapes or mattes on images in a sequence. All the paint modes and parameters in the Effect Editor are accessible to the Rectangle Tool with the exception of the Brush category.
To paint with the Rectangle Tool:

1. Click the Rectangle Tool button in the Effect Editor.
2. Select a paint mode or key mode and parameters in the Effect Editor.
3. Position the cursor where you want to begin painting in the frame.
4. Press and hold the mouse button and drag the cursor to create the rectangle.
   As you drag, you describe the diagonal of the rectangle. For example, if you drag to the right and in a downward fashion, the rectangle is anchored to its upper left corner.

5. Release the mouse button to complete the rectangle.
6. Adjust the object’s parameters if needed.

**Oval Tool**

With the Oval Tool, you can paint oval shapes or mattes on images in a sequence. All the paint modes and parameters in the Effect Editor are accessible to the Oval Tool with the exception of the Brush category.

To paint with the Oval Tool:

1. Click the Oval Tool button in the Effect Editor.
2. Select a paint mode or key mode and parameters in the Effect Editor.
3. Position the cursor where you want to begin painting in the frame.
4. Press and hold the mouse button and drag the cursor to create an oval.

As you drag, you describe the diameter of the oval. For example, if you drag to the right and in a downward fashion, the oval is anchored to its upper left corner.

5. Release the mouse button to complete the oval.

6. Adjust the object’s parameters if needed.

**Polygon Tool**

With the Polygon Tool, you can paint a variety of geometric objects and trace images in a frame. All the modes and parameters in the Effect Editor are accessible to the Polygon Tool with the exception of the Brush category. You can use the Polygon Tool to create objects and mattes composed of straight-line segments, curved segments, or a combination of both.

To take full advantage of the power of the Polygon Tool, you should be familiar with the concepts behind vector-based graphics. If you are not familiar with these principles, see “Working with Vector-Based Objects” on page 342 for more information.

It is helpful to visualize the shape and the position of the polygon within the frame before you begin painting. By visualizing the object first, you will gain more control over the objects’s attributes when you edit it later.
The general workflow for working with the Polygon Tool is:

1. Visualize the object you want to create.
2. Determine a location in the frame to begin painting and click that location to create the initial control point.
3. Click additional control points as you continue to define the shape of the object.
4. Double-click to create the final control point or click the initial control point to create the closed polygon.

*Try to create the object with as few control points as possible. Fewer control points will eliminate more work if you need to modify the object later.*

**Creating Polygons with Straight-Line Segments**

To create a polygon with straight-line segments:

1. Click the Polygon Tool button in the Effect Editor.
2. Select a paint mode or key mode and parameters in the Effect Editor.
3. Click in the frame where you want to place the initial control point.
4. Click in the frame where you want to place the next control point.

A straight-line segment is drawn between the initial control point and the control point you just created.

5. Click in the frame to create additional control points that further define the shape of the object.

A straight-line segment appears between each pair of adjacent control points.
6. When you are satisfied with the shape of the object, double-click in the frame to create the final control point or click the initial control point. The object becomes a closed polygon.

7. Adjust the parameters of the polygon if needed.
Creating Polygons with Curved Segments

To create a polygon with curved segments:

1. Click the Polygon Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect Editor.

3. Click in the frame where you want to place the initial control point, and release the mouse button.

4. Drag the cursor to the location where you want to place the next control point.

5. Click *and hold* the mouse button to begin creating the first curved segment.

   Direction bars with handles appear as a tangent to the curved segment. The cursor “leads” the direction handle that you will use to determine the direction and height of the curve.

6. Drag the cursor, which is attached to the direction handle, to adjust the direction and height of the curved segment.
7. Release the mouse button when you are satisfied with the height and angle of the curved segment.

8. Drag the cursor to the next location where you want to create a curved segment.

9. Repeat steps 3 to 8 to create additional curves if needed.

10. When you are satisfied with the shape of the object, double-click in the frame to create the final control point or click the initial control point.

The object becomes a closed polygon.

11. Adjust the parameters of the polygon if needed.

**Creating a Straight Line Following a Curve**

To create a straight line following a curved segment:

1. Create one or more curved segments as described in “Creating Polygons with Curved Segments” on page 362.

2. Drag the cursor to the location where you want to begin painting the straight line.
3. Click and then release the mouse button to create the control point.

4. Drag the cursor to the location where you want the straight-line segment to end.

5. Click and then release the mouse button to create the control point.

6. Continue to create additional lines and curves.

7. When you are satisfied with the shape of the object, double-click in the frame to create the final control point or click the initial control point.

The object becomes a closed polygon.
8. Adjust the parameters of the polygon as desired.

Curve Tool

With the Curve Tool, you can trace curved objects with freehand capability. All the paint modes and parameters in the Effect Editor are accessible to the Curve Tool with the exception of the Brush category.

To paint with the Curve Tool:

1. Click the Curve Tool button in the Effect Editor.
2. Select a paint mode or key mode and parameters in the Effect Editor.
3. Position the cursor where you want to begin painting in the frame.
4. Press and hold the mouse button and drag the cursor as you paint a freehand curved shape on the frame.
5. When you are satisfied with the shape of the object, release the mouse button to complete the curved object.
6. Adjust the object’s parameters if needed.
Previsualization Marker Tool for Film Projects

The Previsualization Marker Tool enables you to place a Marker effect in a segment that represents an effect that will be processed at an optical facility. This tool is applicable to 24-fps projects only and appears in the Effect Editor only when you are working in a film project with the Paint effect.

When you create an optical list, each Marker, along with its positions in the segment in terms of key frames and color values, appears as an optical event. The editor at the optical facility can refer to the event as a cue for creating a visual effect, such as a rotoscoped object.

For example, the optical editor’s assignment is to create an airplane that flies through the scene. He can use the key-frame information from the optical list to plot the exact path of the effect as it moves through the scene. The Marker’s position at each key frame is described with coordinates derived from the Effect Grid. Position is described in terms of compass coordinates (N, S, E, and W for North, South, East, and West) and X, Y coordinates.

Additionally, you can add multiple Markers to a single scene to represent different effects, and you can establish a unique color for each marker. The resulting optical list will display each Marker and its unique color values, which enables the optical editor to distinguish each Marker.
Applying the Marker Effect

To add a Marker effect to a segment:

1. Enable the Effect Grid and set the appropriate parameters for image scan size, aspect ratio, and film format.
2. Click the Previsualization Marker Tool button in the Effect Editor.
3. Adjust the sliders in the Color category to determine the color of the Marker.
4. Position the cursor at the location in the frame where you want to place the Marker, and click the mouse.
5. Use key frames to move the Marker throughout the segment.
6. To add more Markers, repeat steps 2 to 5.

For information on key frames, see “Using Key Frames” in the Media Composer and Film Composer Effects Guide.
Creating a Cut List with Effect Grid Information

This example shows how to move a Marker through an effect and save the result in a cut list. You could do the same thing with an object you draw using the Paint effect or a matte you create using the AniMatte effect.

To create a cut list that contains the Effect Grid information for the Marker effect:

1. Choose Cut List from the Output menu.
   The Cut List Tool appears.

2. Select the following options:
   a. Choose Get Sequence and select the sequence.
   b. Select the appropriate video tracks.
   c. Select Optical and choose Key Frames as the source data.
3. Choose View.

The Avid Composer system displays the cut list. The following illustration shows an example cut list.

```
<table>
<thead>
<tr>
<th>Key</th>
<th>Frame Footage Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>0-00</td>
</tr>
</tbody>
</table>

Transfer: Full Aperture
Grid: Anamorphic
Fields: 12
Subfields 4
Scan Size: (X: 720, Y: 243)

Marker 1 (R: 255, G: 0, B: 6)
  (x: 50, w: 100) (X: 37, Y: 172)

(2) 100-11
Marker 1 (R: 255, G: 0, B: 6)
  (x: 20, e: 30) (X: 45, Y: 101)

(3) 220-04
Marker 1 (R: 255, G: 0, B: 6)
  (x: 72, e: 11) (X: 590, Y: 49)
```

Moving and Manipulating Painted Objects and Mattes

The Paint and AniMatte effects include editing tools and additional parameters that enable you to perform the following operations on painted objects and mattes:
Reshape Tool

The Reshape Tool enables you to modify the shape of a painted object or matte on the screen. You also can change the shape of an object over time by making changes to the object on an individual key-frame basis. For information on working with key frames, see “Using Key Frames” in the Media Composer and Film Composer Effects Guide.

To reshape objects you paint, you should be familiar with the concepts of vector-based graphics. For more information, see “Working with Vector-Based Objects” on page 342.

Selecting an Object or Matte with the Reshape Tool

To reshape a painted object or matte:

1. Select an object or matte with the Selection Tool.

2. Click the Reshape Tool button in the Effect Editor or double-click the selected object.

The outline of the object becomes highlighted, and control points appear at the midpoint of each straight line and curve.
If you want to drag the control points only, you can Option-click the Reshape Tool button to hide the direction handles.

Changing the Shape of an Object or Matte with the Reshape Tool

To edit an object or matte with the Reshape Tool:

- Click and drag one or more of the object’s control points. For information on moving control points, see “Moving a Control Point” on page 352.

- Edit the object by manipulating the direction bars at one or more control points. For information on editing straight-line segments and curved segments, see “Modifying Lines and Curves Summarized” on page 350.

Editing Objects and Mattes Created with the Curve Tool

The default behavior of control points in an object or matte created with the Curve Tool differs slightly from those created with the Polygon Tool. When you drag one of the direction handles, the direction bar on the opposite side of the control point moves in unison but the length does not change in unison. The dimensions of the curved segments on each side of the control point are not equal because the
Curve Tool creates curves with freehand capability, not with a mathematical formula that describes a Bezier curve in the way that the Polygon Tool does.

You can transform the direction bars at a control point so that their lengths change in unison when you drag one of the direction handles. To do so, Control-click one of the direction handles. For more information, see “Modifying Lines and Curves Summarized” on page 350.

**Z-Rotation**

With the Z-Rotation Tool, you can select an object or matte and rotate it around the Z axis (clockwise or counterclockwise direction). You also can change the rotation of an object over time by rotating the object on an individual key-frame basis.

For an illustration of Z-rotation, see “Rotation — Rotating an Effect” in the Media Composer and Film Composer Effects Guide.

To rotate an object or matte around the Z axis:

1. Click the Z-Rotation Tool button in the Effect Editor.
2. Click the object you want to rotate.

   The object outline becomes highlighted, and a rotation handle appears within the object.
The X on the rotation handle marks the default center of the Z axis for the object. You can click the X and drag it anywhere on the screen to change the center of the object’s rotation.

3. Click the rotation handle and drag the mouse to rotate the object in either a clockwise or a counterclockwise direction.

**Scaling Paint Objects and Mattes**

You can rescale any object or matte that you create. Rescaling increases or decreases all dimensions of the object proportionately.

To rescale an object or matte:

1. Click the Selection Tool button in the Effect Editor.
2. Click the object you want to rescale.
   
   The object outline becomes highlighted, and four selection points appear around the object.
3. Rescale the object by using one of the following methods:
   
   - Click and drag any of the selection points.
Dragging toward the center of the object decreases the overall size, while dragging away from the center increases the overall size. When you drag a selection point, the object is anchored by the selection point that is diagonal to the one you are dragging.

- Option-click and drag any of the selection points to rescale the object using the center of the object as the anchor.
Moving Painted Objects

The Selection Tool also enables you to drag objects or mattes around the screen and in relation to the screen when you zoom out from a frame. You also can animate the object over time by changing the object’s position on an individual key-frame basis. For more information on using key frames, see “Using Key Frames” in the Media Composer and Film Composer Effects Guide.

To move a painted object or matte:

1. Click the Selection Tool button in the Effect Editor.
2. Click the object you want to move.
   The object outline becomes highlighted, and four selection points appear around the object.
3. Click the center of the object and drag it to a new location.
4. Release the mouse button when the object is positioned in the desired location.

Layering Objects and Matte Keys

The methods for moving painted objects forward and backward are described in the following sections.

Layering with the Paint Effect

When you paint on a frame, the paint appears as an object in the foreground, seeming closer to you in three-dimensional space than the video frame. You can change the parameters of each painted object independently, including the object’s orientation in relation to another object. For example, if you have three painted objects, you can stack or cascade them over each other to create three separate layers of objects in the foreground.
All compositing of painted objects takes place in the foreground and is not destructive to the video background. Keep in mind that when you composite various Paint effects on a frame, the Avid Composer system renders the Paint effects to the screen beginning with the bottom layer.

Layering with the AniMatte Effect

Layering works similarly for matte keys, but the image that appears in the foreground is the video that you have chosen to key in or key out. Even though matte keys are rendered by the Avid Composer system starting with the highest track in a multilayer matte key, compositing of multiple AniMatte effects in the same segment occurs in the foreground and is not destructive to the video background.

Using the Outline/Path button to Locate Layered Objects and Mattes

You can use the Outline/Path button to locate an object or matte that might be obscured by others on the screen. The Outline/Path button creates a wire-frame representation of each object, which enables you to locate, select, and manipulate the desired object. Clicking the Outline/Path button toggles the Path on or off.

To locate objects or mattes with the Path function:

1. Click the Outline/Path button in the Effect Editor. Each object painted on the frame appears as a wire frame.
2. Select an object and change its location or parameters.
3. Click the Outline/Path button to return to normal viewing mode.
Bringing Objects and Mattes Forward by One Layer

You can use the Bring Forward function to bring a single object or matte forward by one layer (appearing closer to you in three-dimensional space).

To bring an object or matte forward by one layer:

1. Select an object on the screen with the Selection Tool.
   
   If the object is obscured by other objects, use the Outline/Path feature to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.

2. Click the Bring Forward button, or choose Bring Forward from the Object menu.

3. The object moves one layer forward in the foreground.

Sending Objects and Mattes Backward by One Layer

You can use the Send Backward function to send a single object or matte backward by one layer (appearing farther away from you in three-dimensional space).

To send a painted object or matte backward by one layer:

1. Select an object on the screen with the Selection Tool.
   
   If the object is obscured by other objects, use the Path function to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.

2. Click the Send Backward button, or choose Send Backward from the Object menu.

3. The object moves one layer backward into the layers of objects that appear in the foreground.
Bringing Objects and Mattes to the Front

You can use the Bring To Front function to bring a single object or matte to the front of the foreground layers (appearing closest to you in three-dimensional space).

To bring a painted object or matte to the front:

1. Select an object on the screen with the Selection Tool.
   If the object is obscured by other objects, use the Path function to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.

2. Option-click the Bring Forward button, or choose the Bring To Front option from the Object menu.

3. The object becomes the top layer in the foreground.

Sending Objects or Mattes to the Back

You can use the Send To Back function to send an object or matte to the bottom layer in the foreground (appearing farthest away from you in three-dimensional space).

To send a painted object or matte to the back:

1. Select an object on the screen with the Selection Tool.
   If the object is obscured by other objects, use the Path function to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.

2. Option-click the Send Backward button, or choose the Send To Back option from the Object menu.

3. The object becomes the bottom layer in the layers of painted objects that make up the foreground.
Grouping and Ungrouping Objects or Mattes

The Avid Composer system enables you to group objects or mattes so that they behave as a single object. You then can move the new group and change its parameters as if it were a single object. If you want to separate the group and revert to working with the individual objects, you can do so by using the UnGroup function.

To group and ungroup painted objects or mattes:

1. Select an object on the screen with the Selection Tool.
   If the object or matte is obscured by other objects, use the Path function to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.
2. Shift-click any additional objects you want to include in the group.
3. Choose Group from the Object menu.
   The objects become grouped together, and you can manipulate the group as if it were a single object.
4. To ungroup the objects, select the group and choose UnGroup from the Object menu.

You also can group together groups of objects. If you then select the new group and choose UnGroup, all objects become ungrouped completely.

Locking and Unlocking Objects and Mattes

The lock feature allows you to lock an object or a group in place on the screen. When you lock an object, the Avid Composer prevents you from moving the object accidentally while you add more effects and make additional edits to your sequence. At any time, you can unlock the object to resume moving it in the frame.
To lock and unlock a painted object or matte:

1. Select an object or group on the screen with the Selection Tool.
   
   If the object is obscured by other objects, use the Path function to locate it as described in “Using the Outline/Path button to Locate Layered Objects and Mattes” on page 376.

2. Choose Lock from the Object menu.
   
   The object is locked at its current position.

3. To unlock the object, select the object and choose Unlock from the Object menu.
CHAPTER 11

Using the Paint and AniMatte Effects

This chapter includes information on how to get started with the Paint and AniMatte effects and describes parameters that are specific to these effects. Before you begin reading this chapter, read Chapter 10 to familiarize yourself with basic Intraframe Editing concepts and techniques.

- Using the Paint Effect
- Using the AniMatte Effect
Using the Paint Effect

The Paint effect enhances the creative and corrective powers of the Avid Composer system by providing the following features:

- Customizable paint brushes with preset templates and parameters for adjustable softness and rotation
- Creation of vector-based objects that you can animate and edit
- A variety of paint modes including Erase, Clone, Colorize, Darken, Lighten, Blur, Unsharp Mask, Emboss, and more
- Object selection with rescale, lock/unlock, and group/ungroup capabilities
- Z-rotation of painted objects
- Outline feathering with bias control
- Magic Mask for quick and easy colorization
- Previsualization of painted objects in a film project for improving effects processing at the visual effects facility

Getting Started with the Paint Effect

The Avid Composer system provides twenty-one painting styles (modes) and a variety of painting tools and options. This section briefly describes how to use the Brush Tool and how to adjust the Paint effect parameters to get you started with the Paint effect.

When you paint an object in a sequence, you paint on the frame displayed in the Record monitor. The painted object is superimposed over the video background, appearing closer to you in three-dimensional space. Each object you paint creates a foreground layer that you can work with individually or group with other painted objects in the segment.
Painting with the Brush

To begin painting:

1. Apply the Paint Effect to a segment in the sequence as described in “Applying the Paint Effect to a Sequence” on page 321.

2. Click the Brush Tool button to activate the Brush Tool.

3. Click one of the Brush Shape buttons in the Brush parameter pane of the Effect Editor.

4. Position the cursor over the image in the Record monitor.

   Notice that the cursor becomes a crosshair.

5. Click and drag to paint freehand style on the video background.

6. Release the mouse button when you have finished painting the object.
Painting Using Different Effect Parameters

To experiment with painting objects using different parameters:

1. Apply the Paint effect to a segment in the sequence as described in “Applying the Paint Effect to a Sequence” on page 321.

2. Click the Brush Tool button to activate the Brush Tool.

3. Click one of the Brush Shape buttons in the Brush parameter pane of the Effect Editor.

Notice that the brush head in the Brush Preview window appears with control points where curves or straight lines meet.

4. Click and drag the control points to create a custom shape for the brush head.

5. Position the cursor over the Record monitor, and click and drag to paint an object on the screen.

6. Release the mouse button when you have finished painting the object.

7. Drag the Size slider to adjust the size of the brush head in the Brush Preview window.

8. Drag the Spin slider to rotate the brush head to a new position.

9. Drag the Soft slider to adjust the softness of the brush.
10. Position the cursor over the image in the Record monitor, and then paint a new object on the screen. Paint the new object anywhere you want on the screen, including on top of any previously painted objects.

11. Release the mouse button when you have finished painting the object.

**Changing the Parameters of a Painted Object**

To change the parameters of an object you already have painted:

1. Click the Selection Tool button to activate it, and click an object you already have painted.

   The Avid Composer system outlines the object and displays four selection handles for the object.

2. To move the object, click anywhere *within* the outline and drag the object to a new location.
3. To rescale the object, click and drag any one of the selection handles.

4. Click the triangle next to the Color category.

5. Drag the Hue, Sat, and Lum sliders to change the color of the object.

6. Click the triangle next to the Feathering category.

7. Drag the sliders in the Feathering parameter pane to change the edge feathering.

8. Press the Delete key to delete the object.

9. To undelete the object, choose Undo from the Edit menu.

**Paint Effect Parameters**

Many of the parameters you use with the Paint effect function similarly with the AniMatte effect. Chapter 10 includes complete descriptions of these common parameters. The following sections describe parameters that are specific to the Paint effect.
Paint Modes

The Paint effect provides twenty-one modes that you can use to paint with a variety of styles. When you click a painting tool for the first time, the default setting is Solid mode, which enables you to paint an opaque object on the video background with a brushstroke.

To change the paint mode:

1. Select an object with the Selection Tool. If you do not select an object, the paint mode will be applied to the next object you create.
2. Click the triangle next to Mode if the Mode parameter pane is not open already.
3. Choose a mode from the Mode Fast menu.

When you finish painting, the mode you have chosen becomes the new default paint mode.

Table 11-1 briefly describes the characteristics of each mode.

Table 11-1  Paint Mode Descriptions

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid</td>
<td>Applies paint as an opaque object superimposed on the video background.</td>
</tr>
<tr>
<td>Erase</td>
<td>Removes paint from a frame.</td>
</tr>
<tr>
<td>Outline</td>
<td>Creates an outline that is useful for tracing images in a frame.</td>
</tr>
<tr>
<td>Clone</td>
<td>Duplicates an area from a frame and applies it to another area of the frame.</td>
</tr>
<tr>
<td>Colorize</td>
<td>Changes the tint in a selected area to the foreground color.</td>
</tr>
<tr>
<td>Mode</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hue</td>
<td>Changes the hue in a selected area to the foreground color without affecting</td>
</tr>
<tr>
<td></td>
<td>the saturation and luminance levels.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Changes the saturation in a selected area to the foreground color without</td>
</tr>
<tr>
<td></td>
<td>affecting the luminance levels and the hue.</td>
</tr>
<tr>
<td>Luminance</td>
<td>Changes the luminance in a selected area to the foreground color without</td>
</tr>
<tr>
<td></td>
<td>affecting the saturation levels and hue.</td>
</tr>
<tr>
<td>Darken Only</td>
<td>Reduces the luminance levels in a selected area only if the result would be</td>
</tr>
<tr>
<td></td>
<td>darker than the background color.</td>
</tr>
<tr>
<td>Lighten Only</td>
<td>Increases the luminance levels in a selected area only if the result would</td>
</tr>
<tr>
<td></td>
<td>be lighter than the background color.</td>
</tr>
<tr>
<td>Darken</td>
<td>Reduces the luminance levels in a selected area.</td>
</tr>
<tr>
<td>Lighten</td>
<td>Increases the luminance levels in a selected area.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds more of the foreground color to the colors in a selected area.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Extracts the foreground color in a selected area.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the RGB values of the selected area.</td>
</tr>
<tr>
<td>Mosaic</td>
<td>Applies a tile effect to a selected area with horizontal and vertical</td>
</tr>
<tr>
<td></td>
<td>controls.</td>
</tr>
<tr>
<td>Blur</td>
<td>Blurs a selected area with horizontal and vertical controls.</td>
</tr>
<tr>
<td>Median</td>
<td>Changes a selected area to the most typical (median) color value within the</td>
</tr>
<tr>
<td></td>
<td>selection.</td>
</tr>
<tr>
<td>Unsharp Mask</td>
<td>Sharpens a selected area of an image to create more defined edges with</td>
</tr>
<tr>
<td></td>
<td>horizontal and vertical controls.</td>
</tr>
<tr>
<td>Gradient</td>
<td>Dissipates the paint with controls to establish the direction of dissipation.</td>
</tr>
<tr>
<td>Emboss</td>
<td>Creates a three-dimensional extrusion effect in a selected area with controls for height and angle.</td>
</tr>
</tbody>
</table>
Choosing a Color

You can choose the color you want to paint with by using the eyedropper, the Color sliders, or the Macintosh Color Picker. You can select the color before you begin painting or after you have painted an object.

Using the Eyedropper

To use the eyedropper:

1. Select an object with the Selection Tool.
   
   If you do not select an object, the color will be applied to the next object you create.

2. Position the cursor over the Color Preview window.

   The cursor becomes an eyedropper.

3. Click and hold the mouse button, drag the eyedropper to the location in the Record monitor that contains the color you want to pick, and release the mouse button.

   The Avid Composer system applies the color to the selected object, and the color you picked becomes the new default color shown in the Color Preview window.
Selecting a Color with the Color Sliders

To select a color with the Color sliders:

1. Select an object with the Selection Tool.
   
   If you do not select an object, the color will be applied to the next object you create.

2. Adjust the Hue, Sat, and Lum sliders to select a color.

   The Avid Composer system applies the color to the selected object, and the color you picked becomes the new default color shown in the Color Preview window.

Selecting a Color from the Macintosh Color Picker

The Macintosh Color Picker is a standard application that ships with Macintosh systems. Its appearance varies depending on the current release of the Macintosh operating system. You can access the Macintosh Color Picker as follows:

1. Select an object with the Selection Tool.
   
   If you do not select an object, the color will be applied to the next object you create.

2. Click the Other Options button in the Color parameter pane.

   The Macintosh Color Picker dialog box appears.

3. Select a color as described in “Using the Macintosh Color Picker” in the Media Composer and Film Composer Effects Guide.

Shortcut for Selecting a Color with the Brush Tool

When you use the Brush Tool to paint an object, you can select a color quickly from a video segment as follows:

1. Click the Brush Tool button to make it the active paint tool.
2. Press and hold the Option key, and drag the cursor to the Record monitor.
   The cursor becomes an eyedropper.
3. Position the eyedropper over the color you want to select, and release the mouse button.
   The color you picked becomes the new default color shown in the Color Preview window.

Using Magic Mask with the Paint Effect

Magic Mask enables you to isolate pixels within a specified color range in an image and apply the Paint effect to the chosen pixels. While you can use Magic Mask in conjunction with any of the paint modes to generate custom effects, the primary benefit of this feature is localized colorization, which enables you to create garbage mattes and other chroma key functions.

The Magic Mask category contains a Color Preview window for use with the eyedropper and parameters for adjusting the hue, saturation, luminance, gain (color tolerance), and softness. These parameters are described in the following sections.

The general workflow for using Magic Mask is:
1. Select a paint mode, such as Lighten, Darken, or Colorize, that provides the colorization capabilities you desire.
2. Use one of the paint tools to trace the area of the image that you want to modify.
3. Click the Outline/Path button so you have an unobscured view of the object you want to colorize.
4. Use the eyedropper to pick the color that you want to change from your selection.
5. Click the Outline/Path button to disable Outline/Path mode.
6. Adjust the Magic Mask parameters, such as Gain and Softness, if necessary.

7. Use the sliders in the Color parameter pane in conjunction with the paint mode you have chosen to change the color you picked.

**Getting Started with Magic Mask and the Paint Effect**

To get started with Magic Mask:

1. Load a sequence into the Record monitor.
   
   The video frame in this selection includes a young man wearing a yellow vest that we want to modify.

2. Select a paint mode that provides color modification, such as Hue.

3. Click the Curve Tool button. For more information on using the Curve Tool, see “Curve Tool” on page 365.

4. Click and drag to trace a freehand outline around the area in the Record monitor that you want to colorize.

5. Release the mouse button when you are finished with the outline.

6. Click the Path button to view the painted object as a wire frame.
The wire frame provides an unobscured view of the area in which you want to make the color change.

7. Position the cursor over the Color Preview window in the Magic Mask parameter pane.

The cursor becomes an eyedropper.

8. Click and hold the mouse button, drag the eyedropper to the location in the Record monitor that contains the color you want to modify, and release the mouse button.

For best results, pick the color from the center of the area that contains the color you want to change.

The color you picked becomes the new default color shown in the Color Preview window in the Magic Mask parameter pane.

9. Click the Outline/Path button to restore the painted object to the normal view.

10. Use the Hue, Sat, and Lum sliders in the Color parameter pane (not the Magic Mask parameter pane) to modify the hue of the color you picked.
Magic Mask Hue, Saturation, and Luminance Parameters

After you choose Magic Mask and pick a color with the eyedropper, you can adjust the Hue, Sat, and Lum sliders to refine the color selection. In most cases, you do not need to adjust these parameters, but the values reported by the sliders provide a useful reference.

The Hue slider affects the tint of the color selection. The tint refers to the name commonly associated with a color, such as red, green, or blue. The slider values range from 0 to 255.

The Sat (Saturation) slider affects the purity or intensity of the color selection. The color gray has no saturation at all; a fully saturated color produces the most intense representation of that color. The slider values range from 0 to 255.

The Lum (Luminance) slider affects the brightness of the color selection. The color black has 0 brightness. The slider values range from 0 to 255.

Keep in mind that the Hue, Sat, and Lum sliders in the Magic Mask parameter pane enable you to refine the color you select from the video background. Use the sliders in the Color parameter pane in conjunction with one of the paint modes to colorize your selection.
To adjust the Magic Mask Hue, Sat, and Lum sliders:

- Drag either the Hue, Sat, or Lum slider to attain the desired value.
- Click either the Hue, Sat, or Lum slider, and use the keyboard to enter a number from 0 to 255.

**Gain**

Use the Gain slider to increase or decrease the range of pixels surrounding the color you pick that Magic Mask will enable you to modify in conjunction with your chosen paint mode. Gain includes or excludes pixels surrounding the color you pick that fall within a specified color range, or tolerance. The tolerance you adjust with the Gain slider is relative to the RGB values of the color you picked.

Decreasing the gain lessens the color range and includes fewer pixels contiguous to your color selection. Increasing the gain expands the range and includes more pixels surrounding the color you picked.

To adjust the Gain slider, do one of the following:

- Drag the Gain slider to attain the desired value.
- Click the Gain slider, and use the keyboard to enter a number from 0 to 63.

**Softness**

You can use the Soft slider to increase or decrease the dissipation of the pixels in your color selection that Magic Mask will enable you to modify with the painting tools. The amount of dissipation you adjust with the Soft slider is relative to the RGB values of the color you picked in your selection.

To adjust the Soft slider, do one of the following:
• Drag the Soft slider to attain the desired value.
• Click the Soft slider, and use the keyboard to enter a number from 0 to 63.

Using the AniMatte Effect

The AniMatte effect enables you to generate custom matte effects that you can apply to a segment or transition in a sequence. You can use a variety of brushes and painting tools to create matte effects that you can animate — all from within Effect mode. The AniMatte effect includes the following features:

• Modes for keying in and keying out images
• Key-frameable animation of matte effects
• Creation of mattes as vector-based objects, which enables you to move, rescale, and reshape the mattes over the course of a segment or transition
• Freehand painting ability to create organic matte wipes
• Magic Mask, Brush Shapes, Z-rotation, outline feathering, and more
• Export of mattes while you work in Effect mode to create keys in third-party applications
• No additional hardware required

Getting Started with the AniMatte Effect

The AniMatte effect provides the Key In and Key Out modes for creating mattes. You use the same set of painting tools that are available to the Paint effect to build a variety of multitrack and single-track effects, including traditional matte keys, animated matte keys, chroma keys, and organic matte wipes.
When you use the AniMatte effect as a multitrack effect, you isolate a region of the highest video track (foreground image) with the painting tools and then key in or key out the region. Keying in a region ensures that the selection is displayed over the image on the lower track (background image). Keying out a region ensures that the lower track is visible through the selection.

The following sections briefly describe how to use the AniMatte effect to create popular matte keys.

**Creating a Multitrack Matte Key**

To create a multitrack matte key:

1. Create a sequence with two video tracks. Edit the image you want to use as the background on V1 and the image you want to use as the foreground on V2.

2. Monitor V2 by clicking the video monitor column next to V2.

3. Apply the AniMatte effect to the segment on V2, and click the Effect Mode button.

4. Click the Reduce Tool button if necessary to obtain a better view of the entire image.
5. Click the Curve Tool button.

6. Choose Key In from the Mode Fast menu in the Effect Editor.

7. Click and drag on the image on V2 to draw a matte with freehand capability.

8. When you are satisfied with the shape of the matte, release the mouse button.

   The area outside the border of the matte reveals the underlying image on V1, and the area inside the border of the matte displays the image on V2.

9. Click the Reverse button in the Foreground parameter pane.

   The area outside the border of the matte reveals the image on V2, and the area inside the border reveals the underlying image on V1. By enabling the Reverse option, you have changed the view of the matte from key in to key out.
Using the Reverse option provides a useful reference when you need to see the image on the track that becomes obscured when you apply the AniMatte effect. You might need to see these obscured areas to track the motion of the images so you can edit the matte to follow their movement.

10. Click the Reverse button to disable the Reverse option.

This restores your selection to a matte that keys in your selection.

**Animating the AniMatte Effect**

When you apply the AniMatte effect and create a matte key, the shape and location of the matte remain fixed over the course of the segment. The parameters of the matte are the same at both the first and last key frames in the segment.

When you have moving video on V1 and V2, the images are changing from frame to frame. Consequently, you must change the shape and location of the matte in order to follow the changes of the video over the course of the segment. You can add a key frame at each location in the segment where you make changes to the shape and position of the matte. Alternatively, you can make changes to the matte at various locations in the effect’s Timeline, and the Avid Composer system inserts a new key frame where each change is made.
To animate a Matte Key effect:

1. Click the Step Forward button or the Step Backward button as many times as necessary to park on a frame in which the matte no longer provides a clean key due to the motion of the foreground or background image.

2. Click the Add Key Frame button.

3. Click the Reverse button to swap the view of the foreground and background images.

4. To reposition the matte:
   a. Click the Selection Tool button and select the matte.
   b. Click within the border of the matte and drag the matte to the new location.
   c. When you are satisfied with the position of the matte, release the mouse button.

5. To change the shape of the matte:
   a. Select the matte with the Selection Tool.
b. Click the Reshape Tool button in the Effect Editor, or double-click the matte.

The outline of the matte becomes highlighted, and control points appear at the midpoint of each straight line and curve.

c. Do one or more of the following to adjust the shape of the matte:

- Click and drag one or more of the object’s control points. For information on moving control points, see “Moving a Control Point” on page 352.

- Edit the object by manipulating the direction bars at one or more control point. For information on editing straight-line segments and curved segments, see “Modifying Lines and Curves Summarized” on page 350.

6. Repeat steps 1 to 5 as needed to create a matte that keys the images cleanly over the course of the segment. A clean and accurate matte tracks the movement of the foreground and background images.

Creating a Single-Layer Organic Matte Wipe

While the Avid Composer system includes a wide variety of wipes in the Effect Palette, you can use the AniMatte effect to draw your own custom matte wipe. Additionally, you can create soft edges and other useful variations by adjusting the parameters of the AniMatte wipe. Multiple video tracks are not necessary. You apply the AniMatte effect to a transition on a single track of video and then draw the matte wipe as described in this section.
To create an organic matte wipe:

1. Create a sequence that contains a transition (an incoming and an outgoing segment).

2. Apply the AniMatte effect to a transition as described in “Apply
   ing an AniMatte Effect to a Sequence” on page 321.

3. Click the Effect Mode button to enter Effect mode.

4. Choose Key In from the Mode Fast menu.

5. Click the Reduce Tool button three times to reduce the image to
   25 percent of its normal viewing size.

6. Click the first key frame in the effect’s Timeline.
   The first key frame is highlighted, and the last key frame is
deselected.

7. Click the Curve Tool button.

8. Press and hold the mouse button and drag to draw a custom
   shape to the right of the image displayed in the Record monitor.
9. When you are satisfied with the shape of the object, release the mouse button to complete the matte wipe.

10. Click the last key frame in the effect’s Timeline.

    The last key frame is highlighted, and the first key frame is deselected.

11. Click the matte wipe within its borders and drag it so that it covers the frame in the Record monitor. Make sure to position the leading edge of the wipe so that it is beyond the left border of the frame.

12. Click the Enlarge Tool button three times to restore the video image to 100 percent.
**Adding a Soft Edge to the Organic Matte Wipe**

To add a soft edge to the organic matte wipe:

1. Shift-click the first key frame in the effect’s Timeline so that both the first and last key frames are selected.

2. Select the matte wipe with the Selection Tool if it is not selected already.

3. Drag the Monitor Position bar to the midpoint of the effect’s Timeline.

   The leading edge of the wipe appears in the Record monitor.

4. Click the triangle next to Feathering if the Feathering parameter pane is not open already.

5. Click the Anti-Alias button in the Feathering parameter pane.

6. Click the Fixed Aspect button in the Feathering parameter pane if it is not selected already.

7. Click the Horiz slider, enter 50 by using the keyboard, and press Return.

   Both the Horiz and Vert sliders change to a value of 50.

8. Render the effect to play back the custom wipe with a soft edge in real time.
AniMatte Effect Parameters

Many of the parameters you use with the AniMatte effect function similarly with the Paint effect. Chapter 10 includes complete descriptions of these common parameters. The following sections describe parameters that are specific to the AniMatte effect.

Key Modes

The AniMatte effect provides two modes, Key In and Key Out, that you can use to create matte keys and matte wipes.

Table 11-2 briefly describes the characteristics of each mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key In</td>
<td>Displays the image on the higher track (foreground) within the matte selection while revealing the image on the lower track (background) outside the matte selection for two-track video effects; displays the incoming segment within the matte selection for single-track matte wipes.</td>
</tr>
<tr>
<td>Key Out</td>
<td>Displays the image on the lower track (background) within the matte selection while revealing the image on the higher track (foreground) outside the matte selection for two-track video effects; displays the outgoing segment within the matte selection for single-track matte wipes.</td>
</tr>
</tbody>
</table>

To change the Key mode:

1. Select an object with the Selection Tool.

If you do not select an object, the Key mode will be applied to the next object you create.
2. Click the triangle next to Mode if the Mode parameter pane is not open already.

3. Choose Key In or Key Out from the Mode Fast menu.
   When you finish drawing a matte, the mode you have chosen becomes the new default Key mode.

**Using Magic Mask with the AniMatte Effect**

Using Magic Mask with the AniMatte effect provides an alternative to the YUV Chroma Key effect in the Effect Palette. You isolate pixels within a specified color range in a matte to key in or key out those pixels. You can modify the color range to refine the key and to include contiguous pixels that fall within the color range in the key.

The Magic Mask parameter pane contains a Color Preview window for use with the eyedropper and parameters for adjusting the hue, saturation, luminance, gain (color tolerance), and softness. These parameters are described in the following sections.

The general workflow for using Magic Mask is:

1. Select either the Key In or Key Out mode.
2. Use one of the paint tools to draw a matte key.
3. Choose the opposite Key mode to view the foreground image within your matte selection.
4. Use the eyedropper to pick the color that you want to use as the basis for your chroma key.
5. Switch back to the original Key mode.
6. Adjust the Magic Mask parameters, such as Gain and Softness, as necessary.
Getting Started with Magic Mask and the AniMatte Effects

To get started with Magic Mask to create a chroma key:

1. Create a sequence with two video tracks. Edit the image you want to use as the background on V1 and the image you want to use as the foreground on V2.

2. Monitor V2 by clicking the video monitor column next to V2.

3. Apply the AniMatte effect to the segment on V2, and click the Effect Mode button.

4. Click the Curve Tool.

5. Click the triangle next to Mode if the Mode parameter pane is not open already.

6. Choose Key Out from the Mode Fast menu.

7. Click the Reduce Tool button if necessary to obtain a better view of the entire image.

8. Click and drag on the image on V2 to draw a matte with freehand capability.
9. When you are satisfied with the shape of the matte, release the mouse button.

The area inside the border of the matte reveals the underlying image on V1, and the area outside the border of the matte displays the image on V2.

10. Choose Key In from the Mode Fast menu.

Now you can see the foreground image within the borders of the matte key.

11. Position the cursor over the Color Preview window in the Magic Mask parameter pane.
The cursor becomes an eyedropper.

12. Click and hold the mouse button, drag the eyedropper to the location in the matte key that contains the color you want to key out, and release the mouse button.

For best results, pick the color from the center of the area that contains the color you want to correct. In the example, the off-white color of the sky is the color selection.

The color you pick becomes the new default color shown in the Color Preview window in the Magic Mask parameter pane.
13. Choose Key In from the Mode Fast menu.

The foreground image is keyed out based on your color selection.

14. Adjust the Hue, Saturation, Luminance, Gain, and Softness parameters to refine your key. The following sections describe these parameters.

**Hue, Saturation, and Luminance Parameters**

After you use Magic Mask to pick a key color with the eyedropper, you can adjust the Hue, Sat, and Lum sliders to fine-tune the color selection. If you do not need to adjust these parameters, the values reported by the sliders provide a useful reference to the values that make up your color selection.

The Hue slider affects the shade of the color. The shade refers to the name commonly associated with a color, such as red, green, or blue. The slider values range from 0 to 255.

The Sat (Saturation) slider affects the purity or intensity of the color. The color gray has no saturation at all; a fully saturated color produces the most intense representation of that color. The slider values range from 0 to 255.

The Lum (Luminance) slider affects the brightness of the color. The color black has 0 brightness. The slider values range from 0 to 255.
To adjust the Hue, Sat, and Lum sliders:

- Drag either the Hue, Sat, or Lum slider to attain the desired value.
- Click either the Hue, Sat, or Lum slider, and use the keyboard to enter a value from 0 to 255.

**Gain**

You can use the Gain slider to increase or decrease the effect of Magic Mask on pixels that are contiguous to your color selection within the borders of a matte key. Gain applies color correction to pixels that fall within the specified color range, or tolerance, of the color you pick with the eyedropper. The tolerance you adjust with the Gain slider is relative to the RGB values of the color picked in your selection.

Decreasing the gain tightens the color range and restricts the key to fewer contiguous pixels. Increasing the gain expands the range and includes more pixels contiguous to the picked color in the key. You probably will need to make adjustments to gain to obtain a clean key.

To adjust the Gain slider, do one of the following:

- Drag the Gain slider to attain the desired value.
- Click the Gain slider, and use the keyboard to enter a number from 0 to 63.

**Softness**

You can use the Soft slider to increase or decrease the amount of softness applied to your color selection and contiguous pixels that fall within a specified tolerance. The tolerance you adjust with the Soft slider is relative to the RGB values of the color picked in the selection.

To adjust the Soft slider, do one of the following:
• Drag the Soft slider to attain the desired value.
• Click the Soft slider, and use the keyboard to enter a number from 0 to 63.

Exporting a Matte PICT File

You can create a matte with the AniMatte effect and export it from the Avid Composer system as a high-contrast matte — without having to leave Effect mode. The exported image is a high-contrast 32-bit PICT file that includes an alpha channel.

You can use the exported PICT file in the following ways:
• Import the file back into the Avid Composer system to create a real-time matte key clip that you can edit into a sequence. You can use this clip as a garbage matte or, if you have the 3D Effects option, promote the clip to 3D.
• Open the file in a third-party graphics application, edit the file, and import the file back into the Avid Composer system.
• Use the file as a graphic in an application other than Media Composer or Film Composer.

When you import the PICT file back into the Avid Composer system, the system creates a matte key clip in the bin that you select. You can load the matte key clip into the Source monitor and edit it into a sequence as you can with any other imported matte key. The matte key clip appears as a high-contrast matte with transparent (black) and opaque (white) components. For more information on editing a matte key clip into a sequence, see “Editing with Imported Matte Key Clips” in the Media Composer and Film Composer Effects Guide.

When you open the high-contrast PICT file in a third-party application that supports alpha channels, select the file’s alpha channel to view the high-contrast components of the matte. However, if you open the PICT file in an application that does not support alpha channels, the image appears completely white.
To export a matte key created with the AniMatte effect:

1. Create a matte key using the AniMatte effect in Effect mode.

To follow the remaining steps in this procedure, you must be working in Effect mode.

2. Move the position indicator in the effect’s Timeline to the frame you want to export.

3. Choose Export Matte PICT from the File menu.

   A dialog box appears.
4. Use the Directory pop-up menu to choose the location where you want to save the PICT file.

5. Click Save.

   The system saves the PICT file to the location you chose.

6. If necessary, open the PICT file in a third-party application and make changes to the file.

7. Select the bin into which you will import the PICT file, and choose Import from the File menu.

8. The Import dialog box appears.

9. Click Options.

10. To use the existing alpha channel, deselect Ignore Existing Alpha Channel.

    Depending on your needs, you might have to select Invert Existing Alpha; in a high-contrast matte key with an alpha channel on an Avid Composer system, the white regions are opaque, and the black regions are transparent. For more information on importing a matte key, see the “Importing Files” chapter in the user’s guide.

11. When you are finished selecting the options you need, click OK.

12. Continue with the instructions in the “Importing Files” chapter in the user’s guide to complete the import of the file into the bin.
The PICT file appears as a Matte Key Effect clip in the bin you chose.

13. Click the Source/Record Mode button.

14. Load the matte key clip into the Source monitor.

   The clip appears in the Source monitor as a black-and-white, high-contrast image.
15. Edit the matte key into the sequence as described in “Editing with Imported Matte Key Clips” in the Media Composer and Film Composer Effects Guide.
Index

Numerics

16-bit audio, exporting 261
3-perf projects 232
8-bit audio, exporting 261

A

Acceleration slider 116, 171
Add Channel button 59
Add Deck button 61
Add Edit function
  submaster effects 144, 145
Add Page, in Title Tool 155
AIFF file format
  defined 304
Alias file format
  defined 302
  import specifications for 307
Alpha channel
  defined 305
  in imported animation 312
  in imported graphics 307
  in imported QuickTime files 314
  title creation 180
Animation codec (QuickTime) 263
Animation file types

  described 304
  specifications for 311
Animation with AniMatte effect 399
AniMatte effect
  animating 399
  applying 321, 397
  described 396
  exporting as PICT file 412
  for matte wipes 401
  modes for 405
  parameters for 326
  rendering 320
Anti-aliased images
  alpha channel in 306
  title elements 180
AppleShare, for file transfer 300
Aspect ratio
  grid options 130
Aspect ratio, for imported graphics 244
Attic folder 35
Audio
  Automation Gain recording 192
  channel assignments 71
  eight-channel input 78
  EQ templates 186
  Mix Tool 205
  output parameters 71
  sample rates
Avid Media Fusion, importing files from 315
Avid Visual Extensions 137
AvidDroid, specifying a port for 80
AvidNet 299, 299
AVR (Avid Video Resolution) 48
75B, 75, 70B, 70 48
Editcam compatibility 48
support for digitizing 48
AVR compatibility 157
AVX plug-ins 137

B

Backups attic 35
Baseline option, for JPEG export 268
Bezier curves described 342
manipulating 344
Bin
column headings 123
Bins
retrieve 35
title effect clips
exiting Title tool 159, 160
Bit depth, defined 305
Blackpoint option, for Cineon export 267
Blank button (Command Palette) 105
Blue dot 145
BMP file format
additional export parameters 267
defined 302
import specifications for 307
Broadcast products, compatibility with 48
Brush Tool
creating a custom shape for 339
painting with 355
parameters 336
shapes for 384
templates for 341

for export 261
synchronized with video 225
two-channel board enhancements 184
volume
adjusting while playing 206
Automation Gain 192
Audio down sampling (QuickTime) 261
Audio effects
manipulating 185
Audio EQ (Equalization)
adjusting while playing 191
templates 189
Audio file types
described 304
importing 234
Audio Mix Tool
and Automation Gain 203
new buttons (release 7.0) 205
Audio tone media, creating 73
Audio Tool
resizing 70
AudioSuite Plug-Ins 207
limitations 214
rendering 213
troubleshooting 214
AudioVision
transferring OMF files to
compatibility issues 274
guidelines for 275, 279
Auto Patch command 90
Auto Patching option 90, 90
Auto Size Mode in Title Tool 152
Automation Gain
and the Audio Mix window 203
connecting a fader 193
Fast menu 199
keyboard shortcuts 202
window description 195
Auto Sequence command 225
Auxiliary timecode 96
Avid controller, specifying 80
Buttons

Add Channel
Add Deck
mapping
replacing with Blank button

C

C button for Crawling mode
Calibration tone
creating media for
CamCutter files
Camera roll, combining events based on
Camera, Digital News Gathering (DNG)
CCIR video levels
for export
for import
Channel dialog box
Chyron file format
defined
import specifications for
Cineon file format
additional export parameters
defined
import specifications for
Cinepak codec (QuickTime)
Clip Information window
Clips
displaying information about
Editcam, copying
Editcam, importing
exporting
Codes, QuickTime
Collapsing layers, and Submaster effects
Color Depth option
for PNG export
for SGI export
for Targa export
for TIFF export
for Wavefront export

Color effects
background colors
Color option (QuickTime)
Color Picker
Color, choosing for Paint effect
Column headings
bin view
Combine Fields option
Command Palette
buttons
first group defined
new buttons in
using
Commands
Fade Title
Compatibility
between AudioVision and Media Composer
with Broadcast products
Compatibility requirements for transfer
Compatible AVRs
Component Video codec (QuickTime)
Compressed media
adding uncompressed material to
Compression option
for Photoshop export
for Targa export
for TIFF export
Configuring decks
Consolidate window
Consolidating
for transfer to Pro Tools
Control points
adding
deleting
described
moving
removing
selecting
Control track, using for preroll
Controller, specifying
Conversion tool 42
Converting media file formats 42
Converting media files 42
Copying
   Editcam master clips 39
Crawling title
   acceleration 116, 171
   cropping 173, 173
   defined 150
   foreground transparency 171
   position 172
   soft edges 175
Cropping
   Crop sliders 173
   Cropping
      across scroll direction 174
   Cropping titles 173
Cross-platform movie (QuickTime) 261
Curve Tool
   in AniMatte effect 398
E
   painting with 365
Cut list with grid information 368

D
DAE (Digidesign Audio Engine) 208
Deck 61
   configuration of 58, 64
   controller 68
   preferences 64
Deleting
   deck configurations 64
Destination cropping 174
Destination size
   for an export 260
Detail in the Timeline, displaying 87
Device code in VTR emulation 66
Dialog boxes
   Relink 45
Digidesign AudioSuite Plug-Ins 207
Digitizing
to multiple media files 48
DNG (Digital News Gathering) camera 38
Downstream keying 149
Drives for transferring media 299
DSK (downstream keying)
   of titles and graphics 149
   one title per nesting 161
Dupe detection handle lengths, adjusting 230
Dupe handle lengths
   adjusting for dupe detection 230
   described 228
   matching in dupe lists 231
Duration and speed of title 167
E
Edit delay in VTR emulation 67
Editcam clips
   AVRs 48
   copying 39
   importing 38
Editcam file format
   defined 304
   import specifications for 316
   importing 234
Editing
   submaster effects 143, 143
   titles
      by revising 176
      with third-party plug-ins 141
Effect Editor 110, 169
   buttons 111
   Profile window 115
Effect Grid
   adding information to cut lists 368
Effect Mode
   key frames 167
Effect Mode button 110
Effect template
for intraframe effects 328
Eight-channel audio input 78
Eight-channel audio monitoring on two-channel board 184
Electronic license 19
EQ effect
   adjusting while playing 191
templates for 186
ERIMovie file format
   additional export parameters 267
defined 304
   import specifications for 312
Exchanging material 270 to 299
Export File Type dialog box 252
Export Settings 259
Export, Matte PICT file 412
Exporting files
   audio parameters for 261
   logs 258
   OMF to AudioVision 279
   OMF to Pro Tools 285
   preparing for 250
   preparing for OMF export 272
   procedure for 251
   reasons for 249
   settings for 259
   shot logs 258
   specifications for 305
   specifications for OMFI 314
   specifications for QuickTime 313
   supported formats for 301
   with Media Composer QuickTime codec 288, 289
Eyedropper tool
   with Paint effect 389

F
Fade Title command 167
Fade(s)

title effects 167
Fast Save in Title Tool 158
Fast titles, playing 167
Feathering for Paint effect 386
Fetch 300
FieldPak 38
Fields, combining in film capture 57, 57
Fields, including both in export 260
File conversions 42
File Transfer Protocol (FTP) 300
File types, supported 301
Files
   importing
      limiting size 235
      specifications for graphics ?? to 311
Files, exporting
   audio parameters for 261
   logs 258
   OMF to AudioVision 279
   OMF to Pro Tools 285
   procedure for 251
   reasons for 249
   settings for 259
   shot logs 258
   specifications for graphics 305
   specifications for OMFI 314
   specifications for QuickTime 313
   supported formats for 301
   with Media Composer QuickTime codec 288, 290
Files, importing
   from Avid Media Fusion 315
   from MCXpress for Windows NT 315
   global parameters 236
   guidelines for 235
   mixed resolutions 235
   procedure for 237
   specifications for animation 311
   specifications for Editcam 316
   specifications for graphics 305
   specifications for OMFI 314
specifications for QuickTime 313
supported formats for 301
Film effects
masks
aspect ratio grid 130
Film pulldown
in OMF files 315
Fonts
setting timecode 96
Foreground level, controlling 115
Foreground slider 171
Format option, for YUV export 269
Format Type option, for Wavefront export 269
Frames
fades in 168
Framestore file format
defined 302
import specifications for 307
FTP 300
Full-screen image size, defined 305

G
Gamma option
for Cineon export 267
for Wavefront export 269
Global settings
importing files 236
Global vs. key-frame parameters 329
Graphic object size limits 151
Graphics
titles 148
revising 176
uncompressed, adding to compressed media 149
Graphics codec (QuickTime) 264
Graphics export, additional options for 267
Graphics file types
described 302
importing 234
specifications for 305
Grouping and ungrouping
paint objects 379

H
Hardware information display 27
Hardware Tool
displaying 34

I
IFF file format 302
import specifications for 307
Import dialog box 238
Import Settings dialog box 243
Importing
Editcam clips 38
statistics files 32
Importing Files
from Media Fusion 315
Importing files
from MCXpress for Windows NT 315
global parameters 236
guidelines 235
in mixed resolution projects 235
procedure for 237
specifications for animation 311
specifications for Editcam 316
specifications for graphics 305
specifications for OMFI 314
specifications for QuickTime 313
supported formats for 301
Info button 27
Info Display window 27
Hardware, displaying information about 34
Memory, displaying information about 34
Profile, displaying information about 27
Usage, displaying information about 28
Interlaced option, for PNG export 268
Intraframe editing
See also Paint effect, AniMatte effect
described 318, 322
parameters for 324
parameters, using 328
rendering during 319
single-field step with 319

J
JPEG file format
additional export parameters 268
defined 302
import specifications for 308

K
K-Share 300
Key Frame button 170
Key frames 170
titles, fading 167, 168
Key modes for AniMatte effect 405

L
Layering paint objects 375
License agreement 19
License agreement, accepting 19
Limitations
DSK title on top 161
playing backwards 172
playing fast titles 167
Limits, size of title text and graphics objects 151
Locking and unlocking
paint objects 379
Lossless images 149

M
Magic Mask
described 391
parameters for 394, 410
with AniMatte effect 406
with Paint effect 392
Managing media files 40
Master clips
relinking 44
Matching resolutions 157
Matte wipe, with AniMatte effect 401
MCXpress for Windows NT, importing files from 315
Media Composer QuickTime codec 264
Media Conversion Tool 42
Media File Manager, converting from 42
Media files 42
Editcam 38
managing 40
multiple, digitizing to 48
relinking 44
transferring 298
Media files, converting 42
Media Inbox 299
Media Stream Manager 40
Memory
displaying 34
Menu commands
mapping 101
Relink (Clip menu) 45
Merging events (shot log import) 247
Methods for transferring media between systems 297
MFM to MSM conversion 42
Mixed resolutions 235
Mono audio in an export 261
Motion JPEG A codec (QuickTime) 265
Motion JPEG B codec (QuickTime) 265
Motion option (QuickTime) 266
Movie preview (QuickTime) 261
MSM to AudioVision conversion 42
MUI controller, specifying 83
Multiple layer effects
  submaster 143, 145
Multiple media files, digitizing to 48

N
Nested effects
  submaster effects 143
NTSC frame resolution
  for imported files 307

O
Objects, graphic
  revising 176
OMF Interchange files
  described 271
  exporting to AudioVision 279
    compatibility issues 274
    guidelines for 275, 279
  exporting to Pro Tools 285
    guidelines for 283
    procedure for 285
  importing 234
  methods for exporting 271
  preparing to export 272
  specifications for 314
  web site 271
OMFI Media Files, about 40
OS/2 option, for BMP export 267
Other Options button 176
Oval Tool for intraframe editing 357

P
Pack 24 bits option, for ERIMovie export 267
Page number display, in Title Tool 155
Paint effect
  applying 321, 383
  brush shapes for 384
  changing parameters for 385
  described 382
  modes, described 387
  parameters 324
  parameters, described 386
  rendering 320
Paint objects
  moving 375
  scaling 373
PAL frame resolution
  for imported files 307
Parameters (2D)
  AniMatte effect 326, 405
  Paint effect 324, 386
Patching audio
  using the Auto Patching option 90
Path for intraframe editing effects 336, 336
PCX file format
  defined 302
  import specifications for 308
Pen tool for intraframe editing 319
Photo CD file format
  import specifications for 308
Photo CD format
  defined 302
Photo JPEG codec (QuickTime) 265
Photoshop file format
  additional export parameters 268
  defined 302
  import specifications for 308
PICS animation file format
  import specifications for 312
PICT file format
  defined 302
  import specifications for 309
PICT sequence
  specifications for 312
Pixar file format
  defined 303
  import specifications for 309
Planar RGB codec (QuickTime) 265
Playback of effect titles 168
Plug-ins
  AVX 137
Plug-Ins, AudioSuite 207
PNG file format
  additional export parameters 268
  defined 303
  import specifications for 309
Point size for timecode 96
Polygon shapes, creating 359
Polygon Tool for intraframe editing 358
Preparing
  sequences for export 250
  sequences for OMF export 272
Preroll
  using control track for 56
Preview
  viewing anti-aliased titles 180
Previsualization Marker 366
Printing
  statistics 29
Pro Tools
  transferring OMF files to 283
Profile
  information display 27
Profile window 115
Progressive option, for JPEG export 268
Projects
  transferring 270 to 299

Q

QRT file format
  defined 303
  import specifications for 309
Quality option (QuickTime) 266
Quality option, for JPEG export 268
QuickTime codecs
  See also Media Composer QuickTime codec in Compression settings 263
QuickTime file format
  and Media Composer codec 288
  specifications for 313
QuickTime file type
  importing 234

R

R button for Rolling mode 153
Real time title parameter changes 149
Real-time effects
  submasters 143, 145
Recording
  to the Timeline 52
Rectangle Tool for intraframe editing 356
Relink command (Clip menu) 45
Relink dialog box 45
Relinking
  See also Unlinking
  media files and clips 44
Rendering effects
  submasters 145
Rendering of effects
  during intraframe editing 319
  real-time effects titles 163
Rendition file format
  defined 303
  import specifications for 309
Reshape Tool for intraframe effects 370
Resizing
  the Audio Tool 70
Resolutions, mixed 235
Retrieve files 35
RGB graphics levels
  for export 260
  for import 245
Rolling title
  acceleration 116, 171
  cropping 173, 173
  defined 150
  foreground 171
  position 172
Runup, in VTR emulation 67

S

Saving titles 158
  in a bin 178
Scale bar (Timeline) 87
Scaling paint objects and mattes 373
Scanning for tapes 40, 53
Scene, combining events based on 247
Scroll position slider 172
Scrolling Timeline 86
Segment effect
  submasters 143, 145
  title editing 167
Select Files to Import dialog box 238
Select Tape options 40, 53
Sequence
  third-party plug-ins 141
Sequenced PICT files
  specifications for 312
Sequences
  exporting 249
Sequential files
  exporting 261
  import option for 245
Serial Ports Tool, specifying a controller in 80
SGI file format
  additional export parameters 268
  defined 303
  import specifications for 309

Single frame import options 246
Single-field step 319
Slide, importing a file as 246
Smooth motion in downstream-keyed titles 149
Smooth YUV option, for YUV export 269
Soft edges 175
SoftImage file format
  defined 303
  import specifications for 310
Sound Designer II file format
  defined 304
Source cropping 173
Source tapes, selecting 53
Source tracks
  Auto Patching option 90
  patching in the Timeline 90
Spreadsheet, for reporting statistics 33
Statistics
  file structure and layout 30
  for system usage 28
  imported into a spreadsheet 33
  printing 29
  sample file 30
  viewing 28
Statistics folder 29
Steenbeck controller, specifying 82
Step In button 179
Stereo audio, in an export 261
Storage
  devices for transferring media 299
Submaster editing 143, 145
SunRaster file format
  defined 303
  import specifications for 310
Supported file types 301
Synchronizing
  video and audio subclips 225
Tape name, finding 40, 53
Targa file format
  additional export parameters 268
  defined 303
  import specifications for 310
Text for titles
  revising 176
Text object size limits 151
Third-party plug-ins
  applying to a sequence 141
Three-perforation film projects 232
TIFF file format
  additional export parameters 269
  defined 303
  import specifications for 310
Timecode
  See also Internal Timecode Generator
displays, setting
fonts, setting 96
point size, setting 96
Timecode window 94
Timeline
  displaying detail in 87
effect icons 145
real-time effects, color coding 145
recording to 52
scrolling 86
settings 89
Title
  adding real-time effect to 149
  adding soft edges to 175
  color of background 181
  complexity of 163
  fading a 167
  fast saving 158
  revising 176
  uncompressed, adding to compressed media 149
Title duration 166
Title effect
  exiting Title tool 159, 160
Title parameters, changing in real time 149
Title Tool
  Add Page option 155
  Auto Size mode 152
Title tool
  background options 181
  defined 148
  revising a title with 176
Title, speed of play 167
To OUT timecode display option 96
Tone, creating media for 73
Tracks
  video
    sub-master effects 145
Transferring files 270 to 299
OMF to AudioVision
  compatibility issues 274
  guidelines for 275, 279
OMF to Pro Tools
  guidelines for 283
  procedure for 285
Transferring media
  between systems
    compatibility requirements 297
    methods for 297
    procedure for 297
    storage devices for 299
with AvidNet 299
Transparency of a graphics image
  import specifications for 306
Two channel audio boards
  monitoring eight channels 184
  support for 41kHz and 48kHz 185

U
UNIX systems file transfer 300
Unrendered titles 158
Unused buttons 105
Usage of system
   displaying 28
Use Both Fields export option 260
Use Enabled Tracks export option 260
Use Marks export option 260
User selectable buttons
   mapping 100

V
Vector-based objects
   creating 344
   described 342
Video background updating, in Title Tool 181
Video codec (QuickTime) 266
video input 55
Video Input Tool 46
Video layers
   sub-master effects 145
   submaster effects 143
Video Output Tool 46
Videotape deck
   configurations, deleting 64
   configuring 58
   preferences 64
VTR Emulation settings 65

W
Wavefront file format
   additional export parameters 269
   defined 303
   import specifications for 310
Whitepoint option, for Cineon export 267
Window Zoom box 91
Windows option, for BMP export 267

X
Xinet K-AShare 300
XWindows file format
   defined 303
   import specifications for 311

Y
YUV file format 303
   additional export parameters 269
   import specifications for 311

Z
Zoom box 91
Z-rotation Tool for intraframe effects 372